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Welcome to 
the July 2016 
issue of  
Digital camera

hether you’re shooting 
formal portraits, fashion, 
weddings, candids or 
kids, this month’s issue 
is full of killer tips and 

techniques that are guaranteed to 
improve your people shots. Our 
cover story reveals everything you 
need to know, from mastering the 
art of the headshot and using 
natural light to working with studio 
lights and even some  basic 
retouching skills. 

To whet your appetite and 
get you inspired, we also meet 
one of the world’s top wedding 
photographers, Jerry Ghionis. 
And we talk to one photographer 
who only used an iPhone to 
photograph an epic Indian 
wedding. Bonkers? Turn to page 
96 and judge for yourself. 

With the generous help of Phottix, 
this month’s Shootout took place in 
a studio where our two readers, Will 
and Simon, battled it out with 
off-camera flash and more. 
Enjoy the issue – and happy 
summer shooting!

Complete your digital 
Digital Camera 
magazine collection with 
our back issue library for 
iOS or Android tablets 
and smartphones, plus 
PCs and Macs.
For details, turn 
to page 146

thiS Month’S StaR 
contRiButoRS…

misseD an issUe?  
Read any issue with our 
digital editions…

the Big inteRView
jeRRy ghioniS
We meet one of the world’s most 
acclaimed wedding photographers

PeRFect PoRtRaitS
jaMeS PateRSon
Tips for taking better people shots: 
James has all the angles covered

woRk eXPeRience
SePhi BeRgeRSon
The photographer who shot a 
whole wedding on his iPhone

QueStion MaSteR
andRew jaMeS
Andrew takes on topics including 
cities at night and focus points

analySiS
MaRk BenhaM
The winner of Food Photographer 
of the Year shares his secrets

hotShotS
geoRgia daRlow
Local guidance helped this 
up-and-comer’s portfolio

PoRtFolio
iMRan ahMad Bin 
Rayat ahMad 
Shooting underwater

daRkRooM aRtiSt
glyn dewiS
Our Photoshop guru helps you 
give portraits a poster look
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e v e rY  i s s U e  w e  b r i n g  Yo U  m o r e  F r e e b i e s  t h a n  a n Y  ot h e r  p h oto  m ag a z i n e !

Our series of tips cards 
offer pocket-friendly 
advice for photographers 
on the go. Just keep the 
cards you need in your kit 
bag. You’ll find settings for 
your first shot, plus tips 
for how to improve the 
results. Look for them 
after the magazine.

FREE! 9 all-new 
wedding tips 
cards

164-Page 
BuyeR’S  
guide

MaSteR the aRt oF 
Retouching eBook

Choose your next camera 
or lens with the help of this 
164-page magazine, packed 
with expert reviews. This 
edition of Camera Shopper 
is provided as a PDF ebook 
which you can download via    
www.bit.ly/shopper14

This month’s Photoshop Guide ebook shows you how to take 
your portraits to the next level with clever but accessible 
retouching techniques. Improve the look of skin, hair and eyes, 
add digital make-up, and more! You can also watch or download 
six videos with extra detail for selected tips.  
 You can read this ebook after the magazine or download it 
as a PDF via www.bit.ly/dc179ebook 11 VideoS

Our video lessons are packed 
with essential image-editing 
advice to help you get the 
best from your pictures. 
This month, in addition to five 
videos to accompany our 
Digital Darkroom tutorials (see 
page 127), you’ll find six videos 
to support your free Master 
Retouching ebook.
 You can watch the videos 
on YouTube via www.bit.ly/
dc179video or download 
them to your computer 
via www.bit.ly/dc179extra

inClUDes  
weDDing photo  

CheCklist!

When you see this 
logo in the magazine, 
you can watch a 
related video via  
www.bit.ly/
dc179video. See 
below for details.

 
download the Video

 www.bit.ly/ 
dc179extra

watch  
Video  
www.bit.ly/ 
dc179video
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Add a high-dynamic-range 
effect with HDR Toning 
See page 11 of the ebook

Retouch skin with the High 
Pass filter in Photoshop 
See page 6 of the ebook

Make a precise selection 
when cut a subject out
See page 12 of the ebook

Discover a  simple trick 
to make skin look softer 
See page 7 of the ebook

Add sparkle, then finish the 
look with digital make-up 
See ebook pages 8 and 14

How to make your subject 
look flawless every time 
See page 2 of the ebook
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Lightroom Skills: Adjust bright landscape 
skies with the Graduated Filter 
Read the tutorial on page 128

Image-editing 
guides for 
Photoshop and 
Lightroom: see 
page 127 for 
contents

Tool School: See how the Magic Wand 
helps you make complex selections 
Read the tutorial on page 130

Tool School: Go through the key settings 
for the Magic Wand in Photoshop 
Read the guide on page 131

Creative Spotlight: Four ways to add 
painterly effects to your photographs
Read the tutorial on page 136

Artist Insight: Give your portrait the 
movie poster look with a detail boost 
Read the tutorial on page 132

BONUS 
VIDEO!

pagE 53



T h e  b e sT  n e w  p h oTo g r a p h y  f ro m  a ro u n d  T h e  wo r l d

h oT s h oT s

SEND US  
YOUR SHOTS
Your photograph could 
appear here! Send your 
best recent shot to  
digitalcamera 
@futurenet.com 
(subject line: Hotshots)

georgIa darlow, uK      “This was shot in Bagan, Myanmar, during a trip last year. I was lucky 
enough to have the most fantastic guide who knew lots of off-the-beaten-track locations, including this ancient 
temple that we had to persuade ‘the Keyholder’ to let us access. So with key in hand and an obliging young monk 
from a nearby monastery as the subject, I was able to capture this shot. It was a truly magical location and shoot 
that is by far the most enjoyable I’ve been fortunate enough to experience so far.”
Kit Canon 5D Mk III with EF 24-70mm f/2.8L II USM lens  Exposure 1/60 sec at f/5.6, ISO 3,200
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georgIa darlow, uK      “This was shot in Bagan, Myanmar, late one morning, with two young monks from 
a nearby monastery taking a stroll together. There was something very tranquil about this location and the geometry of the 
space and shadows was quite interesting to play with. As with all the shots from this trip, it was my guide I had to thank for 
showing me round locations I would have never known were there. His knowledge on where, when and how to capture the 
essence of this location was invaluable and something I feel privileged to have been able to share.”
Kit  Canon 5D Mk III with EF 24-70mm f/2.8L II USM lens   Exposure 1/200 sec at f/5.6, ISO 200

georgIa darlow, uK      “This was shot in Bagan, Myanmar, late one afternoon. It had been a busy day 
exploring this magical location and my guide was hurrying me along to our final location of the trip, promising me the best 
light we’d seen all day. I certainly wasn’t disappointed! We didn’t have long before the light began to change, so with added 
urgency, light shafts streaming in and wafted incense enhancing the rays, I was able to capture this shot of a young monk 
from a nearby monastery reading in an ancient temple.”
Kit Canon EOS 5D Mk III with EF 24-70mm f/2.8L II USM lens   Exposure 1/200 sec at f/7.1, ISO 1,600
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osCar dewhursT, uK      “I spent two months at the Los Amigos Biological Research Station 
in the Peruvian Amazon rainforest. There was a set of trails that I walked every day; on one of them there was 
a gap in the forest that allowed you to see out over the river. The view was incredible: on the clearest days 
I could see the snow-capped peaks of the Andes in the distance. One day I spotted this roadside hawk 
perched on the trunk of a cecropia tree by the river. I over-exposed the image to create this high-key effect.”
Kit Nikon D800 with Nikon 600mm f/4 AF-S II lens  Exposure 1/250 sec at f/5.6, ISO 640





roberTo laInez      “This is an old railway wagon abandoned many years ago in an area of The 
Railway Museum in Guatemala City. Immediately upon entering the area, the light and the way it softly 
illuminated the dust accumulated over the decades caught my attention. I couldn’t help thinking about 
how it must have been travelling in it during its heyday.”
Kit Nikon D7100 with Nikkor 35mm f/1.8 lens   Exposure 2 sec at f/9, ISO 720
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agus wahyudI, IndonesIa     “I live in Palangkaraya in Central Kalimantan. My hobby is 
macro and animal photography, which I have been practising for five years. I joined a macro photography 
group called Foto Macro Kalteng, and these shots of an iguana and a snail were taken at home.”
TOP  Kit Canon EOS 7D with 100m f/2.8 macro lens  Exposure 1/125 sec at f/7.1, ISO 200    
ABOVE  Kit Canon EOS 7D with 100m f/2.8 macro lens  Exposure 1/125 sec at f/7.1, ISO 200





Photography news from around the globe

Smartphone cameras take another leap with the launch 
of Sony’s Xperia X. Angela Nicholson takes a look

ot least because of 
their small sensor size, 
smartphones can’t beat a 
CSC or SLR, but for most 

people their image quality is more 
than good enough to negate an 
entry-level compact camera. And 
let’s not forget the key benefit of having a 
decent camera on a phone is that you carry 
it everywhere so you can capture everyday 
trivia and unexpected moments. Sony’s 
Xperia X could be especially useful for the 
latter because it is capable of switching 
from sleep mode to taking a picture in just 
0.6 sec. Naturally I wasn’t able to verify 
that exact figure when I got my hands on 
a unit at Sony’s London launch event, but 
it’s certainly fast in smartphone terms.
Inside the Xperia X’s main camera is 

a Sony 23MP 1 /2.3-inch Exmor RS sensor 

with the ability to shoot at ISO 12,800 in 
low-light conditions. Its Sony G-series 
lens has a focal length equivalence of 
24mm and a maximum aperture of f/2. 
While that aperture is useful in low light, 
the wide-angle lens (and small sensor) 
means that you’ll still have to get very 
close to your subject before you can start 
blurring backgrounds.

S tay  i n  f o c u S 
Perhaps the most exciting feature about 
the X is its Predictive Hybrid Autofocus 
system, which is designed to track a 
subject’s movement around the frame. 
That’s something we’ve seen in many 
compact system cameras for a while. All 
you need to do is tap on the 5-inch 1080p 
screen to identify your subject and the 
camera keeps it sharp while you tap the 
shutter release. Well, that’s the theory. It 
actually works pretty well even in gloomy 
conditions, but don’t expect 100% 
accuracy as fast-moving targets will 
escape its bounding box from time to time.
In addition to the Superior Auto mode, 

which is likely to be the most popular 
shooting mode, there’s a Manual mode, 
but this affords a disappointing level of 
control – you can only set sensitivity and 
white balance. Thankfully, the X seems to 
do a pretty good job with exposure on its 

own, but a bit of control over shutter speed 
would’ve been nice.
Naturally there’s also a front-facing 

camera for selfie-lovers. This has a 13MP 
1/3-inch Exmor RS sensor with a 22mm 
equivalent f/2.0 lens and a maximum 
sensitivity setting of ISO 6,400. That 
wide-angle lens means you don’t need 
ludicrously long arms or a selfie stick to get 
yourself in a shot.
As yet I haven’t been able to examine 

any images that I’ve taken with the X on 
a computer screen, but the results look 
very good on the phone screen. As you’d 
expect, noise is visible in images taken 
in very low-light conditions, but it looked 
within acceptable limits and the automatic 
white balance system coped well with 
artificial light.
£459; www.sonymobile.com

The Predictive Hybrid Autofocus system means you can 
keep your subject sharp until you’re ready to shoot.

FIRST LOOK
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are you 
Xperia’D?



LPOTY, 
anYbOdY?

c o n t e S t  o p e n

If £10,000, being featured in a 
major exhibition and the respect 
of your peers all sound good to 
you, why not enter this year’s 
Landscape Photographer of the 
Year Awards? Now in its 10th year, 
the contest boasts a prize fund 
worth £20,000 (with £10,000 for 
the overall winner) and is open to 
everyone, including a category for 
photographers aged 17 or under.

Images must be entered by 10th 
July 2016 to be considered for 
judging, and they must depict the UK 
landscape. Visit the LPOTY website 
for further details.
www.take-a-view.co.uk

YIn and 
SamYang

n e w  l e n S e S

Samyang has introduced a pair 
of new lenses for Sony E-mount 
cameras with full-frame sensors, 
unveiling the Samyang 14mm 
f/2.8 and Samyang 50mm f/1.4.

The brightest lenses in their 
class, according to Samyang, these 
new lenses expand Samyang’s lens 
range from manual focus-only optics 
to now include autofocus.

Samyang’s 14mm f/2.8 and 
50mm f/1.4 are compatible with 
both phase detection and contrast 
detection sensors, while the 
company says their 67mm diameter 
allows the maximum amount of light 
into the lens to create stunning 
bokeh and shallow depth of field.
£TBC; www.syopt.com
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google  
vs getty

rear eXit

Stock image giant takes 
on web search overlords

Leica’s new digital camera is so simple you 
don’t even need a back-of-camera LCD

l e g a l  d r a m a

n e w  l e i c a

etty has filed a 
formal complaint 
with the EU’s 

antitrust commission, 
claiming that Google is 
promoting the piracy of 
copyright photos by 
scraping images from 
third-party sites.
Getty says it’s seen a big 

drop in visits since 2013, when 

eIca’S latest digital 
rangefinder aims 
to take users back 

in time by completely 
omitting the rear LCD. 
Leica claims the M-D Typ 262 
will take users to a simpler time 
before digital photography. In 
the place of a rear LCD you’ll 
find an old-school ISO dial; the 
lack of a screen also means this 
digital rangefinder features 
controls for everything from 
shutter speed to drive modes.
Checking a photo straight 

after snapping it (or chimping) 
is such a common habit now 

G

L

Google started including 
high-resolution images on 
Google Images. “Because image 
consumption is immediate, 
once an image is displayed in 
high resolution, there is little 
impetus to view the image on 
the original source site,” Getty’s 
complaint reads.
http://wherewestand.
gettyimages.com/advocacy

that it seems perverse to leave it 
out. But consider how much of 
a crutch it is. How often do you 
take a dozen shots of a subject 
to ensure you got it right?
Leica’s sensors are famous 

for capturing great quality and 
detail; and the Typ 262 should 
have no problems doing the 
same thanks to its 24MP 
sensor. The Maestro image 
processor saves raw images, 
so you’ll be able to flexibly 
post-process any shots you 
didn’t nail perfectly.
£4,650/$5995; http://
uk.leica-camera.com

BOOK 
SHELF

daRK ROOmS
Former fashion 
photographer Nigel 
Shafron captures a 
series of banal scenes 
with a poetic grace. 
Texts by David 
Chandler and Paul 
Elliman make the 
connections between 
the five sets clearer.
£35/$50; 
mackbooks.co.uk

KOSen
Documenting the five 
years it takes to 
become a geisha, John 
Davies made repeated 
visits to Kyoto to shoot 
Kosen as she finished 
her training. The result 
is a stunning collection 
of images, exquisitely 
presented in this book.
£30/$45; 
thephotographers 
gallery.org.uk

magnum CYCLIng
Cycling aficionado Guy 
Andrews has clearly 
been busy scouring the 
Magnum archives for 
inspiring images. Here 
he brings together a 
showcase of cycling 
photography that 
includes greats such 
as Robert Capa.
£32; thamesand 
hudsonusa.com

New in print 
and digital 
formats
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PeaK deSIgn 
SheLL
The Shell is designed to 
work with Peak Design’s 
Capture Clip system, 
which attaches your 
camera to a belt or bag 
strap. The neoprene 
sleeve slips over your 
lens and body.
£28/$40; www.
peakdesign.com

Lee FILTeRS 
SuPeR STOPPeR
Lee Filters’ 15-stop 
Super Stopper is 
available in 150mm, 
100mm and Sev5n 
sizes (for CSCs). Expect 
to see an exposure time 
of 1/250 sec increase 
to two minutes.
£103/$150; www.
leefilters.com

Rounding up 
what’s new 
and exciting

FOCAL 
POINT

instant suCCess
The glory days of instant film photography 
return with this new camera release

p o l a r o i d  r e v i S i t e d

he Impossible 
Project is best 
known for buying up 

Polaroid’s film factory to 
produce new instant film for 
existing Polaroid cameras. 
However, six years after re-
inventing instant film, the 
German company has now 
created its own instant camera.
Meet the Impossible Project 

I-1. It bears a strikingly similar 
silhouette to the original Polaroid 
camera and it uses Type-600 
film, but that’s those are the only 
ways the two instant film 
cameras are alike.
Impossible Project’s CEO 

Oskar Smolokowski says that the 
I-1 is an analog camera for the 
digital age. It does everything 
your parents’ Polaroid camera 
did, only better, and furthermore 
adds the ability to connect to 
a smartphone.
While you can frame your 

shots and take photos with the 
shutter button, there are no 
controls on the camera itself. 
Instead you have to turn on the 
app and pair it to a smartphone to 
adjust your shutter speed and 
aperture. The app also offers 
specialised shooting modes, 
including double exposure and 
light painting.
By itself, the camera operates 

on automatic mode at all times, 
adjusting the exposure and 
racking focus on its own. Though 

T
there’s a viewfinder, there’s no 
light or chirp to tell you whether 
your subject is in focus other than 
to keep it centred in the flip-up 
optical viewfinder.
There is a plus/minus switch, 

which essentially acts as your 
exposure compensation, bringing 
the exposure up or down by a stop 
of light. Otherwise, you’ll have to 
take out your smartphone to 
tweak your settings.
It’s an interesting shift that 

forces you to stay in the moment 
and focus more on what’s in your 
shot rather than getting the 
exposure right.

i n  d e v e l o p m e n t 
Once you press the shutter, the 
camera spits out a photo and 
you’ll wait for a few seconds (or 
longer if you’re in a cold place) for 
it to develop.
All there is to the camera is a 

lens with a built in 10 LED (eight 
white, one red, one blue) ring 
flash wrapped around it, plus a 
built in light meter and autofocus 
system. You won’t find a single 
screen or even an indicator light 
on this camera.
The I-1 instant film camera is 

on sale now for $299 (£219) or 
$349 (£269) with three packs of 
film, and you can buy it from the 
Impossible Project, MoMA 
Design Store, Paul Smith and 
Selfridges in the UK.

manFROTTO 190 
gO! CaRbOn FIbRe 
TRIPOd KIT wITh 
baLL head
The 190 Go! develops 
Manfrotto’s popular 
190 series by being 
more travel-friendly. 
Carbon fibre legs keep 
weight down to 1.8kg, 
yet will support up 6kg 
of kit.
£360/$470; www.
manfrotto.co.uk

SOnY 
SuPPORT 

h e l p d e S k

Sony has announced it will be 
extending its Imaging Pro Support 
programme to include UK 
photographers from September. 
The free service includes a 
telephone helpdesk that will provide 
professional photographers with 
support in using their Sony cameras.

The scheme will also include a 
free collect-and-return service for 
Sony units requiring repairs, as well 
as a free back-up loan unit to keep 
professional photographers up and 
running in the interim. 

There will be no membership 
fee for the service, which will be 
available to photographers who 
own at least two camera bodies 
and three lenses from a qualifying 
list to be announced.
www.sony.co.uk

PRe-ZeISS 
FOCuS

Z e i S S  l e n S

ZeISS has launched its fastest 
and widest lens to date for a 
mirrorless camera. The new 
autofocus Zeiss Batis 18mm f/2.8 
E-mount lens is designed to be used 
with Sony’s Alpha 7 series. It will also 
work with smaller-sensor models 
such as the Alpha 6000 and the new 
Alpha 6300. (Review, page 102.)

Like all Batis lenses, focusing 
distance is viewable on an OLED on 
the lens barrel. The aperture range is 
f/2.8-22 and the minimum focusing 
distance is 9.8 inches. The Batis 
2.8/18 accepts 77mm filters, there’s 
a rubberised focus ring for when you 
wish to manually focus the lens, and 
it’s weather-sealed.
$1,499; www.zeiss.com
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before photoshop

Close-up Cam

Pioneering photos from Oscar Gustav 
Rejlander land at the National Portrait Gallery

Google’s new Art Camera lets you browse 
masterpieces in excruciating detail

v i c t o r i a n  e x h i b i t i o n

h i g h - r e S  c a m e r a 

nSeen photographs 
by the celebrated 
early Victorian 

photographer Oscar Gustav 
Rejlander have been 
acquired by the National 
Portrait Gallery, and will 
soon be on show to the 
public. Anticipating Photoshop 
by more than a century, Rejlander 
is known for his pioneering work 

combining multiple negatives in 
the darkroom to create new, 
artificial compositions.
As a portraitist, Rejlander 

influenced famous photographers 
such as Julia Margaret Cameron 
and Lewis Carroll, and he also 
collaborated with Charles 
Darwin and the Pre-Raphaelite 
Brotherhood of artists.
www.npg.org.uk

hen it’s not defending 
itself against Getty 
(page 19), Google has 

been dipping its toe into the 
camera market.
The Google Art Camera takes 

multiple high-resolution close-ups 
of artwork – each image is over 
a billion pixels – that are then 
stitched together into one image, 
enabling you to zoom down to an 
individual blot of paint or a crack 
in the canvas.
What’s more, the Art Camera 

uses a system of lasers and sonar 
that measures out an exact 

distance between it and the 
artwork, allowing it to focus its 
lens more accurately and ensure 
great detail without subjecting it 
to being exposed to bright light.
www.google.com/cultural 
institute/project/art-camera

U

w

manFROTTO 
SPeCTRa 2
At 153 x 93 x 45mm 
and 225g, Manfrotto’s 
affordable new 
hotshoe-mountable 
light panel is lighter and 
more compact than the 
company’s Croma 2 and 
MicroPro 2 panels, yet 
packs a 650 lux punch of 
daylight-balanced light.
£155/$220; www.
manfrotto.co.uk

Rounding up 
what’s new 
and exciting

FOCAL 
POINT

LaOwa 105mm 
F/2 SmOOTh 
TRanS FOCuS
The new Laowa 105mm 
f/2 lens features a wide 
aperture to ensure  
beautifully defocused 
backgrounds. The 
inclusion of a built-in 
‘apodisation’ filter  
helps create a smooth 
transition of bokeh.
£679/$699; www.
venuslens.net

FOCAL 
POINT

TOugh TaLK
a c t i o n  c a m

Between GoPros, Sony’s Action 
Cam and even Nikon’s recent 
KeyMission 360, there’s no 
shortage of ways to record the 
most extreme moments of your 
life. Now Olympus is getting in the 
game with a sensor-laden camera 
named the Stylus Tough TG-Tracker.

On top of shooting 4K movies 
with its 8MP 1/2.3-inch sensor, the 
TG-Tracer comes with an array of 
other sensors including a barometer 
to measure water depth and 
elevation, a compass and GPS.

The TG-Tracker camera also 
offers an ultra-wide 205-degree field 
of view, and the seven-element lens 
opens up to an f/2 aperture.
$349; www.olympus.co.uk

LITe wORK
c a n o n  m a c r o  l e n S

canon has unveiled a new macro 
lens for its EOS M range of 
mirrorless cameras, the EF-M 
28mm f/3.5 Macro IS STM. 
Featuring a compact and lightweight 
design that weighs just 130g, the 
lens employs what Canon says is the 
world’s first built in Macro Lite for 
removing shadow and darkness.

Used to illuminate small objects 
up close, the Macro Lite function 
allows you to alter the lighting 
intensity and direction.
£295/$299; www.canon.co.uk

VanguaRd VeO 42
Featuring a side pocket 
and strap to hold a travel 
tripod, the Veo 42 
backpack splits into two 
sections, with a top 
cavity that has enough 
space for a day’s 
supplies and a jacket. 
Camera kit is protected 
by a removable insert.
£54/$79; www.
vanguardworld.co.uk
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How to balance 
the brightness

At sunrise and sunset, the contrast between 
the sky and the foreground will be too high 
to record detail in both. One option’s to use 
a square graduated neutral-density filter to 
darken the sky. To position the transition, 
press the camera’s depth of field button as 
you look at the Live View screen. If hills and 
trees protrude into the dark section, ditch 
the filter and make two separate exposures 
– one for the land and one for the sky – then 
blend these later.

A M
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Pho t o 
Pro jeC t s

8 fresh and creative ideas to  
try – from street photography 

to double exposures…

P r o j e C t  1

Fields of 
lavender

Seize the opportunity to add a splash 
of colour to your summer scenics

oW is the time of 
year to get this 
landscape classic 

in the bag. Many lavender 
farms open their gates to the 
public when the plants flower 
during July and August, 
although the opening times 
don’t typically tie in with the 
best light of early morning or 
early evening. A friendly chat 
with the farmer and the offer 
of a free print may be all it 
takes to get permission to 
shoot during these times.

Getting low and close to 
foreground plants with a 
wide-angle lens will enable 
you to make the most of 
the leading lines created 
by the rows of lavender. Take 
your time to find the most 
attractive sections of the field 

and look for something of 
interest on the horizon, be it a 
tree, the sun or an interesting 
sprinkling of clouds. If you are 
shooting into the sun, as 
photographer Zhasmina 
Ivanova has done here, then 
shooting with a smaller 
aperture can produce an 
attractive starburst effect. To 
avoid flare, fit a lens hood and 
be ready to shield the front 
element using your hand.

Follow good landscape 
practice for sharp shots: use 
a tripod, an aperture of 
f/11-16, mirror lock-up and 
trip the shutter with a remote 
release. Working with a 
tripod-mounted camera gives 
you the space to compose 
with care too, so there’s no 
excuse for wonky horizons!

N



seafront 
street  

photography 
Take characterful  

candids at the coast

P r o j e C t  2

oASTAL resorts offer a feast 
of photo opportunities for the 
sharp-eyed photographer. The 

blend of colourful paraphernalia, faded 
glamour and hit-and-miss weather (in the UK 
at least) means that it doesn’t take long for 
an intriguing juxtaposition to come together.
 Fear of being confronted might put you off 
having a go at this style of photography, but, 
as Weymouth-based photographer Paul 
Russell confirms, it’s a rare occurrence. 
“I’ve been doing urban and seaside street 
photography seriously since 2004, and in 
all that time I’ve only had maybe three 
uncomfortable experiences,” he says. 
“When I’m shooting, I always have some 

vague explanation in mind about what I’m 
doing that focuses on themes rather than 
individuals that may be in the photographs – 
‘Oh, I’m doing a project on shopping in this 
road/seaside towns in spring’ and so on. 
I also have a business card within easy reach 
at all times – it seems to defuse a situation 
surprisingly quickly. 
 “I generally walk around slowly, without 
stopping at any particular location. I’m 
looking all the time but taking very few 
shots – in a typical two-hour session I may 
only take 10 pictures. When a scene does 
offer up a picture, the beach location often 
presents simple, graphic shots.”
www.paulrussell.info
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explore the 
underground

Create moody mono  
masterpieces on 

a Tube safari 

rAnSporT networks such as the 
London Undergound can fuel 
ideas for a photography project, 

whether you’re looking for a quick 
weekend fix or something more long term. 
From cavernous spaces to design details, 
there are numerous excellent photo 
opportunities that can be covered by the 
price of a single ticket, each of which could 
form the theme for a number of individual 
projects or be part of a much larger one.
 It was on a visit to London a couple of years 
ago that Andy Howe became taken with the 
possibilities offered by taking his urban 
photography underground. “Many of the 
most celebrated, and architecturally beautiful 
underground stations tend to be further out 
of central London and consequently are 
much less busy,” says Andy. “There are some 
fantastic examples of 1930s Art Deco design 

and some iconic stations such as Arnos 
Grove and Southgate on the Piccadilly line, 
Gants Hill on the Central line, and Hampstead 
on the Northern line. The stations have 
wonderful design features such as ceramic 
tiling, winding passageways and period 
fixtures and fittings.
 Obviously if you’re taking pictures on a 
transport system, you’ll need to travel light. 
“Tripods and flash are not permitted on the 
London Underground and, I’d guess, most 
urban metro systems, unless you have 
special permission,” says Andy. “I tend to 
use an ultra-wide angle lens (10-20mm in 
my case) to help deal with confined spaces. 
A shutter speed of 1/30 second is about as 
slow as I like to go, as this, combined with 
the image stabiliser on my lens, seems to 
produce a fairly sharp image.”
http://andrewhowe.format.com

T

P r o j e C t  3
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EFA Euro 2016 and 
Rio 2016 are set to 
make this summer 

one to remember for 
sports fans – and offer the 
perfect opportunity for 
documentary and street 
photography fans to flex 
their creative muscles. 
Instead of focusing on the 
sporting action itself, turn 
your camera on the houses 

clad in team colours, the 
supporters glued to their 
TVs, the celebrations and the 
fall-out when things don’t go 
to plan. Look for the small 
details that tell the story: a 
solitary flag in an unexpected 
location, people going about 
their daily lives while others 
are engrossed in the action, 
and messages of support in 
shop windows.

Sing a strong 
backlight to 
illuminate a leaf 

enables you to reveal its 
structure and colour in 
a vivid way. It’s a technique 
that also works well with 
delicate flowers. You can keep 
things simple and tape the 
leaf to a window or, as we’ve 
done here, stick the leaf to 
the lid of a plastic box and 

illuminate it with off-camera 
flash. Make the leaf as flat as 
possible to keep as much of it 
as possible within the shallow 
depth of field that results 
from working at close 
distances. A macro lens will 
let you fill the frame with 
detail, but you can use 
extension tubes and close-up 
diopters to adapt a normal 
lens so it focuses closer.

AThEr than taking 
trophy portraits of 
flowers, why not 

take advantage of the 
seasonal explosion of colour 
to try something a little 
different with your floral 
shots? There are a number 
of approaches you can take 
to create vibrant abstract 
images. For instance, you 
might opt to zoom in and 

isolate the curve of a petal, 
or move the camera during 
a slow exposure to create 
an abstract blur. You can 
combine several exposures to 
create a fusion of colour and 
shape, or combine techniques 
and images – try shooting 
both a sharp photo and a 
blurred one then blending the 
two together, as we’ve done 
to create this image. 

summer of sport
Document the highs and lows at home

Backlit leaves
Make a macro studio at home

Floral abstracts
Take a fresh approach to flowers

P r o j e C t  6

P r o j e C t  4 P r o j e C t  5

M
ar

cu
s 

H
aw

ki
n

s
S

h
u

tt
er

st
o

ck

P h o t o
P r o j e C t s





T

34            D i g i ta l  C a m e r a        JULY 2016 www.digitalcameraworld.com

shoot a 
single 

subject 
Pick an object that you 

can find everywhere 

hE greatest 
challenge that 
many of us face 

when starting a photo 
project is not so much 
overcoming any technical 
hurdles but coming up with 
an idea in the first place. If 
you’re fishing for inspiration, 
one easy option is to pick a 
single subject that you can 
use to bring focus to your 
photography. Choose an 
object that’s fairly widespread 
as this will enable you to keep 

topping up your project with 
images when you’re out and 
about. For instance, some 
people opt for doors or 
windows, others plump for 
the ubiquitous public bench. 
Here, we went for the slightly 
more niche ’shovel heads’ in 
a garden in Germany, but at 
least there were enough 
examples to build an 
interesting set. 
 You don’t have to treat the 
objects in an identical way 
photographically, as we have 

done here, but repetition 
provides a convenient way to 
make a collection of images 
hold together as a complete 
body of work. You can also 
use a compositional or editing 
treatment to link a more 
disparate set of objects. 
For instance, nominating a 
specific colour and shooting 
examples of it, be they 
full-frame and in-your-face or 
more subtle examples, is a 
great starting point for this 
type of project.

P r o j e C t  7
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oubLE-ExpoSurE images have been 
around for donkey’s years, but the 
ease with which digital cameras 

enable you to pull them has ensured their 
enduring popularity. Combining shots of people 
with textures from nature is a frequently used 
treatment. The trick here is to photograph both 
the person and the natural feature against a pale 
background, such as an overcast sky, where 
their outlines will appear distinct. The tops of 
trees work well, as illustrated in our example 
here, but specialists in this technique have put 
rock formations, flowers and waves to good use.
 Although you can combine a portrait and 
texture in-camera using a compatible model’s 
multiple-exposure mode, you’ll have more 
control if you do it in software. We’re using 
Photoshop CC here, but it’s a simple layering 
trick that works in everything from Elements to 
Gimp. We’ve covered the basic steps but you can 
go on to fine-tune the results using dodging, 
burning and cloning.

D

Step
Open your two images in Photoshop 
CC and convert them to Smart 
Objects. Use Select > All on the tree 
image and copy and paste this onto 
the portrait image. To combine the 
two, set Screen as the blending 
mode at the top of the Layers Panel.

1 Step
Using Edit > Free Transform, rotate 
and reposition the tree layer. Now 
use a Black and White Adjustment 
layer to convert the shot to mono 
and boost contrast with a Curves 
layer, before using Filter > Camera 
Raw Filter on the portrait layer.

2 Step
With the portrait open in ACR, select 
the Graduated Filter, set Exposure to 
+4.00 and drag gradients over 
sections you want to make white, 
such as the bottom and left sides 
here. Use the Adjustment brush to 
further tidy areas, then click OK.

3 Step
In Photoshop, highlight the top layer, 
click the Create Adjustment Layer 
icon and choose Gradient Map. Click 
in the gradient to open the Gradient 
Editor and click the cog icon to open 
the flyout menu. Pick Photographic 
Toning, then your preferred preset.

4

P h o t o
P r o j e C t s

Create 
a double 

exposure 
Make a portrait that mirrors 

this month’s cover image

P r o j e C t  8

ShaRe yoUR 
pRojeCT 

digitalcamera@ 
futurenet.com 

(subject line: 
Photo Projects)
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Master the headshot	 40

Natural lIght	 42

21st-century portrait lighting  44

Lighting modifiers	 46

Super strobes	 48

Retouching secrets	 50

Getting the look	 52

Raise your portraiture game with 
practical advice on camera skills, 
lighting rigs and Photoshop tricks

by JameS PaterSON

ortraiture is the 
genre that keeps on 
giving. There are always 
new skills to learn, new 
faces to shoot and new 
looks to achieve. Our 

advice over the next 16 pages will 
help see you through.

There’s a heavy emphasis on 
lighting here – with good reason. 
Whether it’s from the sun, a flash 
or a continuous lamp, light plays a 
huge part in the success of a portrait. 
Learning how to find the right light – 
or create your own – lies at the heart 
of all great portraiture. 

P
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Im a St e r  t H e 
H e a D S H Ot

Simple, elegant and timeless, a 
good headshot can reveal more 

about a person than any 
other type of portrait

f	you think of 
some of the world’s 
most celebrated 
and creative 

portrait photographers – 
names like Richard Avedon, 
David Bailey, Irving Penn – 
it’s their headshots that really 
stick in the memory. That’s 
because they do something all 
great portraits should: reveal the 
character of the subject. From the 
neck down, one person may be 
indistinguishable from another. It’s 
what’s up top that marks us all out 
as individuals. Our faces are our 
most expressive feature; a good 
headshot should celebrate this. 

Compared to some kinds of 
portrait, the humble headshot 
might seem a tad rudimentary. But 
there’s an art to getting it right, and 

it’s an important feather in any 
portrait photographer’s bow. 
Headshots are always in demand, 
whether it’s for a company website, 
school photos, actor’s headshots, 
passport pictures, or just for your 
own pleasure. 

In some ways a headshot is a 
simple thing: you needn’t think 
too much about composition or 
the background, as the head 
dominates the frame. But 
simplicity brings its own 
challenges, as it means you need 
to get the basics of lighting, depth 
of field and focal length absolutely 
spot-on. There’s nowhere to hide 
with a headshot.

However, the technicals are 
secondary here. More importantly, 
we need to coax something 
interesting out of our subject...

A diffuser for your flashgun 
and a reflector are all you 

need to create a classic 
‘clamshell’ lighting scheme.
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g e t  t H e  lO O K

l i g H t i N g

D e Pt H  O f  f i e l D

Ca m e r a  S K i l l S

St U D i O  S e t- U P

l e N S  S e t t i N g S

Find out the ideal exposure settings for 
natural light or flash-lit headshots

Control the way light falls across a face 
for portrait perfection

Get your aperture right for flattering 
portraits and blurred backdrops

When the subject is moving (as people almost always are), 
you’re restricted to faster shutter speeds. Here’s a good stock 
setting for outdoor headshots: set Manual mode, Auto ISO with 
shutter speed at 1/250 sec and the aperture at its widest setting, 
such as f/4. With flash, use a similar setting but with ISO 100. Take 
test shots to work out the best pairing of aperture and flash power.

if you’re using natural light, 
a window or shady spot is 
ideal for headshots. However, 
a flash kit will give pro results. 
A home studio kit is ideal, along 
with a plain wall or white sheet 
for the background.  For 
a simple, attractive 
‘clamshell’ lighting 
design like the 
shot to the left, 
position one 
light (ideally 
fitted with a 
softbox or 
umbrella [1]) 
above the face 
and camera, 
with a reflector 
[2] held below the 
chin to bounce light 
back upwards.  
If you’re using a 
second light, direct 
it onto the backdrop.

Wide apertures restrict depth of field and lead to blurred 
backgrounds – but how wide do you need to go? Here, the 
difference between f/2 and f/5.6 is just enough to blur the 
distracting background. You might think f/5.6 – the typical 
maximum aperture of a standard kit zoom – is fairly wide, but for 
beautiful blur it’s often not wide enough. As such, a prime lens with 
a wide maximum aperture like f/2 can prove useful for portraits. 

Even small adjustments 
can have a big impact on the 
look of the face. All subjects 
are different, but in general 
a slightly side-on stance 
works well. As you can see 
here (below), asking the 
subject to roll back their 
shoulders and push their 
head forwards slightly will 
tighten the skin and reduce 

double-chins. Camera 
height is important too: 
having the camera level with 
the eyes creates a strong 
connection. As with any 
portrait, it’s vital to put the 
subject at ease, so chat to 
them as you shoot, perhaps 
put some music on to help 
them relax and, vitally, offer 
lots of encouragement.

PRO ADVICE Posing the head

1

2

C O v e r  S t O r y
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W
hen you’re starting out, there’s 
no need to go out and buy a host 
of expensive lighting gear when 
you already have a source of free 

light that offers endless variety. Direct from 
the sun, light can be a bit harsh, but when diffused 
through clouds, or bounced off different surfaces it 
can take on all kinds of wonderful qualities. Then 
there’s the fact that it moves position and colour 
throughout the day, from warm and low in the 
morning to cool and overhead at midday, then 
back again. The great advantage you have with 
portraiture is a movable subject, so you can place 
them where the light looks best.

Harness the power of the sun  
for beautifully lit portraits  

in any location

W i N D OW  l i g H t

r e f l e CtO r S

avO i D  S U N l i g H tS e e K  C O N t r a St lO O K  f O r  S H a D e

WindoW light offers soft, 
directional illumination that 
can fall beautifully over a face. 
North-facing windows are best 
(north of the equator) as they 
don’t see direct sunlight. Try 
having the subject side-on 
(perhaps with a reflector to 
bounce light into the shadow 
side), or shoot with their back to 
the window and expose for the 
shadows for a high-key feel.

Light, inexpensive and hugely 
versatile, a simple reflector is one 
of the most important items in the 
portrait photographer’s kit bag. It 
acts almost like a secondary light 
source by letting you bounce light 
into shadows on the face. Here you 
can see the difference it makes: with 
the sunlight coming from behind, 
the reflector helps to bounce light 
back towards the face, evening out 
the contrast and adding catchlights 
in the eyes for a punchier, more 
saturated portrait (right).

When the sun is out, you may 
think it’s the ideal time to go 
out and shoot portraits. But 
sunlight can be unkind on faces. 
This is because light that comes 
from a small source is harsh, like 
a bare bulb; and while the sun is 
huge, for us it’s a small spot in a 
big sky. So avoid direct sunlight. 
It casts shadows of the nose 
across the face, shows up spots 
and makes subjects squint.

in most good portraits, the 
subject stands out from the 
background. One way to do this 
when shooting outdoors is to 
look for contrasting lighting 
between the subject and 
backdrop, either by having the 
subject in shade with a bright 
patch behind like this, or finding 
a spot where the light falling on 
them is brighter than the 
backdrop, like a doorway.

a	cLoudy sky or spot of 
shade is much better for 
portraiture than direct 
sunlight. In the shade, the light 
is far softer. It’s also less strong, 
which might mean increasing 
ISO, but that’s a worthwhile 
compromise for flattering light. 
If there’s no cloud, look for a 
spot in the shade of a tree or 
wall. Alternatively, shade the 
subject with your reflector.

N at U r a l 
l i g H t

t i P  1

K i t

t i P  3t i P  2 t i P  4

WITHOuT ReFLeCTOR WITH ReFLeCTOR



TOP TIP
Seek out places where the 

natural light is coming from 
one direction, like a window 

or doorway indoors, or a 
covered spot outdoors.
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N

Modern techniques and 
kit can help your images 

to stand out in a world 
awash with cameras

TOP TIP
For off-camera flash, 

a speedlight only needs 
to offer manual power 

control and an optical slave: 
features found on even the 

cheapest models.

21 St- C e N t U ry 
P O rt r a i t 
l i g H t i N g 

oW that anyone with a decent 
camera can take  a competent 
photo, photographers are 
constantly looking for ways 

in which technology can help set their 
lighting and technique apart from the 
crowd. One such approach used increasingly 
by wedding and portrait photographers is to 
supplement ambient light with off-camera flash, 
giving their images an edge over natural-light 
portraits. Another approach might be to include a 
heavy dose of Photoshop in the workflow, not just 
with creative composites like the image above, but 
also with more subtle colour shifts and effects.

Another technology that has come on in leaps 
and bounds is continuous lighting like LED 
panels, fluorescent tubes or simple lamps. These 
aren’t as powerful as flash, but any changes to the 
angle or power can be assessed instantly and 
they’re ideal for if you shoot both stills and video.
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Led panels have become 
increasingly popular. 
They’re far less powerful 
than flashes, but with 
SLRs performing ever 
better at higher ISOs, 
many will find this option 
a worthwhile compromise 
for the ease of use and 
colour temperature 

control that LED lighting 
offers you.

The Interfit LED panel 
used for this outdoor 
portrait provides a 
welcome fill to lift 
the shadows and to 
counteract the effects 
of the green light filtering 
through the leaves.

SuppLement natural 
light with flash and you 
can create a huge variety 
of looks, perhaps with a 
pop of fill flash to even 
out shadows, or maybe 
something more 
dramatic like this. Here 
the deep shade under the 
trees makes a balanced 

exposure between 
foreground and sky 
impossible without the 
use of flash (as the 
near-right image shows). 
Two speedlights lift the 
subject: one placed to the 
left of the camera, the 
other behind the model, 
to our right.

if you want to combine 
two images together to 
create something new 
or fantastical, it’s not 
just about Photoshop 
skills. The key to making it 
believable starts with your 
lighting. Each element to 
be combined should be lit 
at least roughly the same 

way. Here the light comes 
from the right in both the 
portrait and the 
background image, which 
helps everything to click. 
Once shot, it’s simply a 
case of cutting out the 
subject, dropping them on 
the new background, and 
adding a few shadows.

l igHt iNg  COmPOSiteS

f l a S H  O U t D O O r S

l i g H t i N g  W i t H  l e D s

t e C H N i q U e

t e C H N i q U e

t e C H N i q U e

Learn how to light each element in 
a composite image consistently

An off-camera speedlight or two 
can elevate your outdoor portraits 

Continuous lighting is simple, 
affordable and adaptable to all 

WITHOuT SPeedLIGHT WITH SPeedLIGHT



46            D i g i ta l  C a m e r a        JULY 2016 www.digitalcameraworld.com

O
ne of the great things 
about using studio 
heads is the sheer 
variety of modifiers 

and accessories that you can 
choose to attach to them. From 
huge softboxes to tiny snoots, these 
accessories will help you become 
a master of light, bending it to your 
will for any look you like. 

Essentially these modifiers allow 
you to change three qualities in the 
light: its spread, its strength and its 
softness. You can tell a lot about each 

Learn how to control the light 
your flash emits with accessories

l i g H t i N g  
m O D i f i e r S

b a r e  b U l b U m b r e l l a S O f t b Ox
t e C H N i q U e  1 t e C H N i q U e  2 t e C H N i q U e  3

Modifier-free direct flash 
is effective with care

Diffuse the light with 
a shoot-through brolly

The first choice of the 
portrait photographer

our single light source here is an 
Elinchrom head from a home studio kit. 
One of the simplest options is to fire it bare, 
without any attachment or modifier. This 
provides 180 degrees of hard light, which 
isn’t the most flattering or refined look, 
but can be a very dramatic effect.

Like all the shots here 
(barring the ring light), the light 
is positioned to the right of 
camera and above the face, 
and the subject’s body and 
face are angled towards the 
light source. Harsh light is 
often best employed when 
the subject’s face is angled 
towards it: at other angles it 
can produce unattractive 
shadows across the face. 

a	White umbrella will diffuse and spread 
the light to cover a wide area. It’ll give you 
a nice even illumination and fill in a 
lot of the shadows. With white 
umbrellas you have two options: 
angle the head away from the 
subject so the light bounces 
back off the umbrella, 
creating a very wide 
spread; or angle the head 
towards the subject and 
shoot through the umbrella 
to make the light more 
directional. While great for 
producing a spread of soft, 
flattering light, umbrellas 
aren’t as useful if you 
need to control where 
the light falls.

a	Softbox is a rectangular-shaped 
panel fitted with diffusers. It produces a 
wide bank of even illumination, which is ideal 
for portraits. Like an umbrella, 
softboxes will also produce soft 
light, but it’s more directional. You 
won’t get as large a spread of light 
with a softbox, so you have 
more control over which areas 
are illuminated, and which are 
in shadow. And when shooting 
close ups, softboxes create 
more attractive, rectangular-
shaped catchlights in the eyes. 
Softboxes come in all kinds of 
shapes and sizes, each with 
differing tasks. The larger 
the softbox, the softer and 
more even the light.

light by the way it affects the shadows 
under the chin on the images above. 
Smaller light sources like a bare bulb 
or a snoot cast sharp, hard-edged 
shadows, while larger sources like the 
softbox and beauty dish create softer 
shadows, with more gentle 
transitions between light and dark.

You also need to bear in mind the 
environment you’re shooting in. In 
a small room with white walls, the 
light will bounce off them and fill the 
shadows, while in a dark cavernous 
room there’ll be much less fill.
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It might sound slightly counter-intuitive, 
but the closer a light source is to your 
subject, the softer the light appears. 
Closer in, the size of the light increases 
in relation to the subject, and the larger 
a light source is, the more it fills out the 
shadows and the softer the effect 
becomes. As such, you’ll often see 
portrait photographers bring the lights 
in very close to the face.

PRO ADVICE  
Size and spread

S N O Ot r e f l e CtO r r i N g  l i g H t
t e C H N i q U e  4 t e C H N i q U e  5 t e C H N i q U e  6

Channel the light into a 
tight beam for true drama

Get the fashion look  
with a beauty dish

Shadowless light and 
beautiful catchlights

a	Snoot like the Interfit S-Type here 
channels the light down a tube into a 
circular opening, producing a very narrow 
beam of light. The light on the face here is 
hard, with deep shadows under the nose 
and chin. Unlike the other five 
shots here, there’s no spill of 
light across the background, 
and that’s why it comes out 
almost black. Because of this, 
snoots are useful for directing 
the light to a specific part of 
your subject. You wouldn’t 
often see one used in this way 
to light the face. More often 
they’re teamed with other 
lights, perhaps as a hair 
light to pick out details that 
need extra illumination.

a	beauty dish is a large parabolic 
reflector often used in fashion 
photography. A white, circular 
deflector directly in front of the 
bare bulb shades the subject 
from direct flash, bouncing 
the light back into the dish to 
produce a velvety quality of 
directional light somewhere 
between direct flash and a 
softbox. Shadows are soft yet 
defined, while the catchlight in 
the eye is circular.

There are two kinds of beauty 
dish. The metal kind can be 
fitted with honeycomb grids 
or white diffusers. There’s 
also the collapsible kind like 
the Interfit beauty dish here.

not an accessory as such, but a different 
kind of light altogether. A ring light is 
simply a circular ring of light that 
provides frontal illumination with 
minimal shadows. The idea is that 
you direct your lens through the 
circle, so the light comes from 
the camera position. It’s similar 
in some ways to the light from a 
pop-up, but it’s far more attractive 
as you don’t get the hard shadows 
pop-ups inevitably produce. 
Instead, you get beautiful, 
shadowless illumination, which 
is very kind to faces, and useful if 
you want to soften wrinkles. The 
other benefit is the attractive 
ring-shaped catchlights you’ll 
get in the eyes.

NeAR SuBJeCT AWAY FROM SuBJeCT
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W
hen you shoot 
portraits purely 
with natural light, 
you’re usually 

restricted to one ‘correct’ 
exposure. But when you start to mix 
natural light with flash, then you can 
manipulate the exposure to suit your 
artistic means.

Any time that you work with two 
different light sources, the key is all 
about the ratio between the two. You 
can’t control the power of the sun, for 
example, but you can change your 
speedlight power to alter the ratio 
between the two – as we’ve shown 

here by overpowering the midday sun 
for a dramatic moody portrait.

Notice how the boy’s hair has the 
look of a studio portrait with a nice 
hair light to bring out detail and 
texture. But this is in fact sunlight. 
Posed with his back to the sun, the 
natural light hits his hair, making it 
shine. By underexposing the shot for 
natural light, we effectively transform 
the sun into our secondary light 
source. Then we simply lift the face 
with our flash. Here’s how you can 
achieve similar results in just a few 
steps, with the help of an off-camera 
flashgun and the sun…

Overpower direct sunlight for 
moody, dramatic results with 
an outdoor lighting setup that 

won’t break the bank

g e t  t H e  S H Ot
S e t  U P

U N D e r e x P O S e 
W i t H  f i lt e r S

e x P O S e  f O r 
a m b i e N t  l i g H t

l i g H t 
t H e  faC e

All you need for this is a 
speedlight fixed to a stand with 
a silver umbrella attached, plus 
an ND filter and a means of 
triggering the flash off-camera, 
like radio triggers, a sync lead or 
your camera’s wireless flash 
system. (We used Nikon’s 
commander mode with the 
SB-900 here). Direct the 
speedlight into a silver umbrella 
for soft, diffuse light.

Next, underexpose the ambient 
light. You could do this by 
tightening the aperture, but then 
you’d also increase depth of 
field, and in this case you want it 
shallow to blur the background. 
So instead, add an ND filter and 
a polariser. The two filters 
combined block out about four 
stops of light, which makes the 
sky look better but leaves the 
face far too dark.

Don’t turn on the flash yet. 
Instead, set the camera to 
Manual mode and work out an 
exposure for the ambient light. 
If it’s very bright, start with ISO 
100 and a shutter speed of 
1/200 sec, then adjust the 
aperture in further shots until 
the face is correctly exposed. 
Here we had f/4. With his back to 
the sun, this correctly exposes 
the face but blows out the sky.

Now you can turn on your flash. 
On a sunny day you’ll be working 
at the power limits of most 
speedlights, so start in Manual 
at full (1/1) power, then reduce 
if necessary. We positioned our 
flash (bounced off our silver 
umbrella) directly above the face 
here (about a metre away), with 
a silver reflector placed on the 
ground to bounce light back up 
into the shadows.

S U P e r 
St rO b e S

St e P  1 St e P  3St e P  2 St e P  4

C O v e r  S t O r y



TOP TIP
LIght from a speedlight will 
almost always look better 
when it’s diffused with a 

modifier like an umbrella, 
or bounced off a wall.
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r e tO U C H i N g 
S e C r e t S

Pressing the shutter is only half the job: whether it’s 
simple adjustments or more intensive retouching, 

finishing off the image is equally important

ove it or hate it, 
Photoshop has 
changed the way 
portraits are 

created – and it’s also changed 
the way we perceive portraiture 
as truthful or not. With a few skills, 
anyone can transform a portrait into 

whatever they please. But when you 
can get rid of every wrinkle, drop 
three dress sizes and remove every 
imperfection, the real skill is in 
knowing when to stop.

The art to good retouching is 
making subtle, almost imperceptible 
alterations. The three tricks explained 
here will help. First we’ll use two tools 
cherished by retouchers – Heal and 
Clone – to tidy up marks and spots. 
Then there’s a skin softening technique 
that works wonders, softening and 
smoothing out skin while still retaining 
the delicate skin texture that so many 
inferior methods obliterate. And finally 
is a useful trick for reducing eye bags 
that lets you lift dark tones without 
losing detail.

Professional retouchers might 
spend hours working up a single image, 
but thankfully, these tricks take much 
less time to achieve…
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C O v e r  S t O r y



S O f t e N  S K i N

H e a l  a N D  C lO N e r e D U C e  b ag S

t i P  3

t i P  1 t i P  2

This superlative softening technique 
retains the fine texture of the skin

The Heal and Clone tools are great 
for quick and effective retouching

This quick trick reduces unsightly eye 
bags while preserving fine details

Duplicate the background layer then invert it with Ctrl/Cmd+I. Set 
the layer opacity to 50%, and change the Blend Mode from Normal 
to Linear Light: your image should now be grey. Go to Filter > Other > 
High Pass and set the Radius to around 9px. Go to Filter > Blur > 
Gaussian Blur and set it to around 3px. Finally, Alt-click the Add Mask 
icon for a full black mask, then paint white over the skin to reveal the 
softening effect.

Photoshop’s Spot Healing Brush lets you remove spots, blemishes 
and stray hairs by painting over them. Switch to the Clone Tool when 
you need to blend untidy patches or rough skin. Set the tool to 20% 
and Alt-click to sample a clean area nearby, then gradually clone over 
the problem area. Both tools can be set to ‘Sample All Layers’, so it’s 
best to use them on a new empty layer to preserve your original 
image. That way, you can change your mind later…

Add a Curves Adjustment Layer, then click on the Curves layer 
thumbnail to deselect the mask. Double-click the black point 
eyedropper in the Curves settings, then sample a clean skin tone. 
Click OK, then click over the dark eye bag. The shadow tones will 
change colour to match the first sampled tone. Now you simply mask 
it to cover just the bags. Highlight the mask thumbnail and press 
Ctrl/Cmd+I to invert, then paint with white over the eye bags.

Dodging and burning 
might seem more suited 
to landscape photography 
than portraits, but a little 
selective lighting and 
darkening can have a huge 
impact. Here’s one way to do 
it: Alt-click the new layer 
icon, set the Blend Mode to 
Overlay and tick the Fill With 
box, then paint white or 
black over the image.

More important than the 
method is where you dodge 
and burn. With a few subtle 

strokes,  
you can 
emphasise 
the contours 
in the face in 
much the 
same way as 
a make-up 
artist. In general, aim to 
lighten the centre of the 
forehead, the area below 
the eyes and the chin; then 
darken the hairline, below 
the cheekbones and 
underneath the chin.

PRO ADVICE Dodge and burn the face

www.digitalcameraworld.com  JULY 2016       D i g i ta l  C a m e r a             51

C O v e r  S t O r y



52            D i g i ta l  C a m e r a        JULY 2016 

T

g e t t i N g 
t H e  lO O K

Whether inspired by vintage 
films, analogue effects or 

cutting-edge digital work, with 
a combination of lighting and 

Photoshop skills we can create 
a huge variety of looks

he best portrait 
photographers get 
to where they are 
because they settle 

on a look that works for them, 
then hone it to perfection. 
This could be masterful control 
of classical lighting, genius-level 
creative Photoshop abilities, or a 
throw-out-the-rulebook manner. 
Choose an approach or specific look 
that appeals to you, then put in the 
time to perfect it and carve out your 
own niche. Inspiration can be drawn 
from everywhere you look – films, 
magazines, the web, even people on 
the street. Here are four looks to try 
out, each achieved with a cunning 
combination of lighting and 
Photoshop skills...

for the moody look of a 1930s film 
noir, why not try lighting with a gobo? 
Short for ‘go-between’, a gobo can be 
anything placed in front of your light 
source that casts an interesting shadow 
onto the scene.

A blind is a classic example, casting 
strips of light across the scene. For 
this shot, two lights were used: one 
positioned off to the left of the camera, 

with the blind placed in front, fired bare 
for hard, well-defined shadows; and 
another light off to the right, directed at 
the face with a honeycomb modifier to 
narrow the beam.

A combination like this gives the 
perfect look for a punchy black and 
white conversion. Don’t forget to add 
plenty of grain in post-production to 
really enhance the retro feel.

H O l ly WO O D  g l a m O U r
lO O K  1

Use gobo lighting to build an iconic  
look made famous by the silver screen

C O v e r  S t O r y



an effects-heavy portrait treatment 
like this is easier than it looks. Begin 
with a studio-lit portrait against plain 
grey. Then you simply make shapes 
with Photoshop’s Shape Tool, add a 
colour and experiment with different 
Blend Modes. (Hard Light, Linear Light 
and Divide work well here, for example.) 
To offset the portrait, ‘clip’ a duplicate 
to a Shape Layer: drag it above the 

shape in the layer stack and Alt-click 
the line between the two.

Images of textures like the 
weathered leather used here can also 
look great when blended with portraits 
(try Overlay or Soft LIght).

You’ll find the full technique 
explained in our 13-minute streaming 
video, which you can watch via  www.
bit.ly/dc179video

one of the few analogue effects to 
make as big an impact on the digital 
world, double-exposures are hugely 
popular, not just in stills but also in 
music videos and TV programmes. 
Shoot an underexposed portrait taken 
against a bright, blown-out backdrop 
like a sky. This way, the second 
exposure will be confined to the 
shape of the body.

The Photoshop part is simple: copy one 
image on top of another, then simply 
change the Blend Mode to Screen. (You 
can also do this with video layers in 
Photoshop.) It’s perfect for conceptual 
portraits as you can literally get inside 
your subject’s head.

For more help with this technique, 
see our double-exposure tutorial in 
Photo Projects: turn to page 36.

Like the moody flash-lit portrait 
on page 48, we’ve used an 
off-camera speedlight here to 
overpower the natural light. But this 
time it’s positioned on a stand directly 
behind the subject (covered with a clear 
plastic bag to prevent it getting wet) 
and fired bare at full power. The 
resultant backlighting captures the 
falling rain beautifully, creates deep 

shadows and darkens the background 
– even though the shot was actually 
taken in broad daylight.
As for post-production, here it’s 
minimal. Try increasing Clarity in 
Camera Raw to crisp up the rain, and 
add blue into the shadows with 
Photoshop’s Color Balance command. 
Pick an umbrella colour in advance that 
will set off the blue nicely.

D i g i ta l  a rt

D O U b l e  e x P O S U r e

b aC K l i t  r a i N

lO O K  4

lO O K  3

lO O K  2

If you want to go all out with Photoshop, 
why not try a geometric mash-up? 

Replicate the old film technique of exposing the 
same frame twice for evocative portraits

A downpour looks wonderful when lit from 
behind with an off-camera speedlight
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How focal length and sensor size determine what your camera ‘sees’

1  
focal length
As the name suggests, a wide-angle lens offers 
a wide angle of view, while a telephoto lens – 
one that has a long focal length – produces 
a much narrower angle of view.

2  
camera position
The field of view – the physical distance captured 
across an image – changes depending on how near or 
far a camera is to the scene being photographed, but 
the angle of view is determined by the focal length.

3  
camera type
Although the angle of view 
is fixed at each focal length, 
the size of the imaging 
sensor inside the camera 
can have an effect on the 
overall angle of view that’s 
recorded in the picture.

4  
Diagonal angle
When you check a lens’s 
specifications, the angle of 
view is typically quoted for 
the diagonal  of the image.

ANGLE of view is a measure of how 
much of a scene or subject a lens 
can take in. Expressed in degrees, 
the angle of view can be measured 
horizontally, vertically or diagonally 
across an image. It’s the focal length 
that’s key: lenses with shorter focal 
lengths are able to capture more of a 
scene in a single shot, while longer focal 

lengths offer a much narrower view. 
You can, of course, move your camera 
further away in order to bring more of a 
scene in to the picture or move closer to 
produce a tighter shot – or stay where 
you are and adjust the setting on a 
zoom lens – but the angle of view for 
the chosen focal length doesn’t change. 
What does change is the relationship 

between the objects in the picture if you 
physically move closer or further away. 
Step forward with a wide lens and you’ll 
continue to capture more of the 
background relative to the subject of 
the photo. A long lens will continue to 
take in a much smaller portion of the 
background relative to the subject as 
you move away.



b a c k  t o  b a s i c sangLe of view
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HEN photographers talk 
about a lens’s focal length, 
what they’re really concerned 
about is the angle of view. 

This is because the angle of view determines 
how a scene can be framed and composed. 
Long lenses with focal lengths of 200mm, 
300mm or 400mm and beyond offer narrow 
angles of view that make it easier to isolate 
objects within a wider scene.

The drawback to having an angle of view 
of just a few degrees is that it’s equally easy 
to lose track of a subject, as a slight shift 
in the position of the camera can have a 
dramatic effect on which area is picked out 
by the lens. This problem is compounded if 
you’re following a moving subject, as anyone 
who’s tried photographing fast-flying birds 
up close through a 600mm lens will know!
 Wide-angle lenses flip this problem on its 
head. Focal lengths in the region of 16-35mm 
are capable of sucking in a great deal of 
a scene in one photo, and consequently 
it’s easier to initially frame the shot and to 
recompose quickly. The downside of taking 

in an angle of view of almost 100 degrees is 
that it’s easier for distractions to creep into 
the frame and it’s more challenging to make 
an object stand out from all the ‘noise’. 
 You can exploit the traits of different 
angles of view creatively.  For instance, as 
well as being essential in confined spaces 
where you can’t physically move further from 
a subject, getting up close with a wide-angle 
lens means that you can capture both a 
subject and its surroundings in one picture. 
You can also play with scale, as objects 
closer to the camera will appear much 
larger in relation to those in the distance.
 Longer focal lengths take in a much 
narrower section of the background. Not 
only does this make it easier to compose 
a ‘cleaner’ shot  – a small movement of the 
lens is all it takes to find a more suitable 
section of the backdrop – but it magnifies 
that part of the background too. You can 
use this aspect to make distant  buildings, 
mountains or even the moon appear much 
larger in relation to the objects in the 
foreground. The trade-off here is that you’ll 

have to be shooting from a greater distance 
to squeeze them both into the shot.
 As you’ll see above, sensor size makes 
a difference, with smaller sensors such as 
Nikon’s DX format requiring much shorter 
focal lengths to achieve a wide angle of view 
than their full-frame counterparts. But the 
way in which small sensors effectively 
increase the focal length of a lens can 
make them useful for long lens work.

W

Why sensor size is important

Full-frame
These sensors are the same 
proportions as a frame of 35mm 
film and capture the full view of 
compatible lenses.

APS-C
Being either x1.5 or x1.6 smaller 
than a full-frame sensor, an 
APS-C sensor gives a narrower 
view with the same lens. 

Four Thirds (4/3)
These sensors are half the size of 
a full-frame one, so a 50mm lens 
on a Four Thirds camera gives 
the equivalent angle of view as a 
100mm lens on a full-frame SLR.

The downside of 
taking in an angle of 
view of almost 100 
degrees is that it’s 
much easier for 
distractions to creep 
into the frame

THE size of the imaging 
sensor has an impact on the 
effective focal length of a 
lens, and consequently the 
angle of view. With 35mm 
film cameras and full-frame 
digital cameras, the focal 
length gives a good guide to 

the angle of view. But cameras 
with smaller APS-C or Four 
Thirds sensors capture a 
smaller area of the image 
projected by the lens. This 
means that shorter focal 
lengths are required to get  
the same angle of view.
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Wide-angle

Standard

telephoto

Super telephoto
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98̊

84̊

74̊

65̊

46̊

28̊

23̊

15̊

10̊

8̊

6̊

4̊

84̊ - 114̊

62 -̊ 84̊

35̊ - 62˚

8 -̊ 35̊

4̊ - 8˚
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fOCAl lENgTH
How to select the right lens for the shot
THE shorter the focal length is, 
the wider the angle of view. For 
instance, an 8mm fisheye lens may 
be able to take in a huge 180-degree 
view – and there’s a risk that your 
feet will inadvertently end up in the 
picture if you’re not careful. Super 

telephoto lenses, on the other hand, 
may offer an angle of view of just 
three or four degrees. To the right, 
you’ll find a list of common 
horizontal angles of view and the 
focal length required to achieve 
them with different sensor sizes.

aNgle  
OF VieW 98° 84° 65°

4/3  8mm 10mm 14mm

aPS-C  10mm 14mm 20mm

Full-Frame  16mm 20mm 28mm

aNgle  
OF VieW 54° 49° 40°

4/3  17mm 20mm 25mm

aPS-C  24mm 28mm 35mm

Full-Frame  35mm 40mm 50mm

aNgle  
OF VieW 28° 15° 10°

4/3  35mm 70mm 100mm

aPS-C  45mm 90mm 135mm

Full-Frame  70mm 135mm 200mm

aNgle  
OF VieW 7° 5° 3.5°

4/3  150mm 200mm 300mm

aPS-C  200mm 250mm 400mm

Full-Frame  300mm 400mm 600mm
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BACKgROUND MATTERS
where you stand makes a big difference 
to how large or small distant objects appear
CHoosiNG the right focal length for 
a situation isn’t simply a matter of 
working out how large or how small 
you want the subject to appear in 
the picture: it’s also about the 
perspective and the overall look you 
want to achieve. Here you can see the 

power that perspective can have. One 
photo has been shot from a distance 
with a 200mm telephoto lens; the other 
has been shot up close with a 20mm 
wide-angle. The subject size might be 
consistent between the two images, 
but that’s about it. You can see how the 

wide-angle lens has captured much 
more of the environment, although 
having to shoot within such close 
proximity has resulted in some 
distortion on the features close to 
the camera. The telephoto lens 
doesn’t show the same distortion.

extension 
Choosing a 20mm lens and shooting within a few feet 
means that much more of the background is visible. As 
a result, the subject appears much larger than objects in 
the distance. This is what’s known as extension distortion, 
which can make for more dramatic results. It’s not 
particularly flattering for portraits, though…

TElEPHOTO wIDE -ANglE

Subject

Background

KeY

Compression 
To maintain the same 
subject size, the 200mm 
shot had to be taken 
from a much greater 
distance than the 20mm 
shot. The narrow angle 
of view means that a 
much smaller slice of the 
background is included 
in the shot, which makes 
it appear much larger in 
the frame and much 
closer to the subject – 
this is compression 
distortion in action.

neXt
month

get to grips 
with image 

stabilisation
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Many 
entrants to 
photography 
competitions 
think they 
need to go to 

exotic locations to get winning 
shots, but sometimes you only 
need to go down the road. 
Bath resident Mark Benham 
recently won Pink Lady Food 
Photographer of the Year with 
this shot of Duncan Glendinning, 
who runs the Thoughtful Bread 
Company in, you’ve guessed it, 
Bath. “The wife of a friend of 

mine is a food stylist and writer, 
and she suggested I get in touch 
with Duncan,” Mark explains. 
“So I went along on a day when 
he was working a double-shift, 
as they were short staffed.” 

Mark took the images in the 
hot and cramped basement of 
the bakery, in less than ideal 
light. Fortunately there was a 
space with a clean background, 
against which Mark framed this 
shot of Duncan. “It was about 
four in the afternoon and I was 
getting pretty tired, so I 
suggested we had a bit of fun. 

Duncan was making dough and 
threw in some flour, and that is 
how this shot came about.”

Originally Mark was going to 
use a flashgun, but technical 
problems meant he had to rely 
on high ISOs and fast lenses.  
“I increased the ISO to 2,000 
and used a Canon EF 50mm 
f/1.8 lens, which is fast, sharp 
and very reasonably priced. 
You don’t always need the latest 
and greatest gear, and money 
constraints mean I need to 
make the most of my kit.”
www.markbenham.co.uk 

Flour 
Power 

The winner of Food 
Photographer of the Year 

reveals some tasty 
secrets for success
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1  The shutter speed was 1/640 sec 
at f/4.5, using Single-Point autofocus. 
Duncan shot in Aperture Priority mode, 
as he was working fast and needed 
some degree of automation. 

2  Mark focused on Duncan’s eyes. 
The fact that Duncan isn’t staring 
directly at the camera or ‘posing’ gives 
the images much more of an authentic 
documentary feel. At the same time, 
you get a sense of a hard-working 
artisan who clearly enjoys his work.

3  There is a lot going on in the 
foreground of this image, so it was 
important that the background was 
sympathetic and non-distracting. 

4  Mark did minimal tweaking:  
“I edited the image in Adobe Camera 
Raw and began by adjusting the lens 
profile and boosting Clarity, Vibrance 
and Contrast.” After upping the whites, 
he then imported the image into 
Photoshop and used some simple 
Adjustment Layers.

Why it works

4

3

2

1
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The dance 
oF lighT

#2

Dried flowers are 
creative flowers, 
particularly with 

innovative lighting

London-based 
enthusiast 
photographer 
Polina Plotnikova 
is on a roll this 
year. Already she’s 

won a Food Photographer of the Year 
category and received a Commended 
gong in the Garden Photographer 
of the Year for her still-life work – 
including this image, ‘The Last 
Dance’. It’s a great example of her 
simple but highly creative approach 
to still-life photography in the studio. 

“This image is part of an ongoing 
project on dried flowers,” she 
explains. “It’s an orchid – I love 
orchids – and I dried it out to reveal 
the interesting lines and shapes it 
makes when dead.

“I am very much a studio-based 
still life photographer. Other genres 
are fun, but this is the one that suits 
me best. If I can produce two images 
a month that I am happy with, that is 
great, although that might not seem 
particularly productive to other types 
of photographers.”
www.polinaplotnikova.com 
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1  “I shot the 
orchid against 
a Bowens softbox, 
placed behind it as 
backlighting. The 
background is just 
ordinary baking 
paper. I do 
sometimes use art 
paper from art 
shops, but this had 
such a nice, fibrous, parchment  
feel, with a lovely pattern.”

2  The second source of light is another 
Bowens flashlight, used with an umbrella in 
front. “In other words, the orchid is between 
two flashlights,” Polina explains. 

3  “Usually I know in advance whether  
I will convert an image into mono or not.  
I do also shoot in colour to be on the safe 
side. In terms of Photoshop, I did the 
minimum to this image – cropping,  
curves, correction, contrast, 
sharpening, and the black-and-white 
conversion.”

lighting set-up

3

WB

AF SET

2

1
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#3

Taking a 
diFFerenT 

view

research  
and experimentation 

can yield great 
documentary results

a distinguished press 
photographer for the 
AFP agency in London, 
Adrian Dennis had to 
‘think different’ when 
covering the Queen as 

she inspected a cadet Guard of Honour 
at Berkhamsted School in this, her 90th 
birthday year. 

“Because many of the ‘royal boys’ 
[the photographers that make their living 
shooting these kind of events] had filled the 

main areas allocated to the photographers, 
I chose a different position,” Adrian explains. 
“I’ll usually try and do this if I’m allowed – 
mainly because I can’t see the point of 
shooting the same picture as 15 other guys, 
but also I didn’t necessarily think theirs was 
the best angle.” 

He had to park half a mile away and wheel 
all his photographic gear in, but he says the 
effort was worth it.
http://portfolios.afp.com/photographer/
adrian-dennis.html

the eyes have it
1   Not knowing exactly where he would be in 

relation to Her Majesty, Adrian lugged in three Canon  
SLRs and four lenses (24-70mm, 70-200mm, 
300mm, and 500mm). “I was adamant I was going to 
use the 300mm lens on my latest body, the amazing 
Canon EOS-1D Mk II. It’s a great combination: the 
autofocus and sharpness is incredible.” Earlier, 
Adrian had quizzed a cadet officer who told him the 
best place to stand. “The allocated photographers’ 
position was too head-on and wouldn’t lend itself to 
seeing the cadets in the background.”

2   Being in a better position also enabled him to get 
the eye contact between the cadet and HRH. “I want 
my picture to give a clue to what the Queen is doing 

1

2

on that particular day, whereas the ‘royal boys’ are 
looking for a timeless, ‘clean’ portrait of her. To keep 
everything sharp at 300mm, Adrian kept a high 
shutter speed of 1/2,000 sec at f/4, ISO 250. 



Portrait  & 
wedding StarS

Learn how to shoot, style 
and sell contemporary 
portrait photography with 
Canon USA Explorer of Light 
and award-winning Sue 
Bryce at the Societies of 
Photographers Convention. 
The 2017 Convention line-up, 
running from 11th-15th 
January, includes 200 hours of 

seminars, with many exciting 
speakers from around the 
world such as Sue Bryce, Kelly 
Brown and Lindsay Adler as 
well as some of the top UK 
photographers – making this 
an international event of the 
highest calibre. (Sue Bryce 
workshop: 12th January 2017. 
Booking required.)

For your wedding and 
portrait photos, the multiple 
award-winning PortraitPro is 
an indispensable tool. This 
quick and easy portrait-
retouching software will help 
you process the whole shoot in 

minutes. Run it as stand-alone 
software or use the plug-in and 
batch modes in the Studio 
Edition to process hundreds of 
images effortlessly. Extra 10% 
off any sale or list price: 
enter SM7847 at checkout.

Improve your creative 
portraiture, develop skills 
and build your photography 
portfolio with Melencourses. 
This is an exciting and enjoyable 
photography course at Ashridge 
House, Hertfordshire, with 
decorative Victorian-style period 
rooms, beautiful gardens and 
gothic exteriors. You will take 
away a set of creative and 
beautiful images. Learn new 
flash and natural lighting skills 
with the confidence to create 
your own portraits.  

Snap and RYS have teamed 
up to create the ultimate 
one-day event, led by 
award-winning wedding, 
documentary and fashion 
photographers. Join us for a 
day of talks and workshops, 
live shoots and a kick-arse 

party. We’ll focus on practical 
and inspirational topics like 
storytelling, SEO, fashion, 
lighting, branding and 
direction. Join photographers 
from all over the globe for the 
UK’s coolest conference in 
Liverpool on 1st November.

C o n t e m p o r a ry  p o rt r a i t s  
m ast e r  C l as s  w i t h  s u e  b ryC e t h e  u K ’ s  C o o l e st 

p h oto   C o n f e r e n C e

g o  to :  s w p p . c o . u k /c o n ve n t i o n

F r e e  t r i a l :  w w w. p o r t ra i t p ro . c o m g o  to :  w w w. m e l e n c o u r s e s . c o . u k           

g o  to :  w w w. s u m m i t 2 01 6 . p h o t o g ra p h y

JONAS PETERSON // SAM HURD // NESSA K
DANIEL AGUILAR // 2 BRIDES PHOTOGRAPHY

LOVE MY DRESS // SAM DOCKER
CINZIA BRUSCHINI // CLAIRE PENN // NISHA RAVJI
LUKAS PIATEK – LOOKSLIKEFILM // ROSIE HARDY

S6 PHOTOGRAPHY // BABB PHOTO // STEVE GERRARD
THE CRAWLEYS // RIMA DARWASH // THE LAWSONS

HEATHER JOWETT // ROSSELLA VANON
WITH DJ SETS BY

S6 PHOTOGRAPHY // JOHN HOPE // STEVE GERRARD

BUY YOUR TICKET AT:
SUMMIT2016.PHOTOGRAPHY

r e to u C h  p o rt r a i t s  w i t h  f l a i r

C r e at i v e  
p o rt r a i t  
p h oto g r a p h y 
C o u r s e s

a d V e r t i S i n g  F e at u r e
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Members of the global Digital Camera community share their work with you…

Get Involved!
If you’d like to take part in any 
of the features in Photo Active, 
please send us an email at 
digitalcamera@futurenet.com 
with one of the following in the 
subject line: Rate My Photo, 
Shootout, Portfolio or Photo 
Answers. Please include your full 
name, contact details (including 
a daytime phone number) and a 
sample of your work (max 10MB)

66

shOOTOUT
Our special portrait issue continues 
as two readers work with lighting to 
improve their people shots 

FaCebook www.facebook.com/
digitalcameraworld

FliCkr www.flickr.com/ 
groups/digitalcameraworld

twitter www.twitter.com/
digitalcameraw

PHoto
aCtiVe

aSSigNmeNt
82   See the winners 

in our ‘dusk to 
dawn’ challenge

72 74

PORTFOLIO
Reverse-mounting his lenses enables 
Imran Ahmad to capture fish close-ups 
on an epic scale

PhOTO ANsWERs
Help with viewing focus points in 
Lightroom plus cities at night, flashgun 
diffusers and adding drama to shots
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out!Shoot
Two readers take on a studio-based 

challenge in the wild West Midlands

stUdio Lighting

For this  month’s Shootout, Ben Brain tasked 
two readers to get to grips with studio lighting 

and off-camera flash techniques

Join us and learn new skills! Email digitalcamera 
@futurenet.com (subject line: Shootout). 
Please include your address and phone number

Camera:  Canon Eos 70d

loCation:  northampton, northamptonshire

Camera:  Canon Eos 5d Mark iii

loCation:  Poole, dorset

WILL started taking 
pictures with  a 
Minolta SR101 35mm 
film camera when he 
was a teenager in 
the late 1970s. “Life 
happened,” as he puts 
it – he’s now the 
managing director 
of a financial advice 
firm – and it wasn’t 

until three years ago 
that he got back into 
photography again. 
His core kit includes a 
Canon EOS 70D with 
Canon 40mm, 50mm 
and 85mm EF primes 
and a Sigma 18-35mm 
zoom. He’s also a keen 
user of Phottix Mitros 
flashguns.

BEING a graphic 
design studio 
manager in Poole 
meant that Simon 
faced an eight-hour 
round trip for this 
month’s Shootout. 
But he was keen to 
make the long journey, 
as he wanted to test 
himself when it came to 

lighting set-ups and 
directing a model. 
Simon specialises in 
wedding photography 
and has seen some of 
his work published in 
Dorset, Wiltshire & 
Hampshire Bride 
magazine.
www.sawedding 
photography.co.uk

READER 1 READER 2

You CoulD take 
part in our next 

reaDer shootout
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We used Indra360 and Indra500 TTL 
studio lights, with Phottix Odin II TTL flash 
triggers attached to the hotshoes of Will 
and Simon’s Canon SLRs to provide 
cable-free control. Working with the 
camera in Manual exposure mode meant 
that the shutter speed, aperture and ISO 
could be locked in, with the power of the 
lights being adjusted via the flash trigger 
to increase or decrease the brightness.

WE spent the day at the 
headquarters of the UK distributor 
of Phottix studio lights, hotshoe 
flashguns and accessories, so we 
had an ample supply of kit at our 
disposal. We also had the ample 
talents of Phottix brand manager Tony 

Dudley available for technical and 
technique guidance.

The session began with tips for 
mastering exposure and how to make 
a neutral background appear white or 
black, before progressing to using a 
single backlight and a three-light 
set-up .“Tony was a fantastic teacher,” 
says Will. “We covered a lot of ground 
at pace! Learning the mantra of setting 
up background, fill and key lights (in 
that order) was a lot to take in, but 
I soon got to grips with the process.”

Kit Canon	EOS	70D	with	Sigma	50-100mm	f/1.8	DC	HSM	Art	lens	at	69mm			Exposure 1/250	sec	at	f/16,	ISO	100

Controlling studio lights

C
h

a
ll

en
g

e 
1 Create a 

punchy 
backlit 
portrait
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S h o o t o u t stUdio Lighting
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top  

kit



Will and Simon were thrown in at the deep 
end, having to work with two models, 
sometimes with both in the same shot. 
“I had some ideas in my head and a mood 
board of poses on my phone,” says Simon. 
“Looking back, I’ve learned not to rush and 
panic and to use the resources I’ve put in 
place.” Tony’s top tip was to ask the model 
which side they prefer to be photographed 
from, and to arrange the lights accordingly.

Directing a model

aLthouGh he’s been in a studio 
environment before, Simon has 
never had to think for himself in 
regards to setting up lighting, and 
this was one of the aspects he 
wanted to crack. “I had no idea what 
the challenges were before I arrived, so 
I was pretty apprehensive,” he admits. 
“I found the build-up really interesting: 
Tony did a great job explaining how to 
manage the power of the lights and 
how to balance artificial and ambient 
light using my camera settings.”
 Our models, Freddie and Tanya, 
were very experienced, and their ability 
to run through a sequence of poses 
with relatively little prompting certainly 
helped to put Simon and Will at ease. 
Working out the best lighting set-up 
was the initial focus. Here Simon used 
a large folding octagonal softbox to 
create the blown-out background, 
with a softbox and an octa softbox 
positioned to Tanya’s left and right.

Kit Canon	5D	Mark	III	with	Canon	EF	135mm	f/2	lens	
Exposure 1/200	sec	at	f/16,	ISO	200

s h o o t o u tstUdio Lighting

www.digitalcameraworld.com 
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WE switched to portable but 
powerful off-camera TTL flashguns 
for an outdoor session during the 
second part of the day. The 
challenge here was to overpower the 
ambient daylight and create images 
full of mood. “Using high-speed sync 
was a revelation,” says Will. 

High-speed sync (HSS) enables you to 
use much faster shutter speeds than 
normal with flash – so fast, in fact, that 
the daylight can be underexposed, to 
the point where it becomes a fill light 
to the flash’s key (main) light. “The way 
in which you can exclude extraneous 
background details and get the model 
to be the central element was really 
instructive,” adds Will. Using a single, 
bare flashgun, held by an assistant, 
meant that Will could work quickly and 
try a range of different backgrounds 
with next to no set-up time. 

Kit Canon	EOS	70D	with	Sigma	50-100mm	f/1.8	DC	HSM	Art	lens	at	55mm			Exposure 1/2,000	sec	at	f/2.8,	ISO	100

Re-create 
night in the 
middle of 
the dayC

h
a
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en

g
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The Phottix Mitros+ flashguns we were 
using have built-in wireless radio signal 
receivers that are compatible with the Odin 
transmitters from our studio session. 
Unlike infrared, radio signals don’t require 
line-of-sight triggering, so the flashgun can 
be positioned much more freely, including 
behind objects or cocooned in a softbox.

Working wirelessly to
p  

ki
t

S h o o t o u t stUdio Lighting



We’d like to express our 
thanks to Phottix (www.
phottix.com) for its help 
and hospitality – in 
particular Tony, who dealt 
with technical questions 
regarding the Odin wireless 
system with great patience!

Big thanks

SImoN worked a number of 
different single-light set-ups, 
making use of the courtyard’s 
numerous doorways and stairwells 
to add depth to his compositions. 
“Shooting outdoors was just as much 
fun, if not more so, than the studio 
element, with plenty of different 

backdrops and textures in close 
proximity,” he says. Simon kept things 
simple, sticking with a single, diffused 
flashgun, supported on a lighting 
stand, and a 135mm f/2 portrait lens. 
“This style of photography is what the 
majority of my personal work consists 
of, so I was really relaxed during this 
part of the day. As I do with most 
situations, I often look back and wish 
I did this and tried that, but ultimately 
I walked away from the day not only 
having learned something but also 
happy with what I produced.”

Kit Canon	5D	Mark	III	with	Canon	EF	135mm	f/2L	USM	lens			Exposure 1/60	sec	at	f/6.3,	ISO	100

Simon

neXt
Month

two readers take 
on our dartmoor 

challenge
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P h oto  Act i v e

Reverse-mounting his lenses enables Imran 
Ahmad to capture fish close-ups on an epic scale 

Portfolio
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Name:  Imran Ahmad Bin Rayat Ahmad 

LocatioN:  Singapore

Subject:  Underwater wildlife

equipmeNt:   Nikon D4 in Seacam housing with RGBlue  
System 02 lights and a wide range of lenses 

WebSite:  www.escapeinc.com.sg

IN a world awash 
with awe-inspiring 
images of life 
in the ocean, 
underwater 

photographers have to be able 
to serve up more than just 
pretty pictures of curious fishes 
in order to make an impact. The 
work of Imran Ahmad is a case 
in point. A dive operator, lecturer 
and Nikon Professional 
Photographer, Singapore-based 
Imran has earned a reputation as 
someone who’s always looking for 
a fresh approach.

“I’m pretty experimental when 
it comes to photography,” he 
says. “I enjoy exploring older 
techniques alongside new 
technologies, and I believe I’m the 
first photographer in the world to 
successfully use the reverse-ring 
macro technique in the sea and to 
explore the potential for HDR 
photography underwater. 
 “I’m also a firm believer in 
working with lights in creative 
ways rather than just treating 
them as a way to illuminate a 
subject in the depths. Light 
gives character to a shot, and in 
underwater photography that is 
something to embrace. After all, 
a fish is just a fish until you add 
your imagination and creativity.”
 Imran’s intriguing, vibrant 
images are sure to inspire a new 

generation of underwater 
photographers, as the work of 
David Doubilet and Kurt Amsler 
did for him. But how much diving 
experience does he think 
someone needs before they can 
start taking the photography side 
of things seriously? 

“Shooting underwater is much 
easier now than it used to be, 
thanks to the wide availability and 
cheaper price of equipment. But 
it is important to first learn the 
proper way to scuba dive; not only 
will this help you to get images 
but also help you protect the 
environment with good buoyancy 
control. A safe measure is to have 
a minimum of 50 dives under 
your belt before you go in with 
an underwater camera.“
 As you’d expect, raising 
awareness of the vulnerability of 
the ocean environment is just as 
important to Imran as revealing 
its beauty. “I’ve been blessed to 
have dived in some of the best 
destinations in the world, from 
sunny Indonesia and spicy 
Thailand to the exotic Seychelles 
and colourful Philippines. Sadly,  
I have watched the deterioration 
of beautiful reef wonderlands 
through irresponsible tourism 
and bad scuba practice. It’s so 
important to educate our younger 
generation to the importance of 
our reefs and their inhabitants.”

Kit Nikon D4 with 50mm f/1.8 lens  
reverse-mounted on a 105mm f/2.8 lens 
Exposure 1/250 sec at f/4, ISO 200   
Attaching a reversed 50mm lens to a 105mm lens 
gives extreme magnification and a funky bokeh effect. 

Kit Nikon D200 with 60mm f/2.8 lens 
Exposure 1/100 sec at f/7.1, ISO 100   
Colourful fins captured with a standard macro lens  
in the waters of Indonesia’s Raja Ampat archipelago.

Kit Nikon D4 with 105mm f/2.8/50mm f/1.8 RRM 
Exposure 1/125 sec at f/13, ISO 200   
Focusing accurately is difficult when you’re using the 
RRM technique, as the depth of field is wafer-thin.

Kit Nikon D4 with 13mm f/2.8 Nikonos RS lens 
Exposure 1/160 sec at f/11, ISO 200   
A Seychelles seascape takes on an extra-terrestrial 
appearance after being mirrored in Photoshop CS6. 



NeXt
moNtH
The cinematic 

family portraits 
of Fang Tong 

Kit Nikon D4 with 16mm f/2.8 
fisheye lens
Exposure 1/15 sec at f/16, ISO 200  
This split-screen shot was achieved 
with video lights rather than 
strobes. Not having to wait for 
strobes to recharge makes for a 
faster continuous shooting speed. 
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I want to shoot cities at 
night. Can you give me 

some tips for this, please?
Tom Wood

Most of the basic steps you’d 
follow during the day are all 
applicable, so you need to 

think carefully about composition 
and choose an aperture of f/11 or f/16 
to ensure you have plenty of depth 
of field. But there are some critical 
differences too. A building at night can 
change as the lights come on, so it’s always 

worth watching how its lights respond to 
the surroundings as it becomes dark.

The key element is timing. You want 
to shoot at the point the lights of the 
building are completely on but there is still 
some light in the sky – so you have some 
interesting colour there too, such as deep 
blue rather than just black. This will ensure 
maximum impact of the buildings against 
the backdrop. On drab, cloudy nights this 
isn’t really possible so I always try to shoot 
on clear nights or when there are broken 
clouds. You will need to use a tripod too, as 
your exposures are going to run into 
several seconds.

White balance choice is always difficult 
because the lights within your scene will 
vary in temperature. For this reason 

I always shoot raw, leave my white balance 
as Daylight, and adjust later, both globally 
across the whole image and sometimes in 
selected areas too.

As you can see on my example image 
taken in Zaragoza, Spain, the lights along 
the bridge in the foreground are quite 
warm in colour, while those on the far bank 
of the river are a much cleaner white. The 
raw image, shot at a temperature of 5,500K 
(Daylight), is overall much warmer in tone, 
but I manually adjusted it to 4,000K to give 
the whole scene a better balance. 

The closest I would have got to this 
would have been to shoot it with the white 
balance set to Fluorescent WB (4,000K), 
so if I was shooting a JPEG, this is certainly 
what I’d have used.

City lights

Photo
answers

ANDREW JAMEs 

Our expert photo 
advisor is here to help

Befuddled By Burst rates? Gone loco over a lens?

Send your question to digitalcamera@futurenet.com and let us provide you with a solution

Your tricky photography questions answered!

shoot while there’s still 
colour in the sky for the 
most effective results.
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What are they?
Handy widgets that attach to your external 
flashgun to help you shoot portraits 
or other flash-lit subjects with more 
interesting light effects. They redirect, 
soften and generally control the amount 
of  light reaching your subject.

How are they attached to the flashgun?
There are lots of varieties available, and the 
way they attach to the gun itself changes 
from model to model. Typically you can fix 
them to the flashgun with an adjustable 
strap or piece of elastic, then shoot away. 

Will they work on all external flashguns?
It’s best to check with the manufacturer or 
retailer that your flashgun is OK with their 
model but, as a general rule of thumb, most 
modifiers are designed to be universal.

Is there a huge benefit to using one?
If you are an occasional flashgun user, they 
are probably not for you; but if you shoot 
portraits regularly using flash, a modifier 
can be a relatively simple and portable way 
to increase the versatility of your flashgun.

What sort of lighting can they achieve?
You can buy modifiers that will create a 
ringflash-style light that is typified by 
almost shadowless lighting and a telltale 
circular catchlight in the eyes. Others will 
help you bounce the light for a more even 
spread or even control the amount of light 
to a narrow beam so that you can really 
target where the flashlight illuminates your 
subject. Basic diffusers will just reduce the 
harshness of direct flashlight.

How much do they cost?
You can buy a very basic flash diffuser for 
£10 or less, but for a specialist modifier 
or a kit that will give you several different 
options with your lighting, you should 
expect to pay between £99 and £159.

are there any downsides to using them?
Some models can be a bit fiddly to use and 
put on, but practice makes perfect. They 
will also naturally reduce the amount of 
light hitting your subject, so you need to 
account for this with your exposure if you’re 
used to setting your flashgun without 
a diffuser or modifier.

Flashgun modifiers  
and diffusers
Adjust the light produced by your flashgun

See the  
focus

I can’t find a way in 
Lightroom to see the 

AF point that was selected 
when the picture was 
taken. Is there a way to do 
this I’m missing?
Davy Renwick

LightRooM doesn’t have this 
facility, but that doesn’t mean all 
is lost. You could use the free raw 

conversion software that came with your 
camera and work outside of Lightroom, 
but if you want to add the option to 
Lightroom, you’ll need a plug-in.

Show Focus Points (www.lightroom 
focuspointsplugin.com) works well but is 
restricted to Canon and Nikon cameras, 
and you need Lightroom 5, 6 or CC to use 
it. You can download it for either Windows 
or Mac OS X; after installation it can be 
opened via Library > Plug-in Extras, but 
you have to be in the Library module to see 
this menu. The plug-in will show you the AF 
point or group of points you used and 
identify which one was used to lock focus.

A black-and-white square shows the 
inactive focus points; red outer and white 
inner square is for the AF point or points 
originally selected but not locked on; black 
outer and red inner shows the AF point 
that was originally selected and locked 
on; and white outer and red inner 
will reveal a locked on AF point 
that wasn’t originally selected. 

In my shot of the panned 
racing car, you can see I selected 
the middle group of AF points. 
That’s the one at the very centre 
of the AF grid and four surrounding 
it in a cross configuration. As I’d generally 
expect, it was the central AF point (black 
outer and red inner) that locked the focus.

ASK US A 
qUeStion
digitalcamera@ 
futurenet.com 

(subject line: 
Photo Answers)

 laYman’s  

gUiDe

Flash modifiers and 
diffusers enable you to 

control how the light 
leaves your flashgun.
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An experienced 
photographer has told 

me to shoot f/8 if I’m in any 
doubt over the correct 
aperture. Is he right?
Sally Hall

thE phrase “f/8 and be 
there” is something that has 
been passed down over the 

years. Like all such sayings, there is a 
basis of truth to it. If you select f/8, you’ll 
get good of sharpness throughout the 
shot so, if your focusing isn’t 100% 
accurate, then this aperture will help 
a bit. Also, if your lens has a maximum 
aperture of f/4, then f/8 may well prove 
to be its sweet spot: the point where it 
will achieve the best resolution and 
therefore the sharpest image. Ultimately, 
f/8 is the middle ground of apertures, so 
it won’t let you down in many situations.

However, it would be wrong to adopt 
the f/8 approach all the time. When you 
shoot digitally and have the benefit of 
instant review of your image, it makes 
sense to try different apertures and look 
at the effect your choices have on the 
finished images. For example, shooting 
f/8 in lots of situations will bring the 
background more into focus and 
therefore distract from the subject itself. 
Of course, this will vary with the focal 
length you are using and the distance 
between subject and background.

To sum up, Sally, f/8 is an aperture 
that you will find is great for lots of 
situations – but it is by no means the only 
aperture you should ever use.

A camera club judge 
said my landscape 

images lack mood. How 
can I improve this element?
Shirley Trimble

i cAN’t say exactly what this 
judge was missing in your 
images, shirley, but mood can be 

conveyed in a number of ways. When it 
comes to landscapes or wildlife, you need 
to be shooting in the sort of conditions and 
light that will naturally give the viewer 
some sense of drama – whether that is an 
energetic drama or a sombre mood. You 
can use filters to help you capture this feel 
but timing is always crucial. If you shoot in 

the middle of a dull day, your image will 
probably look dull; but if you shoot early 
or late, or when there are some kind of 
atmospheric conditions (such as storm 
clouds), then mood will happen naturally.

You could also think about how colour 
affects the human brain and use this to 
inject some sense of emotion into your 
photographs. At its crudest, an image with 
strong reds can invoke a sense of energy 
and vibrancy, but go for something pink 
and we immediately associate this with 
romanticism. Blue, however, is cooler and 
generally more associated with tranquillity. 

This shot of a single elephant has plenty 
of mood. The blue tones of that big sky 
suggest peacefulness and that’s enhanced 
by the fact there is just a single, isolated 
animal on the horizon line. Even the 
decision to keep the elephant small in 
compared to its surroundings helps to 
hammer home a sense of isolation.

Drama queen
f/8 and  
be there

Should I update my 
camera’s firmware?

Fred Hutton

if there is a 
more recent 
firmware 

release available for 
your camera on the 
manufacturer’s website, 
then yes, you really should 
update it. This is simply 
because manufacturers often 
bring out new and improved 

Up to date
QUICK Q&A

firmware to sort out small bugs or  
they just make improvements to the 
operating system.

First of all, you need to find the 
firmware version you are currently 

using by going into your camera’s 
menu, then go to the 

manufacturer’s website to 
see whether there is a more 

recent version available. 
The next step is to 

download the file, copy it 
to a formatted memory 

card using a card reader, 
place the card in the 
camera and simply 

follow the instructions. 

think about colour and 
composition to heighten the 
mood you want to convey.
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Create a Collection
In the Library Module, go to the 

left-hand side of the interface and 
scroll to the bottom to find the pane 
marked ‘Collections’. Click on the + 
symbol and you’ll be given a number of 
options to choose from in a drop-down 
list. You need to select the option at the 
top – Create Collection – and then 
click on it. 

name your selection
A grey dialog box will open. In 

the Name box, type the name you wish 
to give your selection. I’m creating a 
Collection for a travel photography 
talk, so that’s the name I will give it. 
I could place this Collection within a 
Collection Set, but as I don’t want to 
here, I’m not going to tick anything else 
in the box, so just click Create.

Find your images
Go in and out of your normal 

folders and look for images, selecting 
any that you want in the Collection. 
With the images selected, drag and 
drop them into the Collection. When 
you hold them over the Collection its 
name will turn blue. Each image is put 
inside as a virtual copy: the original file 
remains in its appropriate folder.

Create a Collection  
in lightroom
Bring all of your favourite images together so that 
they’re easier to edit as a group or to find later on

1

2

3

My new lens came 
with a hood. 

Should I be using it?
Dawn Whittaker

thE hood 
is there to 
prevent 

stray light from 
hitting the front 
element of the 
lens. This controls unwanted flare 
and ensures colours are more 
saturated. I know hoods can be a 
pain to attach quickly and can be 
knocked off at the wrong moment if 
not fixed properly: I once had one 
fall onto the ground about 20 feet 
from a wild tiger. But they will 
improve the quality of your images.

They’re also some very useful 
protection when you’re walking 
though undergrowth: once one of 
mine prevented extensive damage 
when it acted as a buffer on a 
dropped lens.

In the hood

QUICK Q&A

 h
ow

 to

Card-less
I know it’s 
stupid, but I 

recently shot for 
half a day without 
a memory card in 
the camera. How 
can I stop this 
happening again?
John Ryedale

Most modern cameras have 
a menu setting that allows 
you to lock the shutter 

when there is no memory card 
inserted. This is a simple 
fail-safe everyone should use 
because it is far too easy to start 
snapping and totally forget that 
you haven’t loaded a card. When 
you’ve enabled this function, you 
won’t be able to focus or use the shutter 
button and the display will say ‘card’ to 
remind you what your error is. Set this, 
John, and it’ll never happen again!

ASK US A 
qUeStion
digitalcamera@ 
futurenet.com 

(subject line: 
Photo Answers)
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Get 
RAteD!

Email your shot to 
digitalcamera@
futurenet.com 

(subject line: Rate  
My Photo)

Accurate focus ensures  
it’s pin-sharp in the eye

Great use of colours  
that contrast well 

Visible wire mesh in the 
background is best avoided

The bird’s hunched pose 
looks uncomfortable

NICELY DONE

ROOM FOR IMPROVEMENT

PAUL sAYs: this is a king 
vulture, and the shot was 
taken at south lakes 
Zoological Park in 

cumbria. There was something about 
the vulture’s rather ugly but colourful 
head that attracted me to it, and 
I knew it would make for an unusual 
shot. It was taken hand-held on 
my Canon EOS 7D Mk II with a 
100-400mm lens at approximately 
150mm. The exposure was 1/1,000 
sec at f/5.6 and ISO 500.

ANDREW sAYs: I feel 
sorry for the poor 
vulture. He wasn’t first in 
line for looks – and yet, as 

you’ve ably demonstrated in this shot, 
Paul, he has a charm all of his own.

There are a number of things to be 
commended here. Focus is nicely on 
that eye so it is tack-sharp; the head 
of the bird is leaning into the negative 
space; and the wonderful deep red of 
the neck really contrasts well with the 
blue sky behind it.

My issue with the shot is the wire 
mesh lines that are showing in the 
background. You’ve shot relatively 

PaUl 
Barrow 

The sharpness is 
spot-on, but a wider 

aperture might 
have helped with 

the background

rat
e

mY 
Photo

wide at f/5.6 but in an ideal world 
a wider aperture might have helped 
render this more out of focus so that 
it wasn’t as obvious. 

The second option would have 
been to zoom in a lot further so your 
framing was much tighter to the 
head and lose most, if not all, of that 
background. After all, you had another 
250mm to play with on your zoom 
range; that could have created an 
almost abstract shot.





The top three entries in our recent ‘dusk to dawn’ contest – and details of this month’s 
challenge, where the emphasis is once again on balancing light and shade…

Assignment

P h o t o  a c t i v ep h o t o  A c t i v e

Don’t miss out! To be in with a chance of winning a Lowepro backpack, 
enter this month’s assignment – full details over the page…
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EvEry issuE, we challenge you to 
take a creative and arresting shot 
around a theme, and share it at the 
online community at Photocrowd 
(www.photocrowd.com). Here, 
you’ll be able to browse the entries 
and vote for your favourites. The 
best entries receive a critique from 
our judge – and one winner receives 
a special prize, courtesy of Lowepro!

Your mission in issue 177 was to 
create cracking pictures at sunset 
and sunrise – and during all the dark 
hours in-between. Hundreds of 
night-time images were submitted 
and, as you might imagine, the Milky 
Way made an appearance in more 
than one shot – including the 
stunning overall winner from 
Marek Kosiba, pictured above. 

1
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1

2

3

Winner & croWD vote Winner
mArek kosibA          When you want to reveal the 
stupendous scale of the night sky, sometimes a single frame just 
isn’t enough. Here, 22 shots have been expertly combined to make 
a 360-degree panorama that really does make you feel small.
Kit Nikon D7100 with Sigma 18-35mm f/1.8 lens at 18mm 
Exposures 30 sec at f/1.8, ISO 3,200
                                       Chosen by the community at Photocrowd

grAeme          Shooting at night heightens the technical 
challenges of photography. How do you compose, focus and expose 
in the dark, especially when you’re on the slippery floor of a rainforest 
trying to record bioluminescence on a micro scale? Hats  
off to the photographer here…
Kit Canon EOS 7D with 100mm f/2.8 macro lens 
Exposure 30 sec at f/5.6, ISO 1,600

scott sim          The contrast 
between the warm glow of Tokyo Tower 
and the cool urban sprawl works superbly. 
You really get a sense of scale: the tower 
dominates the skyline, and the choice of 
viewpoint here, along with the compression 
effect of the long lens, gets this across.
No shooting data available

2

Crow
d 

vote

TURN 
OVER!

 We want to see how 
creative you can be 

when it comes to 
shooting shadows 

and silhouettes

croWD vote

3
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composition and exposure are key 
when it comes to our latest challenge. 
For instance, you’ll need a keen eye for detail 
when it comes to framing a silhouette, as it’s 
all too easy for shapes to merge and become 
indistinct. Look for clean compositions 
where objects aren’t overlapping one 
another: you’ll often find that getting low 
and shooting against the sky helps.
 As with silhouettes, shadows require 
some exposure know-how to get right. Train 
your lens on a dark area and the camera may 
try to brighten things up in order to reveal 

hidden detail. But underexposing 
these types of shot and allowing 

shadows to become ‘crushed’ 
and black can produce 
bolder results.
 

How to enter
Visit www.photocrowd.

com/a/current and look 
for the Digital Camera 

Shadows & Silhouettes 
contest. (It’s free to join.) Click 

Submit An Image to upload your 
entry. The closing date is Friday 15th July. 
The creator of the best photo in the judges’ 
opinion will receive a brand-new Lowepro 
Photo Hatchback BP 250 AW II bag. The 
Crowd Vote winner also receives a special 
prize. A selection of 
winning images will 
appear in issue 181.

This month, we want 
you to join the dark side 
and show us how you 
can capture striking 
images of silhouettes 
and shadows…

AgAinst 
the 
light

ENTER 
TODAY!
www.photocrowd.
com/a/current 
Closing date:  
Friday 15th July

win a Lowepro photo hatChbaCk bp 250 aw ii

We’re giving away this 
versatile Lowepro daypack 
worth £99 to the winner of our 
new assignment.

The Photo Hatchback BP 
250 AW II is a 22-litre pack that 
can swallow an SLR with an 
attached lens, plus two 
additional lenses and 
accessories in its camera 
compartment. Remove this, 
and the pack converts to  
a full daypack.

The hatchback design 
gives peace of mind, as your 

camera gear can’t be 
accessed while you’re wearing 
the pack, while the CradleFit™ 
tablet pocket and built-in All 
Weather AW Cover™ provide 

additional protection. 
www.lowepro.com

new aSSiGnMent



Get a digital 
issue for FREE!

 

take out our risk-free trial  
and pay nothing for 30 days

  Pay less per issue
   Download the latest 
issue instantly
  Choose to download 
issues automatically
  Fully interactive video 
tutorials and guides

GET  
IT now! 

Download the Digital 
Camera App on your 

Apple or Android 
device and start  

your trial  
today!
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Devon and Matt, Beverly Hills 
Jerry says: “This was photographed 
during a night shoot in front of the 
Bulgari store on Rodeo Drive, using 
the Ice Light.”



>
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One of the best wedding photographers in the world, 
Jerry Ghionis has a glamorous but natural style. 

He shares the secrets of his success with Geoff Harris

JerrY
Ghionis

i n t e r v i e w

ow did you get into 
wedding photography?
My brother Nick got into 
photography, and gave 
me my first camera 
when I was 15. I got 

obsessed quickly and soon tired out 
my family and friends. I then did 
a four-year photography course, 
but I quit after a year, as I felt it was 
teaching me stuff I’d never use.

After working at a few camera 
stores, I approached a studio in the 
Italian district in Melbourne, which 
specialised in weddings. I assisted 
and held the bags for a while, then 
I was taken on as a photographer. 
I shot my first wedding aged 20, and 
started my own business in 1997.

So what is the attraction 
of weddings for you?
I have always been a people person,  
I love having a laugh, and I love 
beauty. I thought that as a wedding 
photographer, I would always have 
a job! At 15 I wanted to be the biggest 

H
singer in the world or the biggest 
photographer, and I chose 
photography in the end.

Wedding photography is the best 
testing ground for any photographer. 
There are so many genres that you 
deal with on the day, under time and 
weather constraints, surrounded by 
different personalities and cultures. 
Not much in photography intimidates 
me now after doing weddings.

What was your first big wedding?
I did a lot of ‘bread and butter’ 
weddings... Greek, Italian, Anglo-
Saxon Australian, Asian. But the first 
big one that stands out in my mind 
was a Jewish wedding. I thought we 
Greeks party hard, but I was blown 
away by the chair-dancing and the 
bride jumping over big skipping 
ropes. They even had a satellite 
hook-up to the relatives in Israel.

My first high-society wedding was 
a five-day event in Rome. Every day 
had a different event. I ended up 
going out to Spain for the hen days A
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JERRY GHIONIS

Wedding 
photographer  
and tutor

Born in 1973, Jerry 
Ghionis was named 
one the top five best 
wedding photographers 
in the world by the 
WPPI (Wedding & 
Portrait Photographers 
International). Jerry 
and his wife Melissa 
are based in Melbourne, 
Australia, and Beverly 
Hills, USA, and serve 
international markets. 

Jerry was also named 
in the first list of 
Top Ten Wedding 
Photographers in the 
world by American 
Photo Magazine and is a 
Nikon USA Ambassador. 
In 2014 he received 
a Photography 
Leadership Award 
from the United 
Nations International 
Photography 
Community.

Jerry created the Ice 
Society, a photography 
training website; 
designed the Ice Light, 
an innovative LED 
continuous light 
cylinder; and 
developed the Omega 
Reflector, the world’s 
first 10-in-1 shoot-
through reflector. 

before the actual ceremony. Coming 
from Australia, it was my first 
experience of old money and that 
European or American grandeur. 

Were there any big disasters 
in the early days?
An assistant once loaded a roll of 
previously exposed film into the 
Mamiya I was using at the time, 
so everything got double-exposed. 
Somehow we managed to sort it out, 
and the couple was happy.

Messing up at a wedding is the 
worst feeling in the world. In the film 
days you never knew whether shots 
would be OK until the film came 
back. Being able to check images 
on digital cameras is amazing.

How would you describe the 
Ghionis style... and how has it 
developed over the years?
People describe it as glamorous but 
natural. I combine the beauty of the 

pose with the ‘natural nature’ of 
something candid. When I have 
control over the subject – at the 
couple’s homes or at a location shoot, 
for example – I try to make images 
that look effortless and natural. 
The right place, right light, right 
expression. My main objective is to 
make people look and feel beautiful. 
Their wedding day is arguably the 
most beautiful they have looked and 
felt in their life. So it’s about bringing 
out their beauty, not mine. 

Also, my photography has become 
more sophisticated. I’m very happy in 
my personal life, and I can see more 
passion and sentiment and emotion 
in my images. It’s a reflection of 
where I am in this point of my life. 
When you get to 43, you know who 
you are and make no excuses for it.

You also teach a lot. What kind  
of problems – creative and 
business-related – do students 
struggle with? 
You will stunt your growth if you 
don’t start the right way. You can 
assist or become a second shooter, 
but you don’t learn a thing. Your 
growth will also get stunted if you try 
to do everything yourself, such as 
book-keeping or editing, or waste 
time on social media.

Rather than spending four 
hours a day promoting yourself on 
Facebook or waiting for an email 
enquiry, be proactive. Go out to 
venues and promote yourself. You 
can stand out from rivals by going on 
the road and getting people to see 
your enthusiasm and passion. 

Above      Red phone box 
“I love voyeuristic images and 
perhaps a unique perspective of 
a clichéd subject matter.”

Above right      Groom with tie
“This photo was inspired by 
Johnny Depp’s character in 
the movie Cry Baby.”

Opposite page       
Bride on ground
“This image [of Melissa Ghionis] 
was created on our wedding day. 
It was inspired by the infamous 
movie poster for Blow Up that 
was popularised in the 1960s 
(and arguably the only time 
I could ask a bride to hold my 
legs on a wedding day!).”

JerrY Ghionis

>





I n t e r v I e w
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And technique?
Technique can be taught, but 
being a good person or having 
charisma can be much harder to 
teach. I’d say the biggest problem 
creatively is a lack of confidence. 
Also people shoot too quickly. 
Know your gear and slow down.
 
Why did you develop the Ice 
Light, a hand-held constant 
LED light source?
Since the start of my career I’ve 
used video lights. They were OK, 
but I thought there should be a 
beautiful, daylight-balanced 
light, like window light, which 
I love. As LED lights got more 
popular a few years ago, I thought 
why not do a bigger portable 
light? Being a fan of Star Wars, 
I decided to try a cylindrical light 
source, like a light sabre. It’s so 
flexible. If you hold the Ice Light 
vertically, it’s a bit more 

contrasty; hold it horizontally 
and it’s going to be softer. So the 
Ice Light gives you two qualities 
or densities of light. 

I went to Westcott, who I 
thought were the leaders in 
continuous lighting, and we went 
from there. It’s really taken off. I 
recently saw David Attenborough 
holding an Ice Light in a BBC 
documentary to light his path, 
which really freaked me out! 

Do you think you will ever give 
wedding photography a rest 
to focus on your business 
interests, charity work and 
product development?
No, I love photography. It’s in my 
blood and I will do it until I die.  
I don’t actively promote my 
wedding work now, but I get the 
bookings I want. My body might 
tell me to slow down with the 
weddings, though, as it’s >

JerrY Ghionis

Above      Bride in car
“With this image, I was 
struggling to eliminate 
all of the creases in the 
veil over the bride’s 
face. I eventually 
decided to use one 
crease to emulate a 
single tear drop falling 
on the bride’s face.”

Above      Couple at reception
“DJ lights can be somewhat distracting, but in 
this case they formed a beautiful backlight.”
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Right      Bride on 
staircase
“This was created at 
the historic La Bassa 
mansion in Melbourne.  
The bride is still the 
point of interest even 
though she is dwarfed 
by the environment.  
All the leading lines 
lead to her and she is 
the brightest part of 
the image.”

QUICKFIRE Q&A

What do you miss 
most about Oz when 
you are in LA?
Having a competition 
of  wits with my family 
at my brother’s Greek 
restaurant.

And about LA when in 
Oz?
In-n-Out Burger.

What is your all time 
favourite wedding 
venue or location?
Italy.

If you could only take 
one lens to a wedding, 
what would it be?
The Nikkor 24-120mm 
f/4 zoom.



I n t e r v I e w

physically demanding. I am leaving 
time for personal projects, which is 
important, as they invigorate you. 

What do you think are the next big 
trends in wedding photography? 
We’ve seen this hipster style for 
a while – static, almost meaningless 
images, where couples stare deadpan 
at the camera. At the opposite end, 
there is creativity for the sake of it. 
Weird perspectives and styles that 
mean nothing.

I like to be creative, but it needs 
to communicate something. Good 
photography is either flattering or it 
helps communicate the message you 
have for the viewer. I maintain a quite 
classic style, and avoid just being 
creative and showy for the sake of it. 

Wedding photography as a viable 
business is under threat from the 
rise of smartphones and couples 
asking friends or relatives to take 
the shots. Do you feel optimistic 
about the future?
There’s certainly a threat from 
smartphones or guests with SLRs 
who’ll take the shots for free. I would 
like to be optimistic, but it will only 

get worse. We have a generation of 
new customers who were brought up 
with ‘good enough’ phone and tablet 
photography. Ignorance is bliss. 
People don’t know the charm of a 
beautiful wedding album, they just 
swipe a finger.

I think there will be a renaissance 
at some point. I hope in 10 years or so 
that people will appreciate the 
photographer’s craft again, and the 
luxury of holding albums. As I get 
older, I appreciate more the touchy-
feeliness of albums of memories.
www.jerryghionis.com

Above      Star Wars
“I was invited to 
second-shoot a 
Star Wars-themed 
wedding.  Here is the 
Force in limbo...”
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JerrY Ghionis

JERRY’S kit Bag
Jerry says: “I’m a Nikon 
USA Ambassador and 
my main workhorse is 
the D4S. I also use the 
D810 and D750 and 
have a D5 waiting for 
me in the States. My 
favourite lenses are the 
Nikkor 70-200 f/2.8 VR, 
then the macro 105mm 
and the 85 f/1.4 – plus 
the underrated 
24-120mm f/4.

“At weddings you 
need to be able to go 
close and zoom out 
quickly, shooting at 
wider angles and 
keeping some depth of 
field. So f/4 is better  
for me than f/2.8. 
Where I used to lose 
moments, now I can 
catch them with this 
lens. At f/4 I am happy.”

NEXT
MONTH

King of the  
north: ragnar  

Axelsson 

Bride and groom, Las Vegas
“This deliciously kitsch Las Vegas 
wedding image of photographer 
Sandy Puc was created to look 
like it was taken in the 1970s.”



#SMARTERMOVIEMAG

“Which renowned 
photographer did Nicole 

Kidman play in the 
movie Fur?”
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R obert Mapplethorpe’s work 
has inspired everything 
from reverence to outrage. 

He’s best known for his distinctive, 
masterly studies of flowers, which have 
been widely praised, as have his celebrity 
portraits of people including Debbie 
Harry, Andy Warhol and his close friend 
Patti Smith. However, his erotic and even 
pornographic images of gay fetishes have 
caused controversy, particularly when 
exhibited in the USA.

How did he get into photography?
Mapplethorpe was born in Queens, New 
York, in 1946. In 1963 he began studying 
drawing, painting and sculpture at 
college in Brooklyn. His work included 
collages made up of other photographers’ 
work, but he started to shoot his own 
images in 1970. He used a Polaroid 
camera but in 1975 he began using a 
Hasselblad. He started shooting portraits 
of friends and honed his technique while 
developing the range of subjects for which 
he’s famous, which also included classical 
nudes, self-portraits and statuary.

What was his style?
Most of his work was shot in the studio 
and precisely lit; he sometimes took 
hours just setting up lights. Whatever he 
photographed, Mapplethorpe did it with 
the same cool detachment. “I don’t think 
[my flower photographs] are very 
different from body parts,” he said.

“Maybe I experiment a little more  
with flowers and inanimate objects 
because you don’t have to worry about  
the subject being sensitive... However,  
I don’t think I see differently just because 
the subject changes.”
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What was so special about his 
flower photographs?
Shot either with natural or artificial light, 
they’re sensual, carefully composed and 
make a small and delicate subject look 
powerful. They are also often erotically 
charged: Mapplethorpe playfully made 
parallels between these images and his 
pictures of human sexual organs. 

Which exhibition caused the  
biggest controversy?
In 1989, the Corcoran Gallery of Art in 
Washington, DC, planned to show his 
exhibition The Perfect Moment. However, 
the graphic nature of some of the images 
and their sado-masochistic themes led to 
an outcry from conservative and religious 
organisations. The exhibition was 
cancelled, although it was subsequently 
shown at other galleries.

What was his legacy?
In 1988, a year before his death from an 
Aids-related illness, he set up the Robert 
Mapplethorpe Foundation, a non-profit 

organisation that represents his work and 
artistic vision. The Foundation has 
funded numerous photographic books 
and exhibitions, and raised millions of 
dollars to support medical research into 
Aids and HIV.

Why is Mapplethorpe  
in the news now?
2016 is the 70th 
anniversary of his birth.  
To mark it, a documentary 
film about his life, 
Mapplethorpe: Look at the 
Pictures, was released earlier 
this year, and a number of 
exhibitions are planned.

Where can I see his work?
His website www.mapplethorpe.org 
includes pictures and information. Fans 
of his flower work will enjoy a new 
collection of his work, Mapplethorpe 
Flora: The Complete Flowers, published 
by Phaidon, £125. See www.phaidon.
com/mapplethorpeflora
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NEXT
MONTH

The urban 
fashion work of 

Terence Donovan

RobeRT 
MappleThoRpe

An American photographer known 
for his sensitive yet blunt treatment  

of controversial subject matter 
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#SMARTERMOVIEMAG

Take the smart  
movie quiz...
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released. I found myself using it more 
and more on vacation rather than 
carrying my own camera.

I think the switch really started with 
the iPhone 3G in Egypt a few years ago.  
I felt it produced a different kind of 
image. Also, it had me playing again, 
giving myself the freedom of not being 
a serious photographer all the time. 
When you’re out with your traditional 
camera, you get caught up in processes, 
but this freed me from that.

Over time I started shooting more 
of my personal projects with the iPhone, 
such as wildlife in Africa, and people 
started asking me about these images 
because they looked so different.

I didn’t make the leap to incorporating 
it into my professional work until one day 
after a wedding the light wasn’t right at 
all, so I suggested that the couple do a few 
Instagram-style shots on the iPhone. 
They loved them, and they looked great, 
and what really impressed them was that 
I post-processed the images for them on 
the drive to the airport and shared them 
so they already had some wedding 
images to show their friends.

So I started using it here and there 
a bit more, and eventually I got the idea 
to try and shoot a whole wedding.

Did the couple take convincing?
They were very open to it! I had this 
opportunity in November 2015 to shoot 
a big wedding in India, and because of 
this I had a big team with me. My second 
photographer was an established 
wedding photographer himself.

So I spoke with the couple, who have 
been following my work for three years.  
I said, “This will sound strange, but 
I want to shoot your wedding only on the 
iPhone. I have a good team behind me 
and we’ll get all the other traditional 
shots, and I’ll be directing them, but 

fter more than 10 years 
working as a commercial 
photographer in Tel Aviv, 

Sephi Bergerson closed his studio 
in 2002 and moved to India with 
his family to follow his dream to be 
a documentary photographer. Since 
then, Sephi’s work has been featured in 
books and publications worldwide. 

Increasingly Sephi has been using his 
iPhone 6S Plus as the primary camera in 
his personal projects. He’s currently 
working on a book about Africa, shot 
entirely on the iPhone – and recently he 
used his iPhone professionally for the 
first time to shoot a grand three-day 
wedding in India…

What was it about the iPhone that 
appealed to you to make it your 
primary camera for this project?
I’ve been shooting on the iPhone for quite 
some time, ever since the first iPhone was 

A

>

Sephi Bergerson is using a smartphone for more 
of his commercial work, a move he describes 
as “giving myself the freedom of not being 
a serious photographer all the time”.

This page      The wedding between 
Ayushi and Abhishek took place in 
Udaipur over three days in November 
2015. The wedding photo agency Silk 
Photos, of which Sephi is a member, 
was responsible for photographing and 
filming the celebrations. 

WORK 
EXPERIENCE
Would you shoot one of the biggest weddings of your 
career exclusively on an iPhone? Sephi Bergerson 
recently did just that, and tells Jeff Meyer his story…
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I’d also like to try this.” And they trusted 
me. I think they saw that it could be 
something really unique.

For me, I knew that my team was there 
and that the traditional coverage would 
be very good, so that made it easier. And 
it was a fantastic spectacle. For the event 
I got the iPhone 6S Plus, which has 
a really superior camera. It’s now or 
never, I thought. I was really relaxed.

What advantages did your iPhone 
give you that you didn’t have with 
a traditional camera?
I’d have to say that the real advantage was 
in the editing. The post-production is so 
simple to do on the phone. I loved the fact 
that if I shot a really nice image, I could 
show it and share it with the guests 
instantly. That also enabled me to give 
the couple instant reassurance of what 
I was doing. By the second day they were 
feeling like they were getting something 
that had never been done before.

The other advantage I noticed with 
the iPhone’s simplicity is how much 
closer it brings you to your subject. I’ve 
been a photographer almost 30 years. 
I used to be a commercial photographer 
shooting large-format and medium-
format. I would hold those cameras at 
waist level and look down at them – 
a very solitary process. Even using a 
D-SLR, you put the eye piece to your 
eye and block contact with the subject.

With the iPhone you have this big 
screen and you don’t block contact with 
the subject at all. You feel like you’re still 
there, in the scene. This enables a 
different kind of interaction and 
conversation with people you don’t 
normally get when you’re holding 
a traditional camera. 

Weddings are often low-lit affairs 
with lots of movement. How did you 
get fast enough shutter speeds?
Well, because it’s a very different type of 
camera, some images weren’t achievable 
– but I wasn’t trying to get those types of 

“�If�I�shot�a�really�nice�
image,�I�could�show�it�
and�share�it�instantly.�
That�also�enabled�me�
to�give�the couple�
instant�reassurance”
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This page      While 
the second lead 
photographer Christophe 
Viseux and the rest of 
the Silk team used 
conventional equipment, 
Sephi used an iPhone 6S 
Plus throughout.
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images either. I found that capturing dancing 
wasn’t possible, for instance, nor any of the 
performances. Anything with movement in 
low light was a little difficult.

The one limitation with the phone is that 
the ISO doesn’t go high enough, so you get 
a lot of motion blur. So I would have to wait 
until someone stopped or, as I soon learned 
to do, I held an LED light in one hand and 
shot with the other.

What surprised you most about 
shooting a wedding with an iPhone?
The most rewarding thing was the 
immediacy of it all. Excitement is something 
you lose after 30 years as a photographer, 
and it was really great to have that again. 
To share and be excited and surprised by 
the kind of image that comes out, and to see 
the amazement on people’s faces who are 
surprised you could make this on a phone 
is a wonderful feeling for a photographer.

Why do you think some photographers 
are sceptical of mobile phone cameras?
Photographers who are amateurs usually 
make the mistake of comparing their 
work with the highlights of professional 
photographers. The only work they see from 
us is the work we have on our websites. They 
don’t see all of my bad stuff. And I think this 
is the cause of a lot of insecurity. When you 
speak with photographers who know their 
tools, they know it’s not the cameras that 
enable great pictures, it’s the person.

The truth of the matter is that a lot of 
professional photographers go back to older 
cameras and more basic tools. I’ve gone back 
to using a wood camera. I enjoy working with 
the Lomo and plastic cameras. If you know 
what to do with an alternative technique you 
can produce images that are really unique.

Do you think camera phones are the 
future of photography?
I think D-SLRs are over. I don’t even own a 
D-SLR anymore. They’re still very relevant if 
you’re a sports photographer, but if you have 
to move around I don’t think D-SLRs are 
needed anymore.

Brands like Canon and Nikon need to 
reinvent themselves or they will end up like 
Kodak, which wasn’t smart enough to move 
ahead. I think mobile phones will have better 
and better cameras, which will democratise 
the field. You might say, what’s the point of 
a photographer? But a photographer will 
always be able to produce a unique image 
because they have a particular vision.

m O r e  i n F O
• Visit Sephi Bergerson’s website at www.
sephi.com and his wedding photography 
sub-site at wedding.sephi.com. His 
Instagram account is sephibergerson.
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NIKON D5
Can Nikon’s new flagship full-frame SLR 
match the dizzy standards of the D4S?

CANON EOS 80D
Canon’s latest APS-C format SLR offers 
a 24.2MP sensor and lots of new features

SONY AlphA 6300
A new autofocus system and 4K video 
shooting feature in this new CSC

Given to the top 
product in a  
group test

For products  
that offer superb 
value for money

Given to products 
that receive five 
stars overall

Given to products 
that are innovative 
& groundbreaking

Given to products 
that merit very 
special attention

reviews you can trust

Our five awards

Digital Camera is brought to you by 
the UK’s most experienced team of 
photography journalists, which means 
you can trust everything you read, and 
compare kit with confidence. 

We believe the best way to test a 
product is to use it as it was intended. 
Our real-world testing involves taking 
equipment on a proper shoot – 
whether outdoors or in the studio – 
and using it exactly as you would, to 
let you know if it’s fit for purpose. 

Scientific data won’t tell you 
everything, but it’s a great way to 
make comparisons and sense-check 
our real-world conclusions. We have a 
series of controlled tests for cameras 
and lenses that deliver objective 
benchmarks. You can download the 
high-resolution test images and 
resolution charts we shoot from www.
techradar.com/cameras. This means 
you can check the quality yourself – 
and even run your own tests.

Scores explained
Each of our tests scores  
out of five in one or more 
sub-categories; then we award 
an overall mark out of five. 
Digital Camera is 100% 
independent – and never 
swayed by advertisers. The tests 
you read are our genuine, 
unbiased opinions. Our company 
has a strict code of conduct on 
testing – the most rigorous of 
any photo magazine.

Forget it

Below average

Good for the price

Very good all round

An exceptional,  
best-in-class product

124

TRAVEl BAGS
Six solutions for 
carrying cameras 
and lenses without 
straining your back 
on the road

123

pORTABlE 
DRIVES
Six hard disks and 
solid-state drives 
you can take with 
you on the road

113

SIGMA MOUNT 
CONVERTER
Use Canon lenses 
and more on Sony 
cameras with this 
clever accessory

alSO reVieWeD:

102

pORTRAIT lENSES
Six primes and two zooms to 
help make your portraits pristine
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With a fresh AF system and 4K video, the A6300  
aims to set the bar high for the enthusiast user

Sony has done 
a stellar job to get 
its Alpha line of 
compact system 

cameras and lenses 
firmly established in 
the mirrorless camera 
market, with everyone 
from complete beginners 
to demanding professionals 
now catered for. Plenty of 
focus has been placed on Sony’s 
most recent Alpha 7 full-frame 
models, although it scored a big 
hit with the more junior A6000 
before this – and now it seeks to 
repeat its success with the A6300.

Features
The A6300 may look similar 
to the camera it updates, but 
a handful of changes on the inside 
show it to be a much mightier 
proposition for the enthusiast.  
It has been constructed around 
a new 24.2MP Exmor CMOS 
sensor, which is said to be more 
efficient at gathering light and 
reading out information than the 
A6000. This also allows it to offer 

Sony alpha 6300 
£999/$999 (body only) 

1

The 16-50mm Power 
Zoom kit lens adds 
only a little to the 
camera’s profile.

2

Not only does the 
A6300 offer a built-in 
flash, but there’s also 
a hotshoe. 

3

The Fn button brings 
up commonly used 
options, and these can 
be customised.

4

The camera’s rear 
screen can be tilted up 
and down, but it’s not 
sensitive to touch.

C S C  w w w. s o n y . c o m

4

2

Sensor      24.2MP APS-C Exmor
Focal length conversion      1.5x
Memory      SD/SDHC/SDXC(inc UHS-I)/
Memory Stick Pro Duo
Viewfinder       0.39-inch OLED EVF;  
2.36 million dots
Max video resolution      4K UHD (3,840 
x 2,160) up to 60p
ISO range      expandable to 51,200
Autofocus points      425 points 
(phase-detect AF); 169 (contrast-detect AF)
Max burst rate      11fps
Screen      3-inch LCD, 921k dots, tiltable
Shutter speeds      30-1/4,000 sec, Bulb 
Weight      404g (including battery 
and memory card)
Dimensions      120 x 67 x 49mm 
Power supply      Rechargeable Li-Ion 
battery (NP-FW50)

SpeCifiCationS 4K video recording, a feature that 
Sony is strongly pushing through 
on cameras of all levels.

The sensor also offers an 
unprecedented 425 phase-detection 
AF points, plus 169 contrast-
detection points. This combination 
is said to ensure that focus is swift 
against static subjects – focusing in 
as little as 0.05 sec – and capable of 
keeping up pace with moving ones.

There’s also the familiar sight of 
a tilting three-inch LCD screen, with 
921,000 dots for clarity, but sadly no 
touch operation. The 2,359,000-dot 
electronic viewfinder above this 
has been upgraded from the 
1.440,000-dot version on the A6000. 
Sony has also thrown in the option 
of shooting at up to 11fps with focus 
and auto-exposure maintained 
throughout, as well as Wi-Fi and NFC 
for easy image sharing.

Build & handling
All of this is wrapped up in a 
magnesium alloy body that’s 
designed with improved dust and 
moisture resistance over the A6000, 
as well as a sturdier lens mount. The 

The new 24.2MP Exmor 
CMOS sensor is more 
efficient at gathering 
light and reading out 
info than the A6000

1

3
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Although the A6000’s 
viewfinder was a good 
performer, it’s great to 
see this being made 
even better here with a 
higher resolution panel

grip is large and deep, and well 
rubbered for comfort, although 
larger-handed users might prefer this 
to be even deeper. 

Controls are plentiful around the 
back of the camera, and a good level 
of customisation is possible. The 
control wheel at the rear moves freely 
enough for quick menu scrolling and 
option selection. The command dial 
on the top plate has a pleasing 
stiffness to it, although there can 
be a slight disconnect between its 
turning and the camera responding.

The LCD screen pulls away easily 
from the back plate: this makes 
viewing it in more awkward shooting 
positions easier, although when 
extended it can get in the way of 
certain controls, such as the 
commonly used Fn button and 
the rear control wheel.

Performance
Although the A6000’s viewfinder was 
a good performer, it’s great to see this 
being made even better here, with a 
higher-resolution panel. It’s crisp and 
high in contrast, and only troubled  
by a little noise in darker conditions. 
The LCD screen’s specifications aren’t 
quite class-leading, and at default 
settings it appears somewhat 
under-powered and in need of a boost 
in brightness through the menu, 
although it otherwise performs as 
you would expect.

The camera’s revamped focusing 
system is one of its main highlights, 
and it’s pleasing to discover that it 
delivers. There’s very little delay when 
focusing on everyday subjects, while 
performance against moving subjects 
is also strong. The spread of focusing 
points, almost up to the peripheries 
of the frame, ensures that the system 
stays with the subject well wherever it 
moves. Objects travelling in a variety 
of directions and speeds relative to 
the camera are picked up and 

1

Colour
The camera’s Vivid Creative 
Style has given the greens 
and reds in this image a 
pleasant boost, without 
oversaturating them.

2  
Out-of-focus areas
Captured at f/4 with the 
Carl Zeiss Vario-Tessar T* E 
16-70mm f/4 ZA OSS, the 
out-of-focus areas in this 
scene appear smooth.

3  
Exposure
This shows the camera’s slight 
tendency to under-expose on 
occasion. This image benefits 
from +0.5EV over-exposure to 
make it more balanced.

Meet the 
rivals…
 
The cameras 
taking on 
the Sony 
A6300…

Fujifilm X-E2S
£549/$699
With a 16MP X-Trans 
CMOS sensor and 
X-series glass, 
Fujifilm’s compact 
and affordable 
rangefinder-style 
mirrorless model is 
worth a closer look.
Not reviewed

Panasonic GX8
£574/$998
The GX8 has an 
excellent 20MP 
sensor to 
recommend it, 
together with a fast 
AF system, 4K video 
– and a great price.
Reviewed Issue 170

FOr TEST 
iMAgES And 
rESOluTiOn 
ChArTS, ViSiT
www.techradar.
com/cameras

olympus Pen F
£999/$1,199
The latest Pen model 
from Olympus oozes 
style, but it’s just as 
impressive on the 
inside, with a 
cracking EVF and 
high-quality images.
Reviewed Issue 178

>
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The Sony A6300 does a great job with colour 
accuracy in JPEGs. Only the rival Alpha 7 II 
shows a marginally better performance out 
of the models tested here.

 VerDiCt  

 oVerall  

 BUilD & HanDling  

performanCe  

 ValUe  

 featUreS  

Although a comparison with its immediate 
rivals shows the A6300 to slip a little with 
dynamic range and noise, when viewed in 
isolation it performs well. It’s packed with 
features, focuses promptly and accurately, 
and records superb video. While it’s not 
cheap, you get a lot of camera for your money. 

We SaY...
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A slightly disappointing performance across 
the camera’s full sensitivity span here, with 
a signal-to-noise ratio that’s either the same 
or lower than the others at every setting.

raW Signal-to-noiSe ratio

100 400 1,600 6,400 25,600

The A6300 doesn’t fare too badly for raw 
dynamic range at its lowest sensitivities, 
although as ISO increases, its performance  
is largely outgun by the other cameras here.
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raW DYnamiC range

adhered to well. Every now and again 
the system does get a little distracted 
and venture off elsewhere but, to be 
fair, this is true of many similar 
systems.

When set to burst shooting, Sony 
claims the camera can record 21 
consecutive raw frames or the same 
number of raw+JPEG frames, and 44 
JPEG frames at the highest quality 
setting – and with a fast memory 
card in place it manages to do just 
this. 4K videos looks crisp and 

detailed, and even when light levels 
fall there’s just a slight noise visible in 
footage rather than anything more 
disagreeable, with footage pleasingly 
free from aberrations. 

Audio quality is also very 
good, although using an external 
microphone is advised as the 
camera joins many others in being 
susceptible to picking up wind noises 
when shooting outside.

Noise is well controlled in images, 
and usable results are still possible 
at settings as high as ISO 6,400, 
although you may wish to adjust 
noise reduction (or process the raw 
versions) as the camera’s noise 
reduction system can leave images 
lacking in detail. Images straight out 
of the camera show the A6300’s 
JPEG processing does a fine job,  
with pleasing colour, contrast and 
sharpness. (You may find that you 
wish to nudge up a little at times, 
particularly when shooting very 
detailed subjects). 

The camera’s Dynamic Range 
Optimizer also does a fine job to 
reveal more detail in shadowy areas, 
helping images to appear balanced, 
which is just as well as the metering 
system can occasionally under-
expose the odd frame. Exposure 
compensation is very easy to apply, 
though – and usually only around 
+0.5EV is all that’s required. 
Matt Golowczynski
 

above Comparing this JPEg with the 
corresponding raw file shows the 
camera has done a great job boosting 
contrast and colour. Sharpness is also 
just at the right level.

above The camera’s Auto White 
Balance system keeps colours faithful 
under a range of conditions. This image 
was captured under a mixture of 
daylight and various artificial sources.

above The camera’s electronic level makes it easy to capture images completely horizontal (or 
vertical) – important in scenes where linear details make any slight skewing more apparent.

highEr SCOrES ArE BETTEr. rAW  
rESulTS uSE iMAgES COnVErTEd TO TiFF

highEr SCOrES ArE BETTEr. rAW  
rESulTS uSE iMAgES COnVErTEd TO TiFF

SCOrES ClOSEr 
TO ZErO ArE 

BETTEr
-3.7

19

-6.6

11.6

Images straight out of the 
camera show the A6300’s 
JPEG processing does a fine 
job with pleasing colour
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CANON  EOS 80D

Canon’s new 80D looks great on paper, but does it 
deliver – and is it worth upgrading from the 70D?

The EOS 80D is 
aimed at dedicated 
enthusiast 
photographers, a 

demanding group of people 
who want to be able to shoot 
a huge range of subjects in a 
variety of conditions. Inside 
is a new 24-million-pixel sensor 
along with a Digic 6 processing 
engine; a combination that brings 
a native sensitivity range of ISO 
100-16,000 (one-stop higher 
than the 70D) and a maximum 
expansion value of ISO 25,600 
(the same as the 70D).

The maximum continuous 
shooting rate is the same as the 
70D’s at 7fps, but the burst depth 
has been increased to 110 JPEGs 
or 25 raw files when a UHS-1 SD 
card is used. That’s a significant 
step up from the 65 JPEG or 16 
raw files possible with the 70D. 

Modern SLRs have two 
autofocus systems: one for when 
using the camera conventionally 
(in reflex mode), where images 
are composed in the viewfinder; 
and a second for use in Live 
View and video mode. Canon has 
improved both of these systems 
for the 80D in comparison with 

Canon eOS 80D £999/$1,199

1

An NFC chip means 
the 80D can connect 
to an NFC enabled 
smartphone or tablet 
with just a tap.

2

The vari-angle screen 
is the same as the 
Canon 70D’s, but it 
provides a delightfully 
detailed view. 

3

Canon has kept the 
80D’s shape and 
control layout the 
same as the 70D’s.

4

A headphone port 
joins the mic port  
for audio monitoring 
and recording.

Sensor      APS-C format with 24.2 million 
effective pixels
Focal length conversion      1.6x
Memory      SD/SDHC/SDXC (UHS-1)
Viewfinder     Optical covering 100%
Max video resolution      Full HD  
(1920 x 10800
ISO range     100-16,000, expandable  
to 25,600
Autofocus points      45, all cross-type
Max burst rate      7fps
Screen      Three-inch 1,040,000-dot  
Clear View II TFT
Shutter speeds      30-1/8,000sec, Bulb
Weight      650g (body only) 
Dimensions      139 x 105 x 79mm
Power supply      Lithium-ion LP-E6N

S L R  w w w. c a n o n . c o m

1
2

SpeCifiCatiOnS

the 70D. The reflex mode system, 
for instance, has 45 AF points, all 
of which are cross-type, whereas 
the 70D has 19 points. It can also 
use colour information from the 
7,560-pixel RGB+IR (infrared) 
metering sensor to help with 
subject tracking. This and the 
increased burst depth makes the 
80D more attractive to keen sport 
and action photographers.

Turning to the Live View and video 
autofocus system, the 80D uses Dual 
Pixel CMOS AF technology like the 
70D, which means it has phase 
detection points on the imaging 
sensor itself. The new system is 
more sensitive and faster than the 
one in the 70D, but because fast 
autofocusing often isn’t desirable 
when you’re shooting video, it’s 
possible to vary the speed of the 
80D’s system over seven steps for 
slower focus changes.

Build & handling
Canon gives touch-control over both 
the main and Quick Menus, and it 
can really speed up use. The Quick 
Menu is very useful, providing a 

The 8oD’s screen is 
very good, but the 
viewfinder is still the 
most natural option for 
photographers to use 
when shooting stills

3

4
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1  
Fast AF
In continuous autofocus mode, the 
80D kept this skateboarder sharp 
easily as he moved across the 
frame and towards the camera.

2  
Dynamic range
Thanks to the 80D’s high dynamic 
range, there’s detail in the bright 
highlights as well as the gloomy 
interior of this scene.

3  
It’s natural
The automatic white balance 
system coped with the different 
light and numerous colours of the 
scene to produce a natural image.

speedy route to some of the most 
commonly used features. It would 
be nice, however, if this was 
customisable so that it only 
contained the features you use on 
a frequent basis.

Although the 80D’s screen is 
very good, the viewfinder is still 
the more natural option for most 
photographers to use when 
shooting stills, especially if the 
subject is moving. This also provides 
a bright view – and unlike the 70D’s 
viewfinder, which only covers 98% of 
the lens field of view, the 80D’s covers 
100%. That means there are fewer 
surprises around the edge of the 
frame when you review your shots.

In an update on the 70D, it’s 
possible to select the Creative Filter 
mode via the 80D’s mode dial. When 
this is selected, one of 10 filter effects 
can be applied to JPEG images as 
they are shot. If you’re shooting raw 
files or raw+JPEG files, the camera 
switches automatically to shooting 
just JPEGs. Although it’s possible to 
use Creative Filters when composing 
images in the viewfinder, their 
impact can only be previewed on 
the main screen in Live View mode.

Performance
The 80D’s 24.2MP sensor makes a 
25% increase in pixel count over the 
70D’s, and it enables the new camera 
to make a significant step up in detail 
resolution for the majority of the 
sensitivity range without an increase 
in the level of noise. It’s noticeable, 
however, that at ISO 12,800 the 80D 
scores lower in our resolution tests 
than the 70D. However, when the 
default levels of noise reduction 
are applied, images shot at this 
sensitivity setting (and at ISO 
16,000) look good. 

Noise is controlled well and 
although some detail is lost, there’s 
no obvious smearing. We would 
advise caution with the uppermost 
setting of ISO 25,600, because some 
areas have a slight haze and lack 
detail when images are at around A4 
size. But that’s why this value is an 
expansion setting: Canon makes it 
available for use if it’s really needed, 
but doesn’t consider the image 
quality entirely satisfactory.

Canon has given the 80D a 
significantly better autofocus (AF) 

Meet the 
rivals…
 
The cameras 
taking on the 
Canon 80D… 

Sony Alpha 77 II 
£764/$1,198
This 24Mp SLT 
has an electronic 
viewfinder, along 
with an AF system 
that’s fast and 
accurate even in 
low light.
Reviewed Issue 156

Pentax K-3 II 
£709/$850
Pixel Shift Technology 
helps reduce noise 
from this 24MP SLR, 
but its impact isn’t 
obvious with most 
shots at normal 
viewing sizes.
Reviewed Issue 170

FoR teSt 
iMageS and 
ReSoLution 
chaRtS, viSit
www.techradar.
com/cameras

Nikon D7200 
£714/$1,047
Like the K-3 II, this 
SLR’s 24MP sensor 
lacks an optical 
low-pass filter, which 
helps it resolve a 
higher than average 
amount of detail.
Reviewed Issue 164
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Above the 
Monochrome 
Picture Style gives 
a useful indicator, 
but the best results 
are created by 
converting a raw file.

Left despite the 
very low light, the 
camera was able to 
focus, and noise is 
controlled well for 
iSo 16,000.

gloomy conditions of London’s 
Undercroft skate park, and found 
that the 45-point Automatic Selection 
option is pretty capable, probably 
aided by the new colour detection 
system. Single-point AF (Manual 
selection) mode also worked well 
provided I could keep the active point 
over the subject. That’s easier said 
than done when you’re shooting 
skateboarders, who are prone to 
jumping, twisting and turning, and 
I had greater success when using the 
Zone AF mode. 

In this mode, the 45 AF points are 
grouped into nine zones and you 
select the most appropriate zone to 
use before starting to shoot. The 
camera then tracks the subject using 
the AF points within that zone. It’s a 
great option for moving targets and 
you see the points light up as they 
activate, giving you confidence that 
your images will be sharp. It’s not 
100% fool-proof but I got a high hit 
rate, and it’s more reliable than 
45-point Automatic Selection mode.

The Live View and Video mode 
AF system is also good. It’s fast 
enough to shoot stills of moving 
subjects in some situations, but the 
viewfinder system is more reliable. 

system for use with the 
viewfinder than the 70D, so I was 
keen to put it to the test. It didn’t 
disappoint, getting stationary 
subjects sharp in a flash and 
keeping fast-moving subjects 
sharp, even in low light. 

I experimented with the AF 
point selection modes when 
shooting skateboarders in the 

We found that the 
45-point Automatic 
Selection option is 
pretty capable, 
probably aided by  
the new colour 
detection system 

B&W JPeg

RaW conveRSion
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CANON EOS 80D

While colours aren’t as saturated as in images 
from the Pentax K-3 II, the 80D’s shots are a 
little more saturated than is technically correct. 
Still, they make for attractive results.

 VerDiCt  

 OVerall  

 BUilD & HanDling  

perfOrmanCe  

 ValUe  

 featUreS  

Canon has created an excellent camera that 
makes a worthwhile upgrade from the 70D. 
It’s well-built with sensibly arranged 
controls, has good ergonomics and an 
extensive feature set, and can be set up to 
suit your shooting style. Most importantly, 
the image quality is superb with lots of detail.

We SaY...
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On the whole, the Canon 80D’s images are a 
little cleaner than the 70D’s. It only drops 
slightly behind the Pentax K-3 II and Sony 
Alpha 77 II at the top sensitivity values.

raW Signal-tO-nOiSe ratiO

100 400 1,600 6,400 25,600

Canon has squeezed more dynamic range 
from the 80D than the 70D, indicating 
images have a better range of tones. 
However, the K-3 II achieves higher values.
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When shooting in 
Live View mode, 
the 80D uses the 
imaging sensor 
to measure 
exposure, and it 
does a good job. However, if you’ve 
turned up the brightness of the 
screen to cope with bright ambient 
light, keep an eye on the histogram 
view: images may look brighter than 
they actually are.
Angela Nicholson

When shooting in Live View,  
the camera uses the imaging 
sensor to measure exposure

Above the articulating screen is really useful when you want to shot from low angles like this.

higheR ScoReS aRe BetteR. RaW  
ReSuLtS uSe iMageS conveRted to tiFF

higheR ScoReS aRe BetteR. RaW  
ReSuLtS uSe iMageS conveRted to tiFF

ScoReS cLoSeR 
to zeRo aRe BetteR

The Dual Pixel CMOS AF system’s 
focus shift is smooth enough to be 
usable when shooting video, but it 
is dependent upon the shooting 
scenario and speed of movement.

In reflex mode the 80D uses the 
same metering system as the 750D 
and 760D, which means there’s a 
7,560-pixel RGB+IR (infrared) 
sensor and 63-zone Evaluative, 
Partial, Centre-weighted and Spot 
metering options. The evaluative 
system is very good, but the 
weighting applied to the active AF 
point can mean you need to apply 
exposure compensation in high-
contrast situations. There’s nothing 
especially unusual in that. 

4.5
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It’s a great camera with a fabulous AF system – but 
forget about using the highest sensitivity setting

The D5 takes the 
top spot from the 
D4S in Nikon’s SLR 
line-up. It’s aimed 

primarily at professional news 
and sports photographers, and is 
designed to take photographs in 
challenging conditions. It comes 
equipped with a 20.8MP full-
frame sensor and Nikon’s Expeed 
5 processing engine, which 
enable a native sensitivity range 
of ISO 100-102,400, with 
expansion settings going to ISO 
3,280,000. Yes, three million.

In addition there’s a 153-point 
autofocus (AF) system with 99 
cross-type sensors and the ability 
to shoot at up to 12 frames per 
second, with full autofocusing 
and metering capability for up to 
200 raw files.

Build & handling
Nikon has kept the D5’s control 
layout the same as the D4S. While 
this makes it easy to swap 
between the two cameras, there 
are a few niggles with the 
handling. Because of differences 

nikon D5 
£5,199/$6,499

1

Until a promised 
firmware upgrade 
comes, there’s 
a three-minute 
maximum for 4K video.

2

In review mode, this 
3.2-inch, 2,359,000-
dot screen is touch-
enabled for easy 
image navigation.

3

Nikon should combine 
the functions of the 
Info and ‘i’ buttons to 
streamline controls.

4

The D5 has a metal 
body and extensive 
weather-sealing; 
there’s even a 
weatherproof cover 
for the hotshoe.

Sensor      Full-frame (35.9 x 23.9mm) 
with 20.8 million effective pixels
Focal length conversion      1
Memory      Dual XQD or Dual CF
Viewfinder      Optical covering 100%
Max video resolution      4K (3,840 x 
2,160 pixels)
ISO range      100-102,400 expandable to 
ISO 3,280,000
Autofocus points      153 and 99 
cross-type
Max burst rate      12fps with AF and 
metering, 14fps without and in live view 
mode
Screen      Touch-sensitive 3.2-inch 
2,359,000-dot
Shutter speeds      30-1/8,000 sec, Bulb
Weight      1,235g (body only)
Dimensions      60 x 158.5 x 92mm
Power supply      Rechargeable Li-ion 
EN-EL18a

S L R  w w w. n i k o n . c o m

4

1

2

SpeCifiCationS in the number and position of the 
controls for horizontal and vertical 
shooting, you have to adapt the 
way you control the camera to the 
orientation you’re shooting in.

Performance
In many respects the D5 is a 
phenomenal performer. It beats or 
matches the 24MP D750 for detail 
resolution, for example. Real-world 
images look cleaner and sharper than 
those from the D4S, although it’s 
best to keep sensitivity below ISO 
102,400, and the results at the 
maximum sensitivity setting (ISO 
3,280,000) are very poor.

I found the AF system extremely 
capable, getting fast-moving subjects 
sharp in very low light and tracking 
them around the frame. The 3D 
tracking option is useful, but it relies 
on a strong colour contrast between 
the subject and the background.

In other respects the D5 performs 
well. The Matrix metering system is 
fairly easily influenced by very dark 
or bright sections in the scene, but 
it’s usually predictable. 
Angela Nicholson

Real-world images 
look cleaner and 
sharper than those 
from the D4S

3



The D5 is a great camera and a worthwhile 
upgrade to the D4S, but there are a few 
niggles that stop it from being an absolute 
belter. The top sensitivity expansion settings 
are headline-grabbing, if largely useless to 
most photographers, but the image quality in 
the native sensitivity range is high, provided 
you keep an eye on the exposure.

K I T  Z o n eNIKON D5
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This indicates that the D5 produces more 
vibrant images than the competing cameras. 
We found it produced quite muted tones of 
natural subjects like landscapes or people.
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DXO Analyzer was unable to analyse the files 
taken at the D5’s upper sensitivity values. 
The Canon 1D X Mark II beats the D5 in all 
but the lowest sensitivity values.

raW Signal-to-noiSe ratio

While the D5’s raw file dynamic range is good, 
it is beaten by the D4S and the 1D X Mark II, 
indicating that these cameras capture a 
broader range of tones.
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We SaY...

Meet the 
rivals…
 
The cameras 
taking on 
the Nikon D5… 

Nikon D4S 
£4,189/$5,997 
(body only)
Still a great 16MP 
camera, the D4S has 
been popular with 
pros. There should 
be some well-used 
examples available 
second-hand.
Reviewed Issue 153

Nikon D750
£1,385/$1,997 
(body only)
Aimed at enthusiast 
photographers, the 
D750 is a capable 
all-rounder that has 
a 24MP full-frame 
sensor and an 
excellent AF system.
Reviewed Issue 158

FoR teSt 
iMageS and 
ReSoLution 
chaRtS, viSit
www.techradar.
com/cameras

Canon eOS-1D X 
Mark II
£5,199/$5,999 
(body only)
Canon’s direct 
competitor to the 
D5, this 20.2MP 
full-frame SLR has a 
superb AF system, 
14fps shooting and 
excellent metering.
Not reviewed

10 15 200-5

NIKON D5 7.9

-0.92

2.9CANON 1DX II

NIKON D750

NIKON D4S

5

ColoUr error

-5.4

1  

Decisive timing
The 12fps burst rate came in very 
handy for getting a nice cloud of 
glitter on an Aspire Photography 
Training course. (www.
aspirephotographytraining.co.uk).
 

2

Faithful hues
At low sensitivity settings, the D5 
captures a lot of detail, with results 
on a par with or even beating a 
higher-resolution camera like the 
D750, for example. 

3

Natural colour
In the Standard Picture Control 
mode, the D5 produces quite subtle 
shades of natural subjects, but it 
still makes bold colours look 
pleasantly vibrant.

higheR ScoReS aRe betteR. Raw  
ReSuLtS uSe iMageS conveRted to tiFF

higheR ScoReS aRe betteR. Raw  
ReSuLtS uSe iMageS conveRted to tiFF

ScoReS 
cLoSeR 
to zeRo 

aRe betteR
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The MC-11 gives a new lease of life to many 
Canon-fit Sigma lenses, if you want to add  
a Sony camera body to your collection.

WE SAY...
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SIGMA MOUNT CONVERTER MC-11

Want a Sony body? Don’t ditch your Sigma lenses...

There’s a lot to 
be said for Sony’s 
lightweight yet 
high-performance 

compact system cameras, 
like those from the A7 and 
NEX series. So much so that 
users of relatively bulky Canon 
SLRs might feel tempted to jump 
ship. One thing stopping them is 
that their existing lenses won’t be 
compatible. But the new Sigma 
Mount Converter MC-11 goes 
some way to changing that.

The high-tech converter 
enables you to mount 19 of 
Sigma’s current Canon-fit (or 
Sigma-fit) lenses on a Sony 
E-mount body. It ensures the 
correctly spaced physical 
coupling, and enables electronic 
control of autofocus, aperture, 
and more besides. In-camera 
corrections for peripheral 
illumination, distortion and 
lateral chromatic aberration are 
available, even though these 
aren’t supported when using 
Sigma’s Canon-fit lenses on 
actual Canon bodies.

The built-in electronics and 
data bank currently support 

Sigma lenses ranging from 
Contemporary class APS-C 
format zooms to high-quality 
Art and Sports line primes and 
zooms for full-frame cameras. 
The full list is on Sigma’s website.

The converter features a 
dual-colour status lamp. Solid 
green indicates compatibility; 
blinking orange indicates that the 
lens needs a firmware update 
(available via the Sigma USB 
Dock for compatible lenses); and 
a lack of any illumination means 
the lens is incompatible. 

Performance
Autofocus speed and accuracy 
isn’t impaired, although only 
single rather than continuous 
autofocus can be used. Sharpness 
remains as impressive as when 
using Canon-fit lenses on Canon 
bodies, and other image attributes 
can actually be better, thanks to 
in-camera corrections. With a 
physical length of about an inch, 
and the large size of some Sigma 
lenses, the combination can feel 
front-heavy on Sony’s diminutive 
bodies, but performance is good.
Matthew Richards

Sigma mount 
Converter mC-11 £190/$250

1

The mounting plates 
enable Canon/
Sigma-fit lenses to 
be attached to Sony 
E-series bodies, 
complete with 
all electronic 
communication.

2

A USB port is fitted  
to allow updates to be 
applied to the mount 
converter, direct from 
a computer.

3

The LED indicator 
shows compatibility 
status, and whether 
a firmware update is 
required for the lens.

Full-frame compatible      Yes
APS-C compatible      Yes
Autofocus (single)      Yes
Autofocus (continuous/auto)      No
Direct manual focus       Lens-dependent  
Use with teleconverters       No
Optical stabiliser      If supported in lens
Exif data retained      Yes
Weather seals      No
Communication port for updates      USB
Supplied accessories      Caps
Compatibility check      Via LED lamp

A c c e s s o r y  w w w. s i g m a - i m a g i n g . c o . u k
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SPECiFiCAtiONS

Excellent lab scores for sharpness are 
retained when using the MC-11 with Sigma’s 
top-flight Art and Sport classes of lens.

SHArPNESS

Scores for colour fringing are at least as good 
as when using lenses on Canon bodies, and 
even better with Sony’s in-camera corrections.

Again, automatic distortion corrections  
can be applied in compatible Sony bodies, 
whereas this isn’t available in Canon D-SLRs.

FriNgiNg NeArer 0 is better

DiStOrtiON NeArer 0 is better
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Portrait 
Lenses

S

the contenders
1 canon EF 70-200mm f/2.8L IS II USM £1,500/$2,000

2 canon EF 85mm f/1.2L II USM £1,500/$2,000

3 Fuji XF56mm f/1.2 R APD £875/$1,500

4 nikon AF-S 70-200mm f/2.8G ED VR II £1,800/$2,100

5 nikon AF-S 85mm f/1.4G £1,200/$1,600

6 sigma 85mm f/1.4 EX DG HSM £620/$900

7 sony FE 85mm f/1.4 G Master £1,500/$1,800

8 tamron SP 85mm f/1.8 Di VC USD £750/$750

ome say the lens is 
‘everything’, but 
that’s not really true 

in the digital age. It’s more 
about how the body and the lens 
combine to deliver the results 
that you’re after – and that’s 
particularly true for portraiture. 

Full-frame bodies, for example, 
have an advantage over those 
with smaller image sensors, in 
that they can deliver a tighter 
depth of field at any given ‘actual’ 
versus ‘effective’ focal length. But 
some APS-C camera systems fight 
back, like Fujifilm bodies with the 

availability of a super-fast f/1.2 
lens that also packs a secret 
weapon for enhancing bokeh 
(the quality of defocused areas 
in images).

Then there’s the question of 
whether a ‘fast’ f/2.8 telephoto 
zoom is better than a faster 
85mm prime lens for portraiture. 
The zoom might be better for 
portraiture at weddings and 
events, whereas similarly priced 
prime lenses tend to have faster 
apertures of f/1.2 or f/1.4. Let’s 
see how the most exciting 
contenders compare…

Want to make people look good  
on camera? Matthew Richards  

picks out the ideal lenses
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Canon EFMount option:

f/8 f/11 f/16 f/22 f/32
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f/4f/2.8 f/.56
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2500
readings taken 

from centre

f/1.2
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T LsharPness higher is better

Wide 1.22 Mid 0.32 Tele 0.79

Wide -1.17 Mid 0.89 Tele 1.35 Distortion -0.96

Sharpness is good overall, but could be 
better at the short end of the zoom range.

sharPness higher is better

Zoom lens

Lateral chromatic aberration is extremely 
well controlled for a telephoto zoom.

There’s slight barrel and pincushion at the 
short and long ends, but little of concern.

FrIngIng (at F/8) Lower is better

dIstortIon nearer 0 is better

sharPness higher is better

Fringing 1.32

It’s downright soft at f/1.2 but becomes 
pretty sharp at f/1.8 and crisp at f/2.8.

Lateral colour fringing is minimal but 
longitudinal fringing can be quite evident.

Lab scores show slight barrel distortion 
but, again, it’s difficult to spot in images.

dIstortIon nearer 0 is better

FrIngIng (at F/8) Lower is better

 VerdIct  

 oVerall  

 BUIld & handlIng  

 PerFormance  

 ValUe  

 FeatUres  
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 PerFormance  

 ValUe  
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The full-cream Canon stands out The joint fastest lens on test

canon eF 70-200mm  
f/2.8l Is II Usm 

£1,500/$2,000 

canon eF 85mm  
f/1.2l II Usm 
£1,500/$2,000 

his 70-200mm zoom 
certainly stands out 
in the crowd. It’s the 

only one here with a cream-
coloured paint job, which 
Canon often applies to its larger 
telephotos to minimise the 
build-up of heat when shooting 
under a hot sun. The creaminess 
of its bokeh is also pretty good at 
the long end of the zoom range, 
although the widest available 
aperture of f/2.8 means it loses 
out for shallowness in depth of 
field at 85mm, compared with 
the prime lenses on test.

The lens has a tough 
magnesium alloy-based 
construction, a high-performance 
fluorite element and no fewer than 
five UD (Ultra-low Dispersion) 
elements. It also boasts a four-
stop image stabiliser and weighs 
in at a hefty 1.4kg, complete with 
a tripod collar.

Performance
The autofocus system in this 
Canon zoom is super-fast, and the 
stabiliser lives up to its claims. 
Zoom versatility is nice to have 
but, at the short end of the range, 
sharpness isn’t particularly great, 
and the smoothness of defocused 
areas is a little lacking.

ike only the Fujifilm 
56mm lens on test, 
this Canon has an 

extra-wide aperture of f/1.2. 
That’s a third of a stop faster than 
the f/1.4 lenses, a full stop faster 
than the Tamron 85mm, and 
more than two stops faster than 
the 70-200mm zooms. It’s a big, 
chunky lens and the only prime 
here to tip the scales at over a 
kilogram. Even so, the filter 
attachment thread is relatively 
small at 72mm, compared with 
77mm for the 85mm f/1.4 lenses.

The pro-grade build lacks the 
weather-seals of most Canon 
L-series (Luxury) lenses. This 
Mk II edition has a ring-type 
ultrasonic autofocus system that 
includes an electronically coupled 
fly-by-wire focus ring.

Performance
The reduction in depth of field 
enabled by the oversized f/1.2 
aperture is minimal compared 
with the f/1.4 lenses, but the soft 
and smooth bokeh is maintained 
even when stopping down a little, 
aided by an eight-blade aperture. 
The autofocus speed is slow, 
requiring movement of the heavy 
front element, but at least the filter 
thread doesn’t rotate.

f/8 f/11 f/16 f/22 f/32

1500

1000

500

f/4f/2.8 f/.56

2000

2500

200mm100mm 135mm70mm EdgeMiddleCentre

PrIme lens

Mount option: Canon EF



Fujifilm X-Series Nikon FXMount option: Mount option:

f/1.2
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Distortion -0.02 Wide -0.64 Mid 1.18 Tele 1.83
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sharPness higher is better

Fringing 0.11

Focused areas generally sharp, apart from  
at the edges of the frame at wide apertures.

Extremely negligible amounts of lateral 
and longitudinal (bokeh) fringing.

Essentially zero distortion from this lens, 
with a lab score that’s practically perfect.

FrIngIng (at F/8) Lower is better

dIstortIon nearer 0 is better
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 BUIld & handlIng  
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sharPness higher is better

Wide 0.84 Mid 1.09 Tele 2.19

Sharper than many prime lenses, even at the 
extreme edges of the frame it’s a solid zoom.

Fringing gets slightly worse at the long end 
of the zoom range, but it’s only minimal.

There’s slight pincushioning at 200mm but 
performance is good throughout the range.

FrIngIng (at F/8) Lower is better

dIstortIon nearer 0 is better

It’s all about the filters King of the fast tele zooms

Fujifilm XF56mm  
 f/1.2 r aPd 

£875/$1,500 

nikon aF-s 70-200mm 
f/2.8g ed Vr II  

£1,800/$2,100 

hen it comes to 
minimising depth 
of field, the APS-C 

format Fujifilm lens is at a 
disadvantage compared with 
full-frame lenses, because its 
‘effective’ 84mm focal length 
is derived from a shorter 
56mm focal length. It fights 
back with an extra-wide aperture 
of f/1.2, and an apodisation filter, 
which is unique in this test group. 

Based on nano-technology 
engineering, the internal filter 
seeks to maintain sharpness of 
in-focus areas, while applying a 
‘melting’ effect to blur defocused 
areas more effectively. Naturally, 
the apodisation effect works best 
at wide apertures and, as such, the 
lens is supplied complete with an 
additional ND8 (three-stop 
neutral-density) filter.

Performance
Only contrast-detection autofocus 
can be used, but it’s not overly 
sluggish. The lens does well to 
produce a rich and creamy bokeh 
for defocused areas, but the actual 
depth of field isn’t very shallow 
even at f/1.2, where it’s roughly 
equivalent to shooting at f/2.8 
with an 85mm lens on a full-
frame camera.

he winner of our 
70-200mm group test 
in issue 175, this 

Nikon isn’t short on build 
quality or features. The sturdy 
magnesium alloy construction is 
weather-sealed and plays host to 
a three-mode focusing system that 
gives priority to either automatic 
or manual focusing during 
autofocus. The dual-mode 
stabiliser has normal and active 
settings, as well as automatic 
panning detection. 

Nikon’s ED (Extra-low 
Dispersion) glass is used for no 
fewer than seven of the 21 elements 
in the optical path, while Nano 
Crystal coatings are on hand to 
reduce ghosting and flare.

Performance
All areas of performance are 
simply excellent, from the 
lightning-quick autofocus system, 
through the highly effective 
optical stabiliser, to all aspects of 
image quality. Even so, it suffers 
from the same drawback as the 
Canon 70-200mm lens, in that you 
simply can’t get such a tight depth 
of field towards the short end of  
the zoom range, compared with 
using any of the 85mm prime 
lenses on test.
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sharPness higher is better

Fringing 1.53

Distortion -0.5 Distortion -0.2

Centre-sharpness is excellent throughout 
almost the entire aperture range.

sharPness higher is better

Minimal lateral chromatic aberration,  
with reduced longitudinal fringing.

Negligible barrel distortion, but it’s 
technically lower than in the Canon lens.

FrIngIng (at F/8) Lower is better

dIstortIon nearer 0 is better
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sharPness higher is better

Fringing 0.96

It’s a little disappointing in the corners,  
but excellent at the centre of the frame.

Lateral chromatic aberration is very low, 
but longitudinal fringing can be noticeable.

The extremely small amount of barrel 
distortion is almost impossible to spot.

dIstortIon nearer 0 is better

FrIngIng (at F/8) Lower is better

As good as it gets for Nikon An attractive buy at half the price

nikon aF-s  
85mm f/1.4g 

£1,200/$1,600 

sigma 85mm  
f/1.4 eX dg hsm 

£620/$900 

osing out by a third 
of a stop compared 
with Canon’s top-

flight portrait prime, the 
Nikon is more mainstream at 
f/1.4. It also has two more optical 
elements than the Canon, but with 
ten elements in nine groups, it’s 
still a lot less complex than the 
two zoom lenses in the group.

The pro-grade construction 
feels solid and robust, and the 
aperture is slightly better rounded 
than that of the Canon lens, 
based on nine rather than eight 
diaphragm blades. The internal 
focusing system also enables much 
faster autofocus than in the Canon 
lens. This isn’t really a ‘must have’ 
for portraiture but can be a bonus 
sometimes, like when you’re trying 
to capture fleeting expressions. 
Another improvement over the 
Canon lens is that the Nikon 
has weather-seals.

Performance
Contrast and sharpness are very 
good overall, with a touch of 
softness at f/1.4 that can look 
pleasant in portraiture. Lateral 
chromatic aberration is only very 
slight, and longitudinal or ‘bokeh’ 
fringing is better controlled than 
in the Canon and Sigma lenses.

e’re big fans of 
Sigma’s Art-line 
prime lenses and, 

for Canon and Nikon APS-C 
format cameras, the full-
frame compatible Sigma 
50mm f/1.4 A lens is our 
favourite portrait lens. This 
85mm optic is an older design but 
nevertheless features aspherical 
and SLD (Special Low Dispersion) 
elements, along with a ring-type 
ultrasonic autofocus system. The 
lens doesn’t include weather seals, 
but it does have a well-rounded 
nine-blade aperture and Sigma’s 
super multi-layer coatings to 
reduce ghosting and flare.

It has almost identical specs to 
the Nikon 85mm f/1.4 lens, but 
costs about half the price. The 
Canon and Sony 85mm lenses are 
nearly 2.5 times as expensive, 
making the Sigma great value.

Performance
Autofocus is fast and quiet, while 
centre-sharpness is excellent, 
even at f/1.4. Corner-sharpness 
is underwhelming at any aperture, 
but that’s not normally a deal-
breaker for a portrait lens. 
Longitudinal chromatic 
aberration can be quite noticeable, 
as with the Canon 85mm lens.

EdgeMiddleCentreEdgeMiddleCentre

f/2.8 f/8 f/11 f/16 f/22 f/32

1500

1000

500

f/4 f/.56

2000

2500

f/8 f/11 f/16 f/22 f/32

1500

1000

500

f/4f/2.8 f/.56

2000

2500

f/1.4f/1.4

PrIme lensPrIme lens

Nikon FX



Sony ACanon EF Nikon FXMount options: Mount options:Sony E

K I T  Z o n ePORTRAIT LENSES
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Sometimes the tortoise wins the race

S T

Distortion 0.71 Distortion 0.22

 VerdIct  

 oVerall  

 BUIld & handlIng  

 PerFormance  

 ValUe  

 FeatUres  

sharPness higher is better

Fringing 0.63

It’s almost too sharp for a portrait lens, but it’s 
nicer to have too much detail than not enough.

There’s little colour fringing throughout the 
entire aperture range, right across the frame.

There’s a very small amount of pincushion 
distortion, but it’s extremely hard to spot it.

FrIngIng (at F/8) Lower is better

dIstortIon nearer 0 is better

 VerdIct  

 oVerall  

 BUIld & handlIng  

 PerFormance  

 ValUe  

 FeatUres  

sharPness higher is better

Fringing 0.54

There’s more than enough sharpness on tap 
for portraiture, with impressive consistency.

Lateral fringing is impressively low, and 
longitudinal flaws are almost non-existent.

The amount of pincushion distortion is  
so tiny that it’s essentially a non-issue.

FrIngIng (at F/8) Lower is better

dIstortIon nearer 0 is better

A portrait lens for E-mount cameras

sony Fe 85mm  
f/1.4 g master  

£1,500/$1,800 

tamron sP 85mm  
f/1.8 di Vc Usd 

£750/$750 

onY’s new G Master 
portrait lens is 
beautifully built, 

features a weather-sealed 
construction, and adds 
plenty of useful touches like 
a focus hold button and 
hands-on aperture ring. 
Better still, the aperture ring has 
a de-click option that can be 
operated via a switch on the 
barrel, enabling smooth aperture 
transitions when shooting video.

Smart glass includes an XA 
(eXtreme Aspherical) element and 
three ED (Extra-low Dispersion 
elements). Sony claims the XA 
element features increased 
surface precision, which further 
beautifies the quality of bokeh. 
Another bokeh-enhancing feature 
is that the incredibly well-
rounded aperture is based on an 
impressive 11 diaphragm blades.

Performance
Sharpness is very good at f/1.4 
and stunning at f/1.8 and beyond. 
Despite this, bokeh is smooth 
and dreamy, and the transitions 
between focused and defocused 
areas are impressive. Sony’s Nano 
AR coating fends off ghosting and 
flare, and lateral and longitudinal 
fringing are both minimal.

his is the slowest 
prime lens in the 
group but, with a 

widest aperture of f/1.8, it 
still beats both of the zoom 
lenses on test by more than 
a stop. It’s also the only prime 
lens here to feature an optical 
stabiliser, which is a worthwhile 
addition when shooting on Canon 
and Nikon bodies.

It has pro-grade build quality, 
with excellent handling and a full 
set of weather-seals. It features 
XLD (eXtra Low Dispersion) and 
LD elements, along with Tamron’s 
eBand and BBAR nano-
structured coatings. The overall 
aim is to deliver superb image 
quality with great sharpness even 
in hand-held shooting, along with 
minimal colour fringing, ghosting 
and flare.

Performance
The ring-type ultrasonic 
autofocus system is ultra-fast, 
while sharpness is impressively 
consistent, both throughout the 
aperture range and across the 
whole frame. You can’t get quite 
such a minimal depth of field as 
with an 85mm f/1.4 lens, but 
the Tamron’s bokeh is simply 
gorgeous, which makes up for it.
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the VerdIct

sony gives a portrait masterclass
The Sony FE 85mm f/1.4 G Master is a gem of a lens

onY’s new 85mm G Master 
delivers everything you could 
hope for in a portrait lens, and 

more besides. Sharpness is exceptional, 
while defocused areas are sumptuously soft 
and dreamy. The focus hold button and 
de-click aperture ring option are bonuses, the 
latter working very well for shooting video.

Second place in the rankings goes to the 
similarly new Tamron 85mm. Despite being 
the ‘slowest’ prime lens in the group, it still 
enables a really tight depth of field when 
shooting at f/1.8 on full-frame cameras, and 
it combines impressive bite with exquisite 
bokeh, minimal fringing and negligible 
distortion. The optical stabiliser can be very 
useful, although the faster Nikon AF-S 85mm 
f/1.4G just about has the edge for all-round 

image quality. By comparison, the 
performance of Canon’s top-flight EF 85mm 
f/1.2L II USM is a little lacklustre, with very 
sluggish autofocus and comparatively high 
longitudinal chromatic aberration or ‘bokeh 
fringing’. The Sigma 85mm f/1.4 EX DG HSM 
is also a little worse than average for bokeh 
fringing, but it’s great value at its relatively 
inexpensive asking price.

The Fujifilm XF56mm f/1.2 R APD is a 
super lens for APS-C format portraiture, 
combining a very wide aperture with its crafty 
apodisation filter for boosting the quality of 
bokeh. Even so, when you want a really tight 
depth of field, it can’t compete with an 85mm 
f/1.4 or f/1.8 lens on a full-frame camera. The 
same goes for the versatile Canon and Nikon 
70-200mm zoom lenses. 

S

 BUIld & handlIng 

 PerFormance

 ValUe 

 FeatUres 

 oVerall 

Canon EF 
70-200mm f/2.8L 
IS II USM

Canon EF 85mm 
f/1.2L II USM

Fuji XF56mm f/1.2 
R APD

Nikon AF-S 
70-200mm f/2.8G 
ED VR II

Nikon AF-S 85mm 
f/1.4G

Sigma 85mm f/1.4 
EX DG HSM

Sony FE 85mm 
f/1.4 G Master

Tamron SP 85mm 
f/1.8 Di VC USD

Contact www.canon.co.uk www.canon.co.uk www.fujifilm.
co.uk

www.nikon.co.uk www.nikon.co.uk www.sigma-
imaging-uk.com

www.sony.co.uk www.tamron.
co.uk

Street price £1,500/$2,000 £1,500/$2,000 £875/$1,500 £1,800/$2,100 £1,200/$1,600 £620/$900 £1,500/$1,800 £750/$750

Mount options S

Elements/Groups 23/19 8/7 11/8 21/16 10/9 11/8 11/8 13/9

Diaphragm blades 8 blades 8 blades 7 blades 9 blades 9 blades 9 blades 11 blades 9 blades

Autofocus type Ultrasonic 
(ring-type)

Ultrasonic 
(ring-type)

Stepping motor Ultrasonic 
(ring-type)

Ultrasonic 
(ring-type)

Ultrasonic 
(ring-type)

Stepping motor Ultrasonic 
(ring-type)

Manual AF override Full-time Full-time Full-time Full-time Full-time Full-time Full-time Full-time

Min focus distance 1.2m 0.95m 0.7m 1.4m 0.85m 0.85m 0.85m 0.8m

Max magnification 
factor

0.21x 0.11x 0.09x 0.12x 0.12x 0.12x 0.12x 0.14x

Minimum aperture f/32 f/16 f/16 f/22 f/16 f/16 f/16 f/16

Optical stabilizer Yes No No Yes No No No Yes

Filter size 77mm 72mm 62mm 77mm 77mm 77mm 77mm 67mm

Weather-seals Yes No No Yes Yes No Yes Yes

Included accessories Hood, soft case, 
tripod collar

Hood, pouch Hood, cloth, ND8 
filter

Hood, soft case, 
tripod collar

Hood, pouch Hood, pouch Hood, soft case Hood

Dimensions (DxL) 89x199mm 92x84mm 73x70mm 87x201mm 87x84mm 86x88mm 90x108mm 85x91mm

Weight 1,490g 1,025g 405g 1,540g 595g 725g 820g 700g
   

EF EF FXFXX EEF FX A EF FX AK SA

how the 
Lenses 
comPare
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Micro-TEST K i t  Z O N e

Keep your photos and videos mobile without sacrificing storage or speed

POrtaBle DriVeS

 OVerall   OVerall   OVerall  

w w w. s e a g a t e . c o m

Seagate Backup Plus 
Ultra Slim 2tB

£95/$130

Seagate claims that this 9.6mm design is 
the world’s thinnest 2TB mobile hard 
drive. It looks the part too, and transfers 
images and video at a respectable rate, 
despite using a traditional hard drive.

w w w. d e l k i n d ev i c e s . c o m

Delkin Devices 1tB 
rhinoDrive
£400/$400

With its rubberised casing and silicone 
bumper, the RhinoDrive offers ultimate 
shock protection. It’s far from sleek, 
though, and the SSD within can’t match 
the cheaper Samsung drive for speed.

WD’s compact contender is narrowly 
beaten into last place here for speed, but 
it’s well-priced and includes extensive 
back-up and drive encryption software. 
Even so, it’s an average overall package.

w w w. wd . c o m

WD my Passport  
Ultra 1tB
£58/$60

 OVerall   OVerall   OVerall  

w w w. g - t e c h n o l o g y . c o m

g-technology 1tB 
g-Drive ev atC

£113/$130

This toughened drive is protected by 
a crush-, dust- and shock-resistant 
compartment that also has a built-in USB 
cable. Using a conventional hard drive 
keeps the cost down, but it’s no slouch.

w w w. s a m s u n g . c o m

Samsung Portable SSD 
t3 500gB
£150/$180

At 74 x 58 x 10.5mm, this svelte metal-
shelled SSD is the smallest and lightest 
drive here. It also boasts winning 
performance, outpacing the Delkin SSD 
while still being shock-resistant.

w w w. t r a n s c e n d - i n fo . c o m

transcend StoreJet 
25m3 2tB

£80/$183

The plasticky StoreJet doesn’t ooze 
quality, but it’s shock-resistant to military 
standards. Transfer speeds are the 
fastest on test for a hard drive, and with 
2TB of storage you get incredible value.
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MINI-TESTK i t  Z O N e

Six backpacks that’ll transport your camera kit and much more

1

w w w. m i n d s h i f t g e a r. c o m

mindshift rotation180° 
Panorama 22l

£162/$200
 
Camera backpacks don’t often amaze 
us, but this bag is quite something. 
It retains the traditional daypack design, 
comprising a versatile top compartment 
and removable camera pod below. But 
this is designed to be pulled out from the 
side of the bag and rotated around your 
waist while held securely by the attached 
hip belt. It’s a terrific example of logical 
thinking that works a treat and 
revolutionises on-the-go access.

The only downside is there’s 
only enough space in the camera 
compartment for a body and attached 
lens, plus one other lens and maybe a 
flashgun. The split design also rules out 
a laptop slot, but this bag’s designed for 
the trail, where the three-litre hydration 
pack pocket and comfortable back and 
shoulder padding are more important.

It’s not suited to transporting a lot of 
camera kit or a laptop, but this bag comes 
a very close second to the Lowepro.

2 3

travel bags

 Overall   Overall   Overall  

w w w. l owe p ro . c o m

lowepro Fastpack bP 
250 aW ii
£120/$130

THIS bag has enough space in its lower 
half for a full-frame body and attached 
lens, plus two or three extra optics and 
accessories. What’s more, the clever 
wraparound flap can be partially opened 
for on-the-go side access, or peeled all 
the way back to reveal your lenses.

There’s a spacious top compartment 
for travel essentials, and you can bring 
both a 15-inch laptop and a tablet along 
for the ride. That all adds up to some 
serious weight, but supple straps, 
generous pack padding and a large 
hip belt really lighten the load.

Factor in the reassuringly thick gear 
padding, the built-in rain cover and useful 
accessory pockets, and the Fastpack 
shapes up as a superb all-rounder.

This bag has a versatile, well designed 
camera compartment with on-the-go 
access, but it’s not suited to big full-frame 
optics. It’s a high-quality bag that’s an 
almost faultless travel companion.

w w w. m a n f ro t t o . c o m

manfrotto advanced 
rear access camera 
and laptop backpack 

£120/$160
 
If you’re more used to travelling in the 
city than in the country, Manfrotto’s 
smarter styling will help you look the 
part. It conceals a good-sized laptop slot, 
although this is at the front of the bag – 
furthest away from your back, where it’s 
least comfortable. It has to be located 
here because the rear panel is used to 
access the large camera compartment 
that’ll swallow a 70-200mm f/2.8, plus 
a body and two or three extra lenses. 

The upper daypack space isn’t 
especially large, but you can stash 
personal effects in some spacious front 
and side pockets. You’ll want to travel 
fairly light, though, due to the stiff 
shoulder straps and basic hip belt.

Although it’s tricky to access 
quickly and the straps could be more 
comfortable, it’s a great bag if subtlety 
and security matter more to you than 
convenient access.

Great  

ValueHHHHH
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MINI-TEST K i t  Z O N e

w w w. g e o g r a p h i c b a g s . c o m

National geographic 
africa medium 

rucksack
£129/$90

 
aT first glance, this backpack has a lot 
going for it. The retro design is stylish yet 
understated, and there are some nice 
details like buckle straps. But its appeal 
soon wears off when you’re in the field, due 
to the hard, uncomfortable back padding.

At least you won’t have much to carry, 
though: the bag’s shallow depth restricts 
space in the upper daypack compartment 
and also the camera section beneath. The 
latter is entered via a front flap, but this 
hinges upward, completely ruling out any 
access while on the move. And just for 
some added annoyance, the flap has 
a tendency to spring closed.

You do get plenty of extra pockets and 
a well-placed rear slot for a 15-inch laptop, 
but some of the front pockets have limited 
use. Although it’s well-priced, the size, 
internal layout and accessibility all 
frustrate, as does the hard padding.

w w w. t h i n k t a n k p h o t o . c o m

think tank  
trifecta 10

£130/$160

 
WHere most travel backpacks are 
tailored towards APS-C camera kits, 
the Trifecta 10 is a no-compromise 
design built to carry bulky full-frame 
gear. It’ll easily accommodate a 5DS or a 
D810 with a 70-200mm f/2.8 attached, 
plus two sizable f/2.8 optics alongside, and 
32 x 49 x 17.5cm exterior dimensions. Your 
gear will be well-protected too, thanks to 
Think Tank’s rugged build and superb 
interior padding. That extends to the 
outside, where your shoulders and back 
are sumptuously cossetted.

Things aren’t quite perfect: the small 
upper compartment won’t store many 
personal effects. There is a tablet slot, 
though, and a tripod can be strapped 
to the front, out of the way of large side 
openings that keep kit within easy reach.

With tough construction, this is very 
comfortable and great for large lenses.  
It’s a top-quality yet keenly priced bag for 
serious camera set-ups.

w w w. v a n g u a rd wo r l d . c o m

vanguard  
Havana 48

£80

 
WITH its cavernous upper section, the 
Havana 48 is more a daypack than a 
photo backpack, but it does contain 
a useful camera compartment that 
helpfully hinges out as you open the 
front access flap. Inside there’s enough 
room for a small SLR and a couple of extra 
lenses, although the space isn’t the most 
practical shape or particularly easy to 
divide. It’s effortlessly removable, though, 
as is the bag’s centre divider, leaving you 
with a normal backpack.

Plenty of smaller front and side pockets 
give ample accessory storage, while a 
tripod will stow on the side and a 15-inch 
laptop can nestle at the back. There’s 
protection from the elements courtesy 
of an included rain cover, but the bag’s 
lightweight materials and limited padding 
don’t offer much kit protection.

This is an attractively designed bag that 
works well as a daypack – just don’t try to 
carry too much camera kit.

4 6

 Overall   Overall   Overall  

5

What to look for in a traVel BaG
It’s all very well splashing out on a 
dedicated camera backpack that’ll store 
all your photography gear, but a bag of 
this type isn’t ideally suited to prolonged 
periods off the beaten track. Here you’ll 
be better off with a bag that’s got more 

of a split personality. Travel-orientated 
photo backpacks still let you carry 
essential camera kit, but also offer 
enough space for clothes and food.

Getting the right balance of camera 
versus daypack storage isn’t easy, so 

we’ve selected six bags with varied 
layouts and capacities. Most will still 
swallow a full-size laptop, though, and all 
have mounting points for a tripod. What 
really separates the best from the rest, 
however, is ease of access.
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When there’s too much difference 
in contrast between the sky  
and the ground in your shot, 
Lightroom has the solution…

Sean 
McCorMaCk 

Photographer 
and writer

Sean McCormack  
is an experienced 
photographer and 
writer based in 
Galway. He is the 
author of The 
Indispensable Guide 
to Lightroom CC.  
seanmcfoto.com

SoFTWare Lightroom CC/6  GeT IT FroM www.adobe.com

GeT STarT FIleS FroM www.bit.ly/dc179files

HEN you shoot landscapes, you’ll 
see that the sky in your photos is 
often much brighter than the 

ground. Traditionally, experienced landscape 
photographers use graduated neutral density 
filters, which have a tinted top with a clear 
bottom, in front of the lens. They’re usually 
measured in exposure reduction, so you’ll see 
one-stop graduated neutral-density filters for 
example. The tint looks grey on these, so they 
don’t change the colour in the sky. 

These filters still have a place in digital 
photography to get the best look in-camera, 
but Lightroom allows you to recreate these 
filters digitally, with more options than 
reducing exposure or colour in the sky. 

W

lightroom

Fix your skies  
with ease  
in Lightroom 

2 get the look
Click above the 

skyline and drag down 
until you’re below it. If 
you want a hard line on 
the horizon, only drag a 
short distance. For a 
softer look, drag much 
further. To keep the 
filter straight as you 
drag, hold the Shift key. 
To change position, click 
and drag the pin.

3 dehaze slider
For the skies, you should start with the Dehaze slider. This removes the haze, but at the same time 

increases contrast and saturation. It also darkens the area it works on, which is why it’s good to use 
before or instead of changing exposure. I’ve gone for 30 here.

1 graduated 
filter

Open the Graduated 
Filter from the 
Toolstrip under 
the Histogram in 
Develop. You can also 
use the keyboard 
shortcut M. If you 
need to reset the 
current settings, 
double click on the 
Effect text. 

BE
FO

RE

 
DownloaD the viDeo

 www.bit.ly/ 
dc179extra

watch  
viDeo  
www.bit.ly/ 
dc179video
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Built-in Brush Tool Fix what’s above the horizon line

The Graduated Filter is a linear tool, so 
anything that’s above the horizon will 
take on the effects you apply to the sky. 
Lightroom has a fix for this: in the Mask 
section, select Brush. From the Brush 
section that appears, select the Erase 
brush. Change Size and Feather to Taste. 
Generally I leave Flow and Density at 100.

Auto Mask should be on if the part you 
want to remove has hard edges. To make 

the Mask (the area where the Grad is 
working) more visible, press O to show 
a red overlay.

Use the Erase brush to remove the mask 
off the area you need to bring back. In this 
image, I’m clearing the mask off the pier to 
bring it back to normal. It’s great for 
bringing foreground elements back to 
where they were before you applied the 
Graduated Filter.

6 contrast
There a few 

other options 
worth using. 
Tweak Sharpness 
to better define 
the clouds (+15); 
view the image at 
1:1 when changing 
this. Increase 
Clarity (+30) to 
boost local 
contrast. You may 
want to have a go 
at adjusting 
Contrast too.

4 exposure
If Dehaze has 

darkened too much, or 
if you prefer the sky 
darker, go to Exposure 
and change to get what 
you want. For this 
image, I increased 
the exposure subtly 
(+0.25) to bring better 
balance to the sky. 
(The original image did 
use a real ND grad filter 
but it wasn’t strong 
enough. Dehaze has 
darkened it too much.)

5 highlights
If there’s a lot of 

cloud, you can pull the 
Highlights slider down 
to stop them being 
too bright. Don’t be 
afraid to go the whole 
way down – you can 
always go back!

EXPERT
TIP

D i g i ta l  Da r k ro o m
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Lightroom skiLLs



Discover how to control the Magic  
Wand – one of Photoshop’s most useful 
tools – and learn how to make complex 
selections in a matter of seconds

balance out a  
scene with the  
Magic wand toolJAMES 

PATERSON 

Editor, Practical 
Photoshop

With a decade as a 
working writer and 
photographer behind 
him, James knows 
exactly which 
Photoshop and 
Lightroom tools and 
techniques matter 
the most to you.

SOfTwARE Photoshop CC  GET iT fROM www.adobe.com

GET START filES fROM www.bit.ly/dc179files

Photoshop

Select the Sky
Right-click the layer and choose New 

Smart Object Via Copy. Grab the Magic Wand 
tool, tick Contiguous then Shift-click over 
the sky until selected. Go to Layers Panel > 
Add Mask, double-click the layer thumbnail 
to re-open in Camera Raw, process the 
image to enhance the sky, then click Done.

step by step EnhancE a sky

Improve the toneS
You can use the Magic Wand in 

combination with Camera Raw and Smart 
Objects. First right-click the image in 
Bridge and choose Open In Camera Raw, 
then adjust the tones in the Basic Panel to 
improve the foreground. Don’t worry about 
how the sky looks for now. Once done, hold 
Shift then click Open Object.

1

2

BE
FO

RE

Improve a dull sky by adding  
a touch of drama to it...

 
DownloaD thE viDEos

 www.bit.ly/ 
dc179extra

watch  
viDEos  
www.bit.ly/ 
dc179video
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Select the opposite
Do the reverse of what you want, then invert it

Sometimes it’s easier and quicker 
to select the opposite of what you 
want and then invert it, particularly 
if the subject is against a uniform 
backdrop [1]. This works especially 
well for cutting out portraits.
Simply set the Magic Wand to 
Contiguous [2]. Use a low Tolerance 
setting of around 20-30, then 
Shift-click a few times around the 
background until it’s all selected. 

Once done, go to Select > Inverse 
(or press Ctrl/Cmd+Shift+I) [3] to 
select the subject instead. Then 
you can go on to use Refine Edge 
[4] to fine-tune it. 

Once the selection is as precise 
as possible, click the Add Layer 
Mask icon [5] to convert it to a 
Layer Mask [6]. Everything but the 
selected area will be hidden behind 
the mask.

EXPERT
TIP

1

2

5

6

3
4

The Magic Wand
One of Photoshop’s oldest and 
most useful selection tools, the 
Magic Wand, works by seeking 
out similar tones and colours. 
It’s found in the Tools Panel 
alongside the equally useful 
Quick Selection tool. Simply click 
over a point in your image and 
the tool will select similar pixels, 
making it easy to select large 
expanses of tones or colours.

Refine edge
All selection tools will 
initially create very 
hard-edged selections 
(even with Anti-Alias 
ticked). Most objects in 
real-world photos have 
softer edges, so it’s 
worth taking the 
selection through the 
Refine Edge command 
to improve it. You can 
use Radius to expand 
the ‘search area’ along 
the edge, or Feather to 
soften it slightly.

add, SubTRacT, inTeRSecT
When you use the Magic 
Wand – or any selection tool 
– you’ll see these four icons to 
the top left. Toggling each on 
or off will allow you to add to a 
selection, subtract from it or 
intersect. However, in this 
case it’s always easier to use 
keyboard shortcuts: hold Shift 
to add, hold Alt to subtract, and 
hold both Shift+Alt to intersect.

PhotoshoP anatoMy

SaMple Size
This drop-down lets you control how the tool samples pixels. You 
can set it to either sample a single pixel with Point Sample, or take 
an average reading from a larger area of 3 x 3 pixels, 5 x 5 and so on. 
Imagine it as either pointing with a needle, a finger or a fist.

Tool school D i g i ta l  Da r k ro o m
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conTiguouS
Tick Contiguous and the 
tool will only pick up 
pixels connected to the 
first point you click over. 
Untick it and the tool will 
search image-wide for 
similar colours. Here, 
with Contiguous 
unticked, the tool finds 
both the larger and 
smaller orange circles, 
while with Contiguous 
ticked it will select each 
one individually.

ToleRance
The Tolerance setting controls how inclusive the tool is of different 
shades of colour. With Tolerance below 100, the Magic Wand 
includes only one of the coloured circles here. Between 100-200 
it finds two, and above 200 it selects all three at once.



Discover three different methods to 
bring out the surface detail in your 
photographs and give your images 
a professional movie poster look! 

EnhancE all thE 
important dEtails 
with photoshopGLYN DEWIs 

Photographer  
and author

Glyn is a commercial 
photographer and 
retoucher, and is 
also an Adobe 
Community 
Professional trainer. 
He is the author of The 
Photoshop Workbook. 
www.glyndewis.com

sOFTWARE Photoshop CC GET IT FROM www.adobe.com  

GET sTART FILEs FROM www.bit.ly/dc179files

Photoshop

or this tutorial, I want to take 
you through three different 
techniques for giving your 

photographs much more detail and 
lending them a gritty feel. This 
particular look is incredibly popular 
in the movie industry these days, and  
you’ll no doubt see it being used a lot to 

create movie posters and other film-
associated artwork.

Now, I’m a big believer in knowing a 
variety of techniques to produce similar 
results. This is because every picture is 
different. Because of this, the same 
technique will likely not work on every 
picture and may well produce different 

results. Knowing a variety of techniques 
means you’ll always be able to achieve the 
look you want.

In the tutorial that follows, I’ll take you 
through a technique that uses filters 
within Photoshop, but I’ll also touch on 
two third-party plug-ins that I sometimes 
call on too. 

F
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AFTER

 
DownloaD the viDeo

 www.bit.ly/ 
dc179extra

watch  
viDeo  
www.bit.ly/ 
dc179video
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Surface Blur works well in a lot of photos you’ll 
use this effect for, but don’t apply too high an 
amount as it can introduce haloes and artefacts 
into your pictures, especially if they have lots 
of shadow areas. I typically use Radius and 

Threshold settings of 35 or lower, and I usually 
apply the same strength to both settings.

In practice, the Surface Blur technique 
doesn’t work brilliantly with our tutorial photo, 
probably because of the high proportion of 
shadows and dark areas. Even using my 
preferred settings, you can see artifacts 
appearing in the hat rim and some halo-ing 
becoming apparent around the hat and suit.

EXPERT
TIP

Set up a layer group
Open the start image. Create 
two copies by pressing Ctrl/
Cmd+J twice. Click the upper 
layer and Shift- click the layer 
below so both copies are 
selected. Go to Layer > New > 
Group from Layers. Name the 
group ‘Details’, set the Blend 
Mode to Soft Light and click OK.

mETHOD 1: photoshop

aDD SurFaCe Blur
Convert the layer to a Smart Object 
by going to Filter > Convert for Smart 
Filters. Add the details by going to 
Filter > Blur > Surface Blur. In the 
Surface Blur properties, set the Radius 
and Threshold settings to the same 
number. I find that settings not 
exceeding 30 produce the best results.

prepare tHe IMage
Click the triangle icon for this group  
to open it and reveal the two layers 
inside. Change the Blend Mode of the 
uppermost layer in the group to Vivid 
Light. On the same layer, go to Image 
> Adjustments > Invert: this seems to 
restore the picture to how it originally 
appeared, but the image has now 
been set up to enhance details.

CoNtrol tHe eFFeCt
To limit where and how strongly the 
details are applied, close the Details 
group by clicking the triangle icon, as 
before, and Option/Alt-click the layer 
mask icon to add a black layer mask. 
Then, with a white medium soft-edged brush, paint over 
the image to reveal the details. Use a lower-opacity brush 
when painting over the skin as opposed to the clothing.

1

3

2

4

too muchBefore

Handle with care
Photoshop’s Surface Blur is a 
great tool, but don’t go too mad!

artist insight D i g i ta l  Da r k ro o m
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ClICK aND tWeaK
From the Presets list, choose Detail Extractor. The default 
settings are immediately applied. You can have a go at 
experimenting with them to see what you prefer. Click OK. 
Because the details have been applied to the entire picture, 
click the white layer mask attached to the filter in the layer 
stack and then go to Image > Adjustments > Invert to 
change it to black.

paINt IN tHe DetaIl
With a white medium soft-edged brush, paint over the image 
area to reveal the details. Use a lower-opacity brush when 
painting over the skin as opposed to the clothing. You can 
see it enhances the details and information incredibly. Unlike 
the previous technique, it creates few artefacts and haloes.

aDjuSt tHe DetaIlS
With the image open in Photoshop, go to Filter > 
Convert for Smart Filters, then Filter > Topaz 
Labs > Topaz Detail 3. Adjust the Small Details, 
Small Details Boost, Medium Details, and 
Medium Details Boost settings, with the upper slider 
increased to the right the most, and less for the others, to 
produce an arc. Click OK. Invert the mask and paint over it.

DetaIlS extraCtor
I’m using the latest version of Nik Color Efex Pro 4, which 
includes a preset called Details Extractor. I’m a big fan of 
this plug-in – not just because of the results but also 
because it allows me to work non-destructively. Starting 
from the beginning, with no layers other than the original 
image, go to Filter > Convert for Smart Filters, and then 
to Filter > Nik Collection > Color Efex Pro 4.

Three  
of a kind
Each of these three 
techniques suits 
different types of photo 
better – try them all!

For this shot, my favourite result 
came from Topaz Detail. The 
results it produces are quite 
different from the other two 
techniques, and add a slight 
textured effect. This plug-in 
gives great results but needs 
to be used sparingly on skin.
For this particular image, Topaz 

Detail has produced the best 
result because it enhances 
detail while maintaining the 
original darkness of the suit. 
Whichever method you use, 
always increase the 
magnification to 100% before 
you start apply the effect so you 
can see what’s really going on.

5

7 8

6

mETHOD 2: niK collEction

mETHOD 3: topaZ dEtail
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Create your own brushes

Photoshop offers a huge range of brush tips 
within the Brush Picker, and there are thousands 
more available free of charge online. But if you 
want something special, why not make your 
own? It’s very easy.

All you need to do is select something, then 
go to Edit > Define Brush. Any white parts will 
be transparent, so it works best when you can 
isolate a shape against a white backdrop.
Take, for example, the ink splat brushes used 

EXPERT
TIP

From watercolours to oil paintings, 
sketches and splash effects, discover 
four ways to create brush-based art 
from your photos in mere minutes

Transform your 
favouriTe porTraiTs 
inTo painTingsJAMES 

PATERSON 

Editor, Practical 
Photoshop

With a decade as a 
working writer and 
photographer behind 
him, James knows 
which Photoshop and 
Lightroom tools and 
techniques matter 
the most to you.

SOFTWARE Photoshop CC GET IT FROM www.adobe.com

GET START FIlES FROM www.bit.ly/dc179files

Photoshop

When pre-existing brushes can’t do the job, it’s easy to make your own...

in tip 3 (which you can download via www.bit.
ly/dc179extra). To make these, we dropped 
ink on a piece of white paper, then 
photographed it. After converting to mono 
and boosting contrast, we made a rough 
selection around each spot with the 
Polygonal Lasso Tool, then went to Edit > 
Define Brush and gave our new brush 
a name. Any new brushes appear in the 
Brush Picker at the end of the list.
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DownloaD the viDeo

 www.bit.ly/ 
dc179extra

watch  
viDeo  
www.bit.ly/ 
dc179video
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Use splatter brUshes
Add a Black and White layer then 
a Levels layer, and squeeze in the 
whites and blacks. Make a new 
layer, grab the Gradient Tool, and 
choose a colourful preset. Make 
a gradient and set the Blend 
Mode to Overlay. Add a layer filled 
with white. Grab the Brush Tool 
and load the free splash brush set 
from www.bit.ly/dc179extra. Add 
a Layer Mask and paint with black 
to gradually reveal the face. Add 
a Posterize Adjustment Layer.

paint with patterns
Go to Edit > Define Pattern and 
save. Duplicate the layer, press D 
then go to Filter > Filter Gallery > 
Sketch > Photocopy. Set the 
Blend Mode to Multiply and erase 
any messy parts. Make two new 
layers below the photocopy layer. 
Fill the lower one with light brown. 
(Try #dbc5b8.) Select the upper 
one and grab the Pattern Stamp 
tool. In the options, target the new 
pattern, choose a bristle brush tip 
and tick Impressionist, then paint.

Make a watercoloUr
Go to Filter > Camera Raw Filter > 
Details. Set Noise Luminance to 
100, Luminance Detail to 20. Add 
a layer; fill with off-white. Drag 
the lower layer to the top; add a 
Layer Mask. Grab the Brush Tool, 
load the Wet Media set and pick 
a tip. Paint the edges black. Add 
a Posterize Adjustment Layer 
(40 levels). Add a Pattern Fill 
layer; choose Extra Heavy 
Canvas. Make the Blend Mode 
Soft Light with 60% Opacity.

3

2

4

Get the oil paintinG look
Duplicate the background, then 
go to Filter > Stylise > Oil Paint. 
Set Stylisation, Cleanliness and 
Bristle Detail to 10, Scale 1.6, 
untick Lighting and click OK. 
Press Ctrl/Cmd+F to run again. 
Go to Filter > Nik Collection > 
Color Efex Pro. (Download it at 
www.google.com/nikcollection.) 
Use the Detail Extractor filter to 
pull out detail. Add a Color Lookup 
Adjustment Layer, choose Foggy 
Night and set Opacity to 50%.
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Prefer print? 
Keep your 
mags together 
with our binder, 
which neatly 
holds a year’s 
worth of issues

All-new 196 pages to 
help you shoot perfect 
portraits. Easy-to-follow 
guides and techniques, 
published in a handy 
compact format

the digital advantage 
your digital magazines can travel with you – even if you 

delete them, they’re free to re-download at any time

 www.myfavouritemagazines.co.uk/photo  www.myfavouritemagazines.co.uk/photo

Binders for your print issues ON Sale NOW
Camera Bag 
essentials Vol 3

Available onapple iPad, iPhone 
or iPod touch

Get the free Digital Camera 
app for your iPad or iPhone at 
www.bit.ly/DC_app (UK) or 
www.bit.ly/DCW_app (the 
rest of the world), then 
browse through our back 
issues or buy a subscription 
using the app.
 
android, PC or mac

Zinio:  
www.bit.ly/DCW_Zinio
Google Play:  
www.bit.ly/DCW_GoogleP 
 
Other options

Digital Camera is available for 
Kobo, Kindle, Nook, Windows 
8 and more. Check out all of 
our partners in the column 
on the right of this page.
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Issue 169   October 2015
Take your best shots ever as we explain 
how to make the most of your camera’s 
Raw setting / Fast prime lenses on test / 
Free Teach Yourself Photoshop 50-video 
training course (DVD with print edition; 
online video with digital editions)

Issue 171   December 2015
Master the art of composition with tips 
and techniques from pro photographers 
/ Flashgun basics / Patrick Ward in 
conversation / 10 videos  / Restore Old 
Photographs ebook / Free 2016 calendar 
full of iconic photography

Issue 172   January 2016
Take our photography crash course and 
master the basics today! / Budget SLRs 
and CSCs on test  / Terry O’Neill’s classic 
celebrity photos / 30 photo inspiration 
cards / Please note that the Sleeklens 
presets offer in this issue has now closed

Issue 173   February 2016
Explore our 52 photo projects and stay 
creative all year long! / Dedicated 
flashguns on test / Lottie Davies inspires 
in our interview / How to win a photo 
contest / Sony Alpha 7S II on test / Nine 
tips cards / Photoshop layers ebook

Issue 174   March 2016
Master new skills / Creative street 
photography guide / Chris Packham 
interview / Slimbridge wildlife shoot / 
35mm primes on test / Focusing basics / 
Nine tips cards / Levels & Curves ebook /
Giant Photoshop Elements ebook

Issue 175   April 2016
Night photography skills and gear / 
telephoto zooms on test / Alec Soth 
interview / Aperture basics / 2016 Digital 
Camera Awards / Nine ways to light a 
potato / 34 Amazing Photo Tricks ebook 
/ Nine tips cards / 11 videos

Issue 176   Spring 2016
Shoot beautiful landscapes with our 
massive guide / Nikon D7200 vs Canon 
EOS 70D / Shutter speed basics / Studio 
lighting kits / Martin Middlebrook / Lara 
Jade / Darkroom Effects ebook / Nine 
landscape tips cards /Nine videos

Issue 177   May 2016
Stuart Freedman on how to put together 
a photo essay / How Matilda Temperley 
mixes fashion and documentary / 
Coastal landscape advice / Image-
editing software on test / Montage ebook 
/ Nine tips cards / 10 expert videos

Issue 178  June 2016
Time for adventure in our travel special, 
with tips, inspiration and journalism / 
Travel cameras and tripods on test / 
Inside cruise ship photography / 
Lightroom ebook / Nine tips cards / 
Creative Camera Skills: 30 videos! 

Issue 170   November 2015
Shoot stunning landscapes as five pros 
reveal their processes and Chris Rutter 
shares his skills / Wide-angle primes on 
test / David Alan Harvey / Free Outdoor 
Landscape & Nature Photography and 
Secrets of Layers ebooks

Issue 167   August 2015
Master new camera skills as seven top 
pros and past masters introduce you to 
the practice of Zen photography / Meet 
Paul Hill and Chris Leslie / Fun lenses for 
retro effects on test / Free Master 
Photoshop in a Day ebook

Issue 168   September 2015
Unleash your lenses with our guide to 
getting better shot from your glass / 
Super telephoto zooms on test / Canon 
5DS R vs Nikon D810 / Please note that 
the DxO FilmPack 3 free software offer 
in this issue has now closed
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hich photographer (living 
or dead) would you like to 
have round for dinner?
Roger Fenton – to 

understand what it was like to 
make the first photos.

What’s your favourite place on earth?
The Derbyshire Peak District, although 
Yosemite really impressed me.

What is on your memory card?
Images from when I was volunteering 
with refugees in Greece; some from 
New York, where I exhibited in April; 
and a few New England landscapes.

Who would you most like to thank 
for getting you where you are today?
Brian Randle, who helped me get my 
first photographic job with the 
Birmingham Mail when I started 
freelancing. Also, my late wife Angela, 
who was very involved in setting up 
the workshops we started in 1976.

Tell us a secret about your 
photography that you haven’t 
told anyone before?
When I was given my first assignment 
as a freelancer, I’d never processed 
film on my own before. I winged it!

To crop or not to crop?
I prefer to orchestrate things in the 
viewfinder if I can, but I’m not precious 
about cropping.

What features at the top of 
your bucket list?
To do a show drawn from the material 
in my archive.

What’s in your kit bag right now?
I use small cameras, so the iPhone 
and a Panasonic Lumix. I don’t need 
a camera bag anymore.

Which book should every 
photographer read?
Apart from mine? Beauty in 
Photography by Robert Adams  
and Photography: Key Concepts 
by David Bate.

Whose work do you most admire?
Bill Brandt.

How many pictures do you shoot 
on an average project?
Very few, even when out in Greece 
photographing the refugees as things 
started to kick off on the Macedonian 
border. I hate waste, which I think 
must come from my film background. 

Talking once to Josef Koudelka, 
I worked out that he shot more film 
in one month than I probably would 
in my entire life!

Any words of wisdom for aspiring 
professionals out there?
Be different. Try not to press the 
shutter if you’ve seen the picture in 
the viewfinder before. And hard work 
doesn’t guarantee success, but 
persistence does.

Do you have any unfulfilled 
photographic ambitions?
No. I tend to wait for photographs to 
find me. I’m reactive, and I don’t want 
to do what everyone else has done.

What is your desert island D-SLR?
My iPhone.

Approaching Photography 
by Paul Hill is published by 
Photographers’ Institute Press. 
Prints from Paul Hill and Maria 
Falconer’s recent trip to Greece 
are on sale now at  
www.mariafalconer.co.uk/
prints.html with the proceeds 
being donated to voluntary 
groups out there.

Veteran documentary and 
landscape photographer

Paul Hill, MBE

DESERT 
ISLAND 
D-SLR

www.hillonphotography.co.uk
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Visit www.digitalcameraworld.com for more great photo tips 

Your exclusive digital camera wedding photographY cards

    wedding group portraits

    wedding incidentals

   bride & groom: first dance

    bridal portraits

    wedding ceremony

    bride & groom

    the reception    the ceremony    the preparations

WEDDING SHOT PLANNER 1 WEDDING SHOT PLANNER 2 WEDDING SHOT PLANNER 3



the preparations 

uSE THIS cHEckLIST TO mAkE SuRE 
yOu NEVER mISS THE kEy SHOTS

   The bride getting ready: 
  Wedding dress on a hanger 
  Wedding dress embroidery details 
  Bride’s shoes 
  Bride’s jewellery 
  Wedding bouquet 
  Hair being styled 
  Make-up being applied 
  Reflection of bride in make-up mirror 
  Dress  being laced or zipped up 
  Bride in her dress – full-length

   At the wedding venue: 
  Flower displays  
  Orders of service 
  Groom and ushers – wide shot 
  Groom and ushers – head shots 
  Groom’s cufflinks, flowers and shoes 
  Venue details (eg, church gargoyles) 
  Guests arriving

the ceremony 

uSE THIS cHEckLIST TO mAkE SuRE 
yOu NEVER mISS THE kEy SHOTS

   Before: 
  Groom waiting for the bride 
  Bride and father in wedding car 
  The arrival of the bride 
  Bride walking down the aisle 
  First glance between the bride and groom 
  The father giving the bride away 

   During: 
  Wide shot of the venue’s interior 
  Candid portraits of parents 
  Candid portraits of other guests 
  Vows 
  Exchange of rings 
  First kiss

   After: 
  Bride and groom walking down the aisle 
  Bride and groom kissing outside 
  Bride and groom showered in confetti 
  Bride and groom in wedding car

the reception 

uSE THIS cHEckLIST TO mAkE SuRE 
yOu NEVER mISS THE kEy SHOTS

   People: 
  Bride and groom – full-length 
  Bride and groom – half length 
  Bride and groom – close-up of the rings 
  Bride by herself – full-length 
  Bride by herself – half-length 
  Bride by herself – head shot  
  Full group shot showing venue 
  Smaller requested groups

   Incidental shots: 
  Reception venue exterior/interior 
  Wedding cake table and cake details 
  Candids of bridesmaids and guests  
    Venue details – centrepieces, place 
settings, champagne glasses

   Events: 
  Speeches and toasts 
  Cake-cutting 
  First dance Im
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WeDDinG pLanner 3 WeDDinG pLanner 2 WeDDinG pLanner 1

WeDDinG inciDentaLs

FOR yOuR FIRST SHOT, TRy...

Exposure mode� aperture priority

Aperture� f/2.8-8

Shutter speed automatically set

ISO� auto

TO ImPROVE yOuR SHOT…
   Look for images that help to tell the story 
of the day: hats, flowers, children playing, 
architectural details, etc. 

   For close-up details, use a macro lens and 
keep to a mid-range aperture such as f/8 .

   Ask to move items such as shoes and rings 
into as much natural light as possible.

top tip: Take a small reflector – it will be 
as handy for removing shadows in close-up 
shots as it is for portraits on the day.

first Dance

FOR yOuR FIRST SHOT, TRy...

Exposure mode� aperture priority

Aperture� f/2.8-f/4

Shutter speed automatically set

ISO� 400-3,200

TO ImPROVE yOuR SHOT…
   If the room is well-lit, you can increase 
the ISO and go for ambient mood.

   If you have to use flash, use two or three 
off-camera flashguns positioned on light 
stands and trigger them wirelessly.

    Recruit a friendly waiter to help you test the 
dance floor exposures during the meal.

top tip: Try a slow-sync flash shot – get 
in close, use a shutter speed of 1/4 sec and 
move the camera after the flash fires.

briDaL portraits

FOR yOuR FIRST SHOT, TRy...

Exposure mode� aperture priority

Aperture� f/2.8-f/5.6

Shutter speed automatically set

ISO� 200-800

TO ImPROVE yOuR SHOT…
   Background distractions are everywhere – 
take a good look around before shooting.

   Start with a wide, full-length shot before 
moving in for 3/4-length and head shots.

   Use continuous drive mode, asking the 
bride to change her pose or the direction 
of her gaze slightly between each frame.

top tip: Shoot from a short stepladder 
and ask the bride to raise her chin a little: 
this often creates a more flattering angle.

Group portraits

FOR yOuR FIRST SHOT, TRy...

Exposure mode� aperture priority

Aperture� f/8-11

Shutter speed automatically set

ISO� 200-400

TO ImPROVE yOuR SHOT…
   Ask the best man to organise the various 
groups that need to be photographed.

   For smaller groups, stand back and use a 
longer focal length, such as 70-200mm.

    For a large group of 100-300 people, use a 
wide-angle lens and stand on a small ladder 
so that you can see everyone’s face.

top tip: Use continuous drive and shoot 
in bursts to improve your chances of 
getting a shot without anyone blinking.

WeDDinG ceremony

FOR yOuR FIRST SHOT, TRy...

Exposure mode� manual

Aperture� f/2.8

Shutter speed 1/200 sec

ISO� 800-1,600

TO ImPROVE yOuR SHOT…
   Get to the venue early (or preferably the 
day before) to assess the light and work 
out your manual exposure settings.

   Increase the ISO to get a fast enough 
shutter speed to prevent motion blur.

   Use a 70-200mm f/2.8 lens to give yourself 
framing flexibility during the service. 

top tip: If it’s a church service, try to sit 
at the front with the choir on the groom’s 
side, so that you’re facing the bride.

briDe & Groom

FOR yOuR FIRST SHOT, TRy...

Exposure mode� aperture priority

Aperture� f/3.2-5.6

Shutter speed automatically set

ISO� 200-800

TO ImPROVE yOuR SHOT…
   Scout the reception venue for three 
suitable  locations ahead of the big day.

   To avoid high-contrast images with harsh 
shadows, position the couple in the shade.

   Check the histogram: there should be a 
spike to the right (the white wedding dress), 
but it shouldn’t be pushed off the edge.

top tip: Ask the bride and groom to rub 
noses rather than kiss, as this will ensure 
that their faces won’t be obscured.

Your exclusive digital camera wedding photographY cards

Visit our shop at www.myfavouritemagazines.co.uk/photo
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Tidy up a face

start image

1 Patch messy areas
Open patch_before.jpg from the start files. 

Make a new layer and rename it ‘Patch’. Grab the 
Patch Tool then choose Patch: Content-Aware 
and tick Sample All Layers in the Options bar. 
Make rough selections around a messy area, 
then drag to a nearby clean area to tidy it up.

Step by step: Clean up a grubby face

2 Remove spots
Continue patching up the larger messy 

areas, then switch to the Spot Healing Brush and 
once again tick Sample All Layers in the Options 
bar. Make a new layer named ‘Healing’, then use 
the Spot Healing Brush to paint over marks, spots 
and blemishes to remove them.

3 Clone tones
Make another new layer called ‘Cloning’. 

Grab the Clone Tool, set the Opacity to 20%, and 
then choose Sample: All Layers. Hold down alt 
to sample a source next to a messy area, then 
paint over the area a few times to blend the  
tones and make it smoother.

1 There are three tools that any pro 
retoucher would be lost without: 

the Spot Healing Brush, the Clone Tool and the 
Patch Tool. Used in combination, they can clean 
up marks, scratches and spots in seconds.

In CS6, the Patch Tool was given a massive 
boost with a Content-Aware option. This makes 

it similar to the Content-Aware Fill command, 
but the tool is more useful for retouching. 
What’s more, as with the Clone, Spot Healing 
Brush and Healing Brush Tools, you have the 
option to Sample All Layers, which means that 
all your patching, cloning and healing can be 
done on separate layers.
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Sculpt faces with the Brush Tool 
This is a really effective enhancement for 
adding depth and definition to a face.  It works 

by selective lightening and darkening to accentuate facial 
features like cheekbones and jawlines.

Hold Alt and click Create New Layer in the Layers Panel 
to access the New Layer dialog box. Choose Mode: Soft 
Light and tick Fill With Soft Light Neutral Color, then press 
OK. Grab the Brush Tool. Press D to reset your colours to 
black and white, and 1 to set Brush Opacity to 10%. Paint 
with black over the shadow areas on the face and body, 
then paint with white over the highlights. The grey image 
below right gives you an idea of where to paint. For a similar 
view, just hide your Background Layer. When you’re done 
painting, go to Filter > Blur > Gaussian Blur and set Radius to 
about 50px. This helps to make the effect look more natural.

Remove stray hairs
Stray hairs are one of those things 
that are easily overlooked when 

photographing a person. It’s only when you look at 
the image later that you realise how annoying and 
distracting they are. Taking a few minutes to remove 
the hairs and tidy up around the head will really help 
to give your portraits a professional polish.

Make a new layer, then grab the Clone Tool and set 
Sample: All Layers in the Options bar. Choose a hard-
edged brush tip and set Opacity to 100%, then zoom 
in close. (Hold down Ctrl/Cmd+space then drag to 
the right to zoom.) Hold down alt and click to sample a 
point in the background next to the stray hair, then paint 
over it. Continue around the head, varying the hair lengths 
so the results aren’t too uniform. To tidy up hairs that cross 
over the face, switch to the Spot Healing Brush, set Sample: 
All Layers, and paint over the hairs.

MASTER RETOUCHING



Change body shapes

start image

4 Every portrait photographer 
knows there are certain things 

you can do to make a person look slimmer. For 
example, getting a person to lean forwards 
or shooting from slightly above the face will 
reduce double chins; crossing legs while 
standing or making an L-shape with  
the feet will lead to a more forgiving body 
shape; and shooting into the ‘dark side’ 
(having your light source behind and to the  
side – see the image used in Tip 17) will make  
a face appear thinner.

We know it’s a touchy subject, but slimming 
with Photoshop is just another method for 
making a person look their best. We’re not 
talking about huge shifts in body shape, but 
a few nips and tucks to reduce bulges, shrink 
chins and trim flab. The best tool for the job is 
the Liquify Tool. It’s easy to master. Simply go 
to Filter > Liquify and use the Forward Warp 
Tool to start moving pixels around. Of course, 
what you do depends on your image. Here, 
a quick tuck to the underarm bulge and the 
angle of the waistline, is all that’s needed.



MASTER RETOUCHING
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Tone down eye bags
Day-to-day life takes its toll on your eyes. 
Unless you’ve spent the past month being 

pampered in a luxury spa with 10 hours of sleep a night, 
it’s likely that you’ll have dark circles under them. 

As with most retouching techniques, we don’t want to 
remove eye bags completely, as this will look fake. We just 
want to tone them down. 

Zoom in close to the eyes then click the Create New Layer 
icon at the bottom of the Layers Panel. Grab the Clone tool 
from the Tools Panel then go to the Options bar at the top 
of the screen. Choose Mode: Lighten (this means you’ll only 
replace areas that are darker than your clone source), set 
the Opacity to 20%, and set Sample: All Layers.  
Hold down Alt and sample 
a clone source on the cheek 
directly below the dark 
area, then make a couple 
of  swipes with the Clone 
Tool to tone down the bag.

Crop in and tilt
It’s best to get composition right in-camera, 
but when it comes to photographing people 

you’re often working with moving targets, which can make 
framing slightly more tricky. You’re also usually trying to 
coax an expression or reaction out of your subject, which 
means concentrating on what is or isn’t included in the 
frame may slip down the list of priorities. Luckily, with 
modern sensors being the size they are, we can get away 
with a bit of post-capture cropping in Photoshop.

Cropping in tighter is something that you’ll see portrait 
photographers do time and time again, and a slight tilt to 
the frame when cropping will often result in a more pleasing 
angle. Tilting the head backwards towards their higher 
shoulder, like in this image, is seen as a more feminine angle, 
while a tilt forwards is more masculine. The Crop Tool also 
offers a ‘rule of thirds’ guide in CS6 or later – you can access 
further compositional guides such as the Golden Ratio via 
the View drop-down. For a classic composition, loosely 
position the eyes or face along one of the thirds.



High Pass Skin smoothing7

start image

1 Copy the layer
Open high_pass.jpg. Press Ctrl/Cmd+J 

to copy the layer. Note: if you’re working with  
lots of layers, highlight the top layer and press 
Ctrl/Cmd+shift+alt+e to merge a copy. 
Rename the layer ‘High Pass’, then click the Blend 
Mode drop-down and choose Overlay.

2 Overlay and High Pass
Go to Filter > Other > High Pass. Set Radius 

to 9px and press OK. This applies sharpening, but 
when inverted, it turns into a softening effect, 
so go to Image > Adjustments > Invert (or press 
Ctrl/Cmd+i) to invert the colours on the ‘High 
Pass’ layer.

3 Smooth the skin
Hold Alt and click the Add Layer Mask icon at 

the bottom of the Layers Panel to add a full Layer 
Mask that completely hides the softening. Now 
grab the Brush Tool, choose a soft-edged brush 
tip and set the colour to white, then paint over 
the skin to reveal the ‘High Pass’ layer.

Step by step: Silky skin with the High Pass filter

Pro retouchers will often spend 
a few hours working just on a 

model’s skin, painstakingly removing every 
imperfection with the Clone and Healing Tools. 
Of course, most of us don’t have the time or 
patience for such work, but luckily there are 
things we can do to cut corners.

One of the best loved – and fastest – skin 
smoothing techniques is the High Pass 
method. It gives your subject silky-smooth skin 
while still retaining some detail and texture. 
Therefore you don’t end up with the dreaded 

‘plastic look’ some methods can give. Instead, 
you get beautifully realistic smoothness.

Here’s the quick method below, but if you 
want greater control over the strength of the 
smoothing effect, you could try applying a 
touch of Gaussian Blur (Filter > Blur > Gaussian 
Blur) between Steps 2 and 3. As the image is 
inverted at this stage, the greater the blur 
radius value, the more subtle the effect. When 
painting the mask in Step 3, you don’t need to 
be too precise. A few quick strokes with a large, 
soft-edged brush should do the trick.
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1 Prepare the mask
In Bridge, right-click on clarity_before.jpg 

and choose Open in Camera Raw. Click on the 
Adjustment Brush in the toolbar, then go to 
the settings on the right and tick Show Mask. 
Click the colour picker next to this and choose 
a bright colour for your mask.

2 Paint the mask
Click on the forehead to add a new Pin. 

Then paint a mask that covers the rest of 
the skin. Take care not to go over the facial 
features. If you do, hold down Alt and paint to 
erase parts of the mask. Use the ] and [ bracket 
keys to resize your brush as you paint. 

3 Reduce Clarity
Untick Show Mask, then go to the settings 

in the top right. Make sure all the sliders are 
reset to their default values (double-click a 
slider to quickly reset it), then drag the Clarity 
slider back to -64 to soften the area covered 
by the mask. 

Step by step: Smooth skin with ACR’s Clarity slider

8

9 How to remove hot spots
You know those shiny parts you sometimes 
see on a person’s face where bright lights 

are reflected? They’re called hot spots. Not only are they 
distracting, they can also make a person look sweaty,  
even when they’re not. Nobody wants to look like a  
Sweaty Betty, but if we remove the hot spots completely 
we’ll lose some of the shimmer that helps to define the 
face. The solution is to tone them down with a  
combination of the Patch Tool and the little-known but  
very useful Fade command. 

Duplicate your layer, then grab the Patch Tool. If you’re 
using CS6 or later, choose Patch: Normal in the Options 
bar, then make a rough selection around the hot spot. Drag 
the selection to a clean area of similar tone to remove the 
hot spot completely. Next, press Ctrl/Cmd+H to hide the 
marching ants, then go to Edit > Fade Patch Selection (or 
press Ctrl/Cmd+shift+F) and lower the Opacity to about 
40% to reveal a toned-down hot spot. 

Clarity Skin Smoothing
You may think of Camera Raw as merely a raw 
converter for your camera files, or a place to 

make a few tonal tweaks before opening your image into 
Photoshop. But delve a little deeper and you’ll find a host of 
incredibly useful tools and settings. One such setting is the 
Clarity slider. When dragged to a positive value, the Clarity 
slider increases midtone contrast, which can be great for 
teasing out detail in your images. But drag it to a negative 

value, and you’ll get a wonderful 
softening effect that 
works brilliantly over 
skin. There’s a Clarity 
slider in the Basic 
Panel but, crucially, 
you can also use it in 
conjunction with the 
Adjustment Brush 
(which is another 
ACR gem) to confine 
the softening effect 
just to the skin.  
Here’s how…

MASTER RETOUCHING
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Boost the eyes

start image

1 Boost contrast
Open eyes_before.jpg, then click the 

Create Adjustment Layer icon at the bottom 
of the Layers Panel and choose Curves. Make 
an S-shaped curve like the one shown to boost 
contrast, then press Ctrl/Cmd+i to invert the 
Layer Mask. Next, grab the Brush Tool and paint 
with white over the eyes.

Step by step: Add impact to eyes

2 Dodge and burn
Hold down Alt and click the Create New 

Layer icon at the bottom of the Layers Panel. 
In the New Layer box, name the layer ‘Dodge 
Burn’, choose Mode: Overlay and tick the Fill With 
Overlay – Neutral Color box. Grab the Dodge Tool, 
set Range: Midtones, Exposure: 20%, and then 
paint over the iris.

3 Sharpen the lashes
Switch to the Burn Tool. Set Range: 

Midtones, Exposure: 20%, then paint to darken 
the pupil, the edge of the iris and the lashes. 
Next, create a new layer and grab the Sharpen 
Tool. Enable Sample All Layers in the Options bar 
and set Strength to 20, then paint over the lashes 
to selectively sharpen them.

10 Most photographers will agree that 
the eyes are the principal part of 

any portrait, so it pays to make a few subtle 
improvements to give them extra sparkle.

Here, we’ll concentrate on the essentials 
of eye enhancement, but if you want to take 
it further you can do a lot more – change the 
colour, add a catchlight, apply make-up, even 

make them larger. It can be useful to think 
of an eye as a set of four elements: pupil, iris, 
whites and lashes. Each element requires a 
different set of tools. We want to boost the 
tones inside the iris, darken the pupil and iris 
rim, lighten the whites and sharpen the lashes. 
Subtlety is key here, so don’t be afraid to lower 
the layer Opacity of any effect to tone it down.
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11 Whiten teeth
People are often so worried about their teeth  
that they refuse to smile when having their  

photograph taken, or they’ll do a close-lipped smile that 
isn’t fooling anyone. If only they knew how easy it is to  
whiten teeth in Photoshop!

Zoom in close then click the Create Adjustment Layer 
icon at the bottom of the Layers Panel and choose Hue/
Saturation. Next, click on the drop-down at the top of the 
Hue/Saturation settings (where it says Master) and choose 
Yellows. Drag the Saturation slider to about -50 and set 

Lightness to +10.
Now you just need to localise 

the colour effect to the teeth, so 
press Ctrl/Cmd+i to invert the 
Hue/Saturation Layer Mask so 
the effect is hidden. 

Grab the Brush Tool and paint 
with white over the teeth to 
reveal the effect.

12 Change eye colour
You can change the colour of just about  
anything with Photoshop, including an iris. This  

is very similar to the method described in Tip 11 above. Add 
a Hue/Saturation Adjustment Layer and then use the Hue 
slider to adjust the colours. If you have a specific colour in 
mind, tick Colorize, then simply invert the Layer Mask  
with Ctrl/Cmd+i and use the Brush Tool to paint with  
white over the iris.

Of course, the beauty of working with Adjustment Layers 
is that the colours you choose aren’t set in stone, so you 
can try out different shades at any time simply by double-
clicking the thumbnail of the Hue/Saturation layer in the 
Layers Panel. Hue/Saturation isn’t the only option for colour 
changes, either. If you like, you can use a Color Balance or 
Photo Filter Adjustment Layer to tint the colours. 

For finer control over colour channels, you could use 
a Curves or Levels layer.



PHOtOsHOP gUiDe
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Improve tones in ACR
Straight out of the camera, raw files can 
sometimes look a bit flat. Fortunately, Camera 
Raw has plenty of controls and settings that can 

be used to enhance and improve tones. The best place to 
start making these adjustments is the Basic Panel. Use it 
to tweak exposure and boost contrast. Explore ACR a little 
further and you’ll find other great tools that can be used for 
selective adjustments. The Adjustment Brush is ideal for 
enhancing portraits, because you can set pins for different 
parts of the face such as the eyes, lips and skin, then adjust 
the tones accordingly. The Spot Removal Tool is also useful, 
because each time you heal a spot or mark you get two 
interactive circles that can be resized and repositioned. 
The tool can also be used to batch-remove sensor marks 
by opening a group of files then clicking Select All.

Make your portraits pop
Portraits will often benefit from an increase 
in contrast. However, skin tones are primarily 

made up of reds, so you need to be careful when boosting 
contrast because this can lead to overly red faces. You can 
combat this with a combination of Color Balance and 
Curves Adjustments. First, use Color Balance to dial down 
the reds. Click the Create Adjustment Layer icon at the 
bottom of the Layers Panel and choose Color Balance, 
then drag the top slider towards Cyan. Next, add a Curves 
Adjustment Layer to increase contrast. Click near the top-
right of the diagonal curve line to add an anchor point, then 
drag this up slightly to lighten the highlights. Make a second 
point towards the bottom-left of the Curve line, then drag 
this down to darken the shadows. An alternative method 
for boosting contrast without affecting colours is to add 
a Curves Adjustment Layer with  
the Blend Mode set to Luminosity. start image



Add HDR Toning effects

start image

1 Make a new document
Open hdr_toning_before.jpg, then go to the 

Layers Panel. Right-click the Background Layer 
and choose Duplicate Layer. In the Duplicate 
Layer dialog box, choose Destination: New and 
click OK. Make sure that you’re working on the 
new untitled document, then go to Image >  
Adjustments > HDR Toning.

Step by step: Create a stylised portrait with HDR Toning

2 Apply HDR effects
In the HDR Toning box, set Radius: 81px, 

Strength: 1.75, Detail: 110%, Highlight: +10%, 
Saturation: -100%, then click OK. Next, right-
click the layer in the Layers Panel and choose 
Duplicate Layer again. This time, set Destination: 
hdr_toning_before.jpg and click OK. Go to the 
hdr_toning image.

3 Blend with the original
Go to the Layers Panel and change the Blend 

Mode of the top layer to Luminosity. Next, hold 
down alt and click the Add Layer Mask icon at 
the bottom of the panel. Grab the Brush Tool and 
paint with white at 40% Opacity to gradually 
reveal the stylised effect over the face.

15 The HDR Toning command can be 
used to give an image a stylised HDR 

effect. You’d be forgiven for thinking it should 
only be used on landscapes, but in fact it can 
also give portraits an eye-catching stylised 
finish. The HDR Toning command will only 
work on a flattened document, but for greater 
flexibility we’d like the effect on its own layer, 

with the original image underneath. So we 
need to work around the problem by making a 
duplicate document. We’ll show you how here.

The effect will tease out detail in the shadow 
areas, so once it’s applied, you may find that 
you need to use other retouching techniques 
such as spot removal and skin smoothing to 
perfect the look.
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Cut out hair

start image

1 Make a selection
Open cutout_hair_before.jpg and grab the 

Quick Selection Tool from the Tools Panel. Paint 
over the head with the tool to make a selection. 
(Hold down Alt and paint to subtract areas from 
the selection if it goes wrong.) When you’re 
happy, click on the Refine Edge button, which 
can be found at the top of the display.

Step by step: Change the background colour

2 Refine the edges
Tick Smart Radius and set Radius to 72. 

Tick Decontaminate Colors and choose Output: 
New Layer with Layer Mask, then click OK. Next, 
highlight the bottom layer, then click the Create 
Adjustment Layer icon and choose Solid Color. 
Set R:227, G:196, B:196 and click OK.

3 Refine the mask
Highlight the top layer’s mask, then right-

click it and choose Refine Mask. Grab the Refine 
Radius Tool from the left of the Refine Mask 
box, then use it to paint over any gaps in the 
hair where you can still see the original white 
background. When you’re happy, click OK.

16 If you’d like to change the background 
colours or make a composite, you’ll 

need to use selection tools to isolate your 
figure. The biggest challenge with this is 
getting an accurate selection around hair. 
There’s no perfect solution to the problem, but 
since CS4 Adobe has made things much easier 
with the Refine Edge command which, as the 
name suggests, can be used to refine the 

edges of a selection (or a Layer Mask, with the 
almost identical Refine Mask command).

To access Refine Edge, you’ll need to make an 
initial selection with any of the selection tools. 
If you have a clean background you could use 
the Magic Wand or Color Range command, but 
if the background is more cluttered, you may 
find the Quick Selection Tool gives you a better 
starting point.

PHOtOsHOP gUiDe
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MASTER RETOUCHING
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Replace the background
The ability Photoshop gives you to change a 
background opens up a whole world of possibility: 

you could sit someone on a one-pence piece, place a person 
in a vintage scene, or on top of a mountain, or wherever 
your imagination takes you. To transfer a figure to another 
scene, follow the selection technique shown opposite in 
Tip 16, then open a suitable background image, grab the 
Move Tool and drag the portrait to the background. You may 
need to resize the layer, in which case press Ctrl/Cmd+t, 
hold down Shift, and drag the corner of the bounding box. 
Things will look more realistic if the lighting is similar in both 
images, so if the background is lit from a different angle to 
the portrait, you could try flipping one or the other (Edit >  
Transform > Flip Horizontal.) As a finishing touch, tweak the 
colours to help the images gel together. You could also try 
adding a Blur filter to simulate depth of field.

Skin tone selections
If you have CS6 or later, you can access a handy 
feature hidden within the Color Range command 

that allows you to quickly select skin tones. Go to Select 
> Color Range, then click the drop-down menu at the top 
of the box and choose Skin Tones. The command is useful 
if you want to target and lift skin colours, or isolate and 
preserve them while changing the rest of the image. The 
feature may seem a little frivolous (after all, you could 
achieve the same results with a couple of clicks within the 
standard Color Range settings), but if you’re working at 
speed, a few clicks can make all the difference. Plus if you’re 
into making Actions, you could build the command into a 
recorded sequence, then play it back on other images for 
fast, automated changes to skin tones.

start images



Apply digital make-up to the eyes

start image

1 Paint the colours
Open eye_makeup_before.jpg, then click 

the Create New Layer icon in the Layers Panel. 
Click the Blend Mode drop-down menu in the 
Layers Panel and choose Color. Grab the Brush 
Tool and choose a colour, then paint around 
the eye. Set the layer’s Opacity to about 16%. 
Continue adding other colours on new layers.

Step by step: Add make-up and glitter to eyes

2 Add glitter
Create a new layer and rename it ‘glitter’, 

then click the Brush Panel icon in the Options bar. 
Highlight Brush Tip Shape, then set Size to 4px 
and Spacing to 182%. Next, highlight Scattering 
and set Scatter to about 980%, then paint with 
white to add the scattered glitter effect. Set the 
glitter layer Opacity to about 50%.

3 Flip the make-up
Hold down Ctrl/Cmd and click to highlight all 

except the Background layer. Press Ctrl/Cmd+g, 
then drag the new group to the Create New Layer 
icon. Grab the Move Tool and tick Show Transform 
Controls, then click the bounding box. Right-click 
and choose Flip Horizontal, then position the 
copied group over the other eye.

19 Nothing can replace real-life make-
up, but if you want to try applying 

digital make-up in Photoshop, it’s not hard to 
get convincing results. You can experiment 
with different colours and erase at any time 
– plus it’s cheaper than forking out on eye 
shadow! The key is to apply different colours 
to separate layers, each one set to the Color 

Blend Mode with a low layer Opacity. This 
makes it easier to give the effect depth, and it 
gives you greater control if you need to tweak 
or erase anything. With Photoshop’s excellent 
Brush Panel, it’s also quick and easy to apply 
scattered glitter. And, of course, once you’ve 
completed one eye, you can simply copy the 
effect and flip it to cover the other eye.
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Enhance the lips
Often, parts of the face will look better 
when slightly enlarged. In particular, we find 

larger eyes and lips more appealing. So as well as lips, this 
technique for speedy enlarging is equally effective on eyes. 
Grab the Lasso Tool and make a loose selection around the 
lips, then right-click and choose Feather. Set Radius at 10px, 
click OK, then press Ctrl/Cmd+J to copy the selected area 
to a new layer. Next, press Ctrl/Cmd+t to enter Transform 
mode; go to the options at the top of the screen and set W 
at 110% and H at 110%, then press Enter to apply. If the 
teeth are showing, add a Layer Mask and paint with black 
to hide the oversized teeth and reveal the original teeth 
on the layer below. We’ve also changed the lip colour here 
with a Hue/Saturation Adjustment Layer (the same as the 
technique for changing eye colour in Tip 12).

Apply selective sharpening
Sharpening is the vital final part of any image-
editing process. But when it comes to working 

on faces, you don’t necessarily want to apply sharpening 
to the entire image. It’s much better to apply sharpening 
selectively to certain areas, such as the eyes, hair and lips. 
As usual with Photoshop, there are several ways to achieve 
this. One popular method is High Pass sharpening. 

The technique for High Pass sharpening is very similar to 
that for High Pass skin softening. Follow Tip 07, but to get a 
sharpening effect instead of softening, simply skip the part 
in Step 02 where you invert the layer. Because you don’t 
need to invert the layer, you can also convert the layer to 
a Smart Object (Filter > Convert for Smart Filters) before 
you apply the High Pass filter. This gives you the option to 
change the strength of the sharpening effect at any time, 
simply by double-clicking the High Pass Smart Filter in the 
Layers Panel.
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